U.S. Department of Labor
Wage and Hour Division *

ULS. Wage and Hour Division
(Revised July 2009)

Fact Sheet #16: Deductions From Wages for Uniforms and Other Facilities
Under the Fair Labor Standards Act (FLSA)

This fact sheet provides general information concerning the application of the FLSA to deductions from
employees' wages for uniforms and other facilities.

Characteristics

The FLSA does not allow uniforms, or other items which are considered to be primarily for the benefit or
convenience of the employer, to be included as wages. Thus, an employer may not take credit for such items in
meeting his/her obligations toward paying the minimum wage or overtime.

Requirements

Uniforms: The FLSA does not require that employees wear uniforms. However, if the wearing of a uniform is
required by some other law, the nature of a business, or by an employer, the cost and maintenance of the
uniform is considered to be a business expense of the employer. If the employer requires the employee to bear
the cost, it may not reduce the employee's wage below the minimum wage of $7.25 per hour effective July 24,
2009. Nor may that cost cut into overtime compensation required by the Act.

For example, if an employee who is subject to the statutory minimum wage of $7.25 per hour (effective July 24,
2009) is paid an hourly wage of $7.25, the employer may not make any deduction from the employee's wages
for the cost of the uniform nor may the employer require the employee to purchase the uniform on his/her own.
However, if the employee were paid $7.75 per hour and worked 30 hours in the workweek, the maximum
amount the employer could legally deduct from the employee's wages would be $15.00 ($.50 X 30 hours).

The employer may prorate deductions for the cost of the uniform over a period of paydays provided the prorated
deductions do not reduce the employee's wages below the required minimum wage or overtime compensation in
any workweek.

Other Items: Employers at times require employees to pay or reimburse the employer for other items. The cost
of any items which are considered primarily for the benefit or convenience of the employer would have the
same restrictions as apply to reimbursement for uniforms. In other words, no deduction may be made from an
employee’s wages which would reduce the employee's earnings below the required minimum wage or overtime
compensation.

Some examples of items which would be considered to be for the benefit or convenience of the employer are
tools used in the employee's work, damages to the employer's property by the employee or any other
individuals, financial losses due to clients/customers not paying bills, and theft of the employer's property by
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the employee or other individuals. Employees may not be required to pay for any of the cost of such items if, by
so doing, their wages would be reduced below the required minimum wage or overtime compensation. This is
true even if an economic loss suffered by the employer is due to the employee's negligence.

Employers may not avoid FLSA minimum wage and overtime requirements by having the employee reimburse
the employer in cash for the cost of such items in lieu of deducting the cost from the employee's wages.

Typical Problems

(1) A minimum wage employee working as a cashier is illegally required to reimburse the employer for a cash
drawer shortage. (2) An employer improperly requires tipped employees to pay for customers who walk out
without paying their bills or for incorrectly totaled bills. (3) An employer furnishes elaborate uniforms to
employees and makes them responsible for having the uniforms cleaned. (4) An employee driving the
employer's vehicle causes a wreck, and the employer holds the employee responsible for the repairs, thereby
reducing the employee's wages below the minimum wage. (5) A security guard is required to purchase a gun for
the job, and the cost causes him/her to not earn the minimum wage. (6) The cost of an employer-required
physical examination cuts into an employee's minimum wage or overtime compensation.

Where to Obtain Additional Information

For additional information, visit our Wage and Hour Division Website: http://www.wagehour.dol.gov
and/or call our toll-free information and helpline, available 8 a.m. to 5 p.m. in your time zone, 1-866-
4AUSWAGE (1-866-487-9243).

This publication is for general information and is not to be considered in the same light as official statements of
position contained in the regulations.

U.S. Department of Labor 1-866-4-USWAGE
Frances Perkins Building TTY: 1-866-487-9243
200 Constitution Avenue, NW Contact Us

Washington, DC 20210




1/9/2020 Direct Deposit of Wages

« @ »DWD

Department of Workforce Development

Direct Deposit of Wages

Overview

Wisconsin labor standards laws do not directly address the issue of direct deposit of wages. However, several laws have an indirect impact on how
direct deposit programs may be used.

Mandatory Direct Deposit

Mandatory direct deposit systems are permitted under certain circumstances:
The employee must be able to collect his or her wages at a bank or facility in the State of Wisconsin.
The employee must receive all of his or her wages, and cannot be made to incur any charges to receive them. If an employee uses an existing bank

account, generally this will cause no problem. If an employee does not bank, and has to establish an account solely for the purpose of receiving wages,
all fees must be covered by the employer.

Voluntary Direct Deposit

If an employer chooses to institute a direct deposit pay system that is available at the option of the employee, it is immaterial whether or not there are
fees associated with obtaining the wages. If the employee chooses to use the direct deposit system, it is assumed that the employee has agreed to pay
these fees for the convenience and security of having the wages placed directly into his or her bank account.

Direct Deposit as a Condition of Employment

Because this issue is not addressed in the statutes, an employer may make employee participation in a direct deposit pay program a condition of
employment. An employer may also require that established employees participate in a direct deposit system as a condition of continued employment.

Wisconsin Statutes

Wis. Stat. § 103.45

Wisconsin Statutes 103.45, states that wages paid in a method other than cash must be paid "in some designated place of business in the county in
which the work was performed, or at the office of the person paying the wages if within this state, or at any bank within this state.” This means that a
direct deposit system must utilize a Wisconsin facility unless the employee voluntarily chooses a facility that is located outside of the state.

Wis. Stat. § 109.03(1)

Wisconsin Statutes 109.03(1) requires an employer to make timely payments to workers, and that wages be paid in full on the corresponding pay date.
This means that a mandatory direct deposit system must provide a worker with 100% of his or her wages without the worker incurring any cost to gain
access to their pay (check fees, service charges on an account, etc.).

For More Information

e Contact Info
e Complaint Process
e Labor Standards Complaint Form (LS-119-E)

https://dwd.wisconsin.gov/er/laborstandards/deposit.htm


http://docs.legis.wisconsin.gov/statutes/statutes/103/45
https://docs.legis.wisconsin.gov/statutes/statutes/109/03
https://dwd.wisconsin.gov/er/contacts.htm
https://dwd.wisconsin.gov/er/laborstandards/complaintprocess.htm
https://dwd.wisconsin.gov/dwd/forms/erd/ls_119_e.htm
https://dwd.wisconsin.gov/
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Esther Friedberg Karp is an internationally-renowned trainer, writer, business consultant and speaker
who was named one of the Top 10 QuickBooks ProAdvisors in the world, with the title Top
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Esther holds a BSc from the University of Toronto in Actuarial Science and Mathematics, and an MBA
in Marketing and Finance from York University’s Schulich School of Business.

She can be reached at esther@e-compubooks.com or 416-410-0750.
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Training at a Glance

Use this as a guide to select specific activities you want to cover.

TOPIC CONTENT

BEST PRACTICES ® Browser Functionality
e Keyboard Shortcuts

NAVIGATING ® ClientHome
® Various Left-hand Navigation Tabs

® Quick Create

QuICKBOOKS ONLINE TEST DRIVE

Exercises contained in this handbook can be completed using a QuickBooks Online “test drive” file.
The test drive uses a sample company file called Craig’s Design & Landscaping Services. It can be
accessed through the following link:

Craig's Design & Landscaping

You don't have to create an account or sign in to access the test drive file; just complete the security
validation and click Continue.

This test drive is designed for you to explore and try out new things without worrying you will break
something or make a mistake. It is not designed to retain any changes you make. Once you close
this QuickBooks Online test drive company it is completely refreshed, so remember to allow
sufficient time to complete each activity. But don't worry if you have to close the test drive before you
are finished! You can always begin again.

Course 2 - Navigate QuickBooks Online 3
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Topic 1: Best Practices

IDENTIFY BEST PRACTICES WHEN USING QUICKBOOKS ONLINE

Browser Tips

The tips below are based on Google’s Chrome browser, but many of them work in other browsers:

® Click a choice in the left navigation bar, Quick Create menu, gear icon or other access points and
drag it up to access it in a new tab in the existing browser

® Logintoa QuickBooks Online company (including the test drive company), right-click your
browser tab, left-click Duplicate. (You can repeat this as many times as you like.) Now you have
multiple tabs logged in to the same QuickBooks Online Company. You can then navigate to
another access point in QuickBooks Online in one (or more) of the tabs so you have two (or
more) tabs open to the same company showing different areas of QuickBooks Online.

@ Pull one tab out of the browser window and you can work in QuickBooks Online on two different
screens side-by-side. You can work on these two windows independently of each other. Repeat,
as needed!

® Chrome allows you to create different users (Customize : > Settings > People). If you have
two or more different QuickBooks Online companies, you can log in to each of them using a
different Chrome user and operate each account simultaneously. (Or you can log in using two or
more different browsers, such as Chrome, Firefox and Safari, or log in as an incognito user.)

® Loginas aseparate Chrome user for your QuickBooks Online companies. Open the screens you
use most often and bookmark them (click %) to create a QuickBooks Online icon bar to be used
with multiple QuickBooks companies.

® |[f a company has special screens you use regularly, create a folder on the Chrome bookmark bar,
bookmark those screens and save in the folder

€« C & https;//gbo.intuit.com/app/employees

i Apps [ Esther's companies @ Chart of Accounts @ Employees @ Invoice @ Expense

® Right-click the back arrow of the browser to display a recent history of the screens you were on
previously; left-click the one you want to return to and resume working

Course 2 - Navigate QuickBooks Online 4
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@ Left-click and drag your selection up to where a new browser tab can be positioned and release

it to open a new tab with that selection

1 Microsoft Office Home x ng X £3 Settings X | £ History

< c O

@ Chart of Accounts

@ Craig's Design and Landscapi

& https//c23.qbo.intuit.com/app/reportv2?token=BAL_SHEET&show_logo=falseldat.. & W -~

@ Reports @ Invoice @ Expense

Subscribe now and save 50%  Subacribe now

i Apps @ Employees @ Deposit @ QBOTestDrive (@ Test Drive QBO Can..

@ Glickbooks =

Total Bank Accounts

Taxes ~ Accounts Recaiv

A ti
ccounting Total Accounts Receivable

~+ Other Current Assets
My Accountant

Inventary
Undeposited Funds
Total Other Current Assets
Total Current Assets
~ Fixed Assets

~ Truck

https://c23 gbo.intuit.com/app/reports Original Cost

Deshboard pee Somy Addnotes & @
Banking
= Design and Landscaping Services
Seles BALANCE SHEET
As of February 17, 2019
Expenses
oL

Prajects
Workers

Chacking 1,201.00
Reports Ssvings 800.00

$2,001.00

528152

55,281.52

596.25
2,062.52
52.658.77

39,941.29

13.495.00

® |If you are getting unexpected results when working in QuickBooks Online or are having
problems logging in, make sure to clear your cache and cookies in Chrome (Customize [ />

History > History > Clear browsing data)

® CTRL+ and CTRL - allow you to zoom in and out quickly

NOTE: This browser functionality works best in a Chrome browser and is useful because many
accounting professionals use two (and sometimes three) monitors. (Internet Explorer and Edge also
allow the user to right-click a tab and select Duplicate. Other browsers, namely Firefox and Safari, do
not necessarily have the ability to select Duplicate by right-clicking a tab. However, it is possible to
highlight the entire URL of the tab, right-click and select Copy, then open a new tab in the same
browser window, right-click and select either Paste or Paste & Go, depending on the browser being
used.) All the browsers mentioned do feature the ability to drag a tab off to open in a separate

browser window.
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Keyboard Shortcut Tips

You may be used to working with keyboard shortcuts when using desktop programs, whether
QuickBooks Desktop, Microsoft Word®, Excel® or other programs. There are also keyboard
shortcuts when working in QuickBooks Online. Some common keyboard shortcuts can be found by
clicking Ctrl + Alt + /. If you're on a Mac, use Option + Ctrl + /. Notice that the same shortcut key
acts differently depending on the screen you are in.

For example, Ctrl + Alt + ¢ opens the Customer Center, if you are not in the middle of creating a
transaction. If you are in the middle of creating a transaction, it cancels that transaction.

These shortcuts indicate what function you can fulfill quickly in a Windows environment by clicking
on Ctrl + Alt + letter (the list of letters is in the chart below). If you're using a Mac, substitute
Command + Option + letter.

X
Your Company ID is 1935 1484 6511 734 ‘ O Copy ‘
H23
Keyboard Shortcuts
To teke advantage of shortcuts, simultaneously press
[ctrl] and [alt or option] and one [key from the list below]

REGULAR PAGES - HOMEPAGE, CUSTOMERS, AND S50 ON TRANSACTION PAGES - INVOICE, EXPENSE, AND SO ON
SHORTCUT KEY ACTION SHORTCUT KEY ACTION
[ nvoice x Exit transaction view

Check l c Cancel out l
e Estimate s Save and Tew
P Expensze d Save and Cloze

Bocaiye Poymeans m Save and Send

[ c Customers l P Prinmt

T
a Chart of Accounts

Lists
h Help
i Search Transactions
d Focus the left menu
Tor/ Thiz dialeg

This screen is also one place you can find your Company ID, which you might need if you have to call
technical support.
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Other keyboard shortcuts you may be interested in are the date shortcuts. When you are in a date
field, you can move forward and back a day at a time by using your + and - keys. To go to today, use
the letter t. Here are some other date shortcuts:

w for first day of the week

k for the last day of the week
m for the first day of the month
h for the last day of the month

y for the first day of the year

r for the last day of the year

Do you see the pattern? Use the first letter to go to the beginning and the last letter to go to the end
of the time period related to the date that is currently displayed.

Also, the ESC key will cancel the current transaction being entered/edited.

Calculations

There's a simple calculator available directly on the rate or amount field of a transaction. Enter your
first number then use your keyboard to add (+), subtract (-), multiply (*) or divide (/). The beauty of
this feature is the results are entered directly into the transaction by moving to the next field, either
with your mouse or the Tab key; no retyping of numbers is necessary.

(S Check #71 @ Hep

AMOUNT
Payes Bank Account

Checking ~ | Balance $1,201.00 $ D . [] U

Mailing sddress Payment date Chack no.

[] Print later

AMOUNT

v Category details

¢ catecoRy DESCRIPTION amount | sitasie  Tax  customer -
10.00
o - 245 O O - 0
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Topic 2: Navigate

In this topic, we discuss how to navigate around QuickBooks Online. It's important to understand the
interface and to know the options for entering information so you can figure out the correct workflow
for your business.

ComMPANY HOME PAGE

When you log in to QuickBooks Online, the Home page is the first screen that appears. The top of
the screen shows the name of the QuickBooks Online company (helpful when you are running more
than one company in QuickBooks Online).

You'll see a Setup guide at the top of the Home page which can guide you through such steps as
invoicing and connecting with an accountant. Clicking Hide will collapse this guide so you have
more screen real estate available on this Home page.

- Craig's Design and Landscaping Services e

Get paid for the work you do Hide

See how much you're making

Start tracking time @
Connect with an accountant Set up payments Send your first Swipe cards in
o o invoice person with our
mobile app

Add the finishing touches

Once it's collapsed you can click Resume setup to expand the setup guide again.

PRIVACY

Bring it back anytime X
Your setup guide is right here if you
ever need it again.

L:;,, Craig's Design and Landscaping Services

Invoices Expenses Lastmonth ¥ Profit and Loss Lastmonth ¥ Ba
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Below the Setup guide, you'll see several bar charts and graphs related to the performance of your
company. You'll see Invoices receivable, including those that are overdue. You'll also see invoices
that were paid in the last 30 days, including those that were not yet deposited. You'll also see a
breakdown of major expense categories, income and expenses on the Profit and Loss, as well as a
Sales graph. The time frames on these last three graphs start out at Last month but can be changed
by clicking the drop-down arrow to choose another date range. As you hover over any of the
sections of these graphics, you will get more information about that section. You can drill down to
get either a detail report related to totals or continue to get to an actual transaction.

Invoices Expenses Lest month ¥ Profit and Loss Lestmonth ¥
$5,281.52 UNPAID LAST 365 DAYS $6,99°2 $1.355
’
LAST MONTH NET INCOME FOR JULY
$1,525.50 $3,756.02 R
OVERDUE NOT DUE YET

I 52,666
’ Miscellaneous $8.347 8 TO REVIEW

Maintenance and...

$2,062.52 $1,629.70 5900 $6.002 17 TO REVIEW
%% Rent or Lease E'%'.;E\SES ‘///////%
y $2,486

Everything else

Sales l Lest month ¥ l

$8,426
LAST MONTH
£3.9K
£2.6K
£1.3K

$0

gy 7
oy
o
37
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Invoices

$3,281.52 UNPAID  LAST 363 DAYS

$1,525.50 $3,756.02
OVERDUE NOT DUE YET

$3,092.22 FAID  LAST 30 DAYS

$2,062.52 $1,629.70
NOT DEPOSITED DEPOSITED

l Lmst manth W

Sales

$0

LAST MONTH

533K
322K
31K

50
Jan 1 Jan 31

Le2at month ¥

Expenses

$7,035

LAST MONTH

W 52,6066

Mizcellanecus

W 5940

M 5900
Rent or Le=ze

W $2,529
Everything =lae

Mairtenance and ___

Lzat month ¥

Profit and Loss

$-163

NET INCOME FOR JANUARY

56872 & TO REVIEW
: VAP,
neove N7
17 TO REVIEW

el 77777
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On the right side of the Home page is a list of bank and credit card balances and, if those accounts
are connected with the banks, you get information as to current bank or credit card balance versus
the QuickBooks Online balance for each account, and how many transactions have been
downloaded and not matched or entered into QuickBooks Online. There is also a direct link to
connect a bank or credit card account to its QuickBooks Online counterpart, as well as a drop-down
to take you directly to the register for the bank or credit card account of your choice.

This section of the Home page acts as a reminder to review the bank feeds on a timely basis. You'll
learn more about the Banking Center later in this training.

Bank accounts &

Checking

Bank balance 3362193

In QuickBooks £1.201.00

Savings 1 to review

Bank balance
In QuickBooks

Mastarcard

Bank balance

In QuickBooks

Viga

In QuickBooka 50

Checking
Savings
Maetsrcard

Visa

Connect accounts [ Go to regieters ﬁ ]
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At the top right corner of the Home screen is a switch called Privacy. When you activate it,
QuickBooks hides all the financial numbers on the screen to protect this sensitive information from
anyone walking by your computer. This is very helpful if you're working in a public place such as an
airport or a coffee shop.

+ c - 2 c
I Dashboard 2o Craig's Design and Landscaping Services Resuma satup

Banking
Zeles
Expenses
Projects
Workers
Reports
Taxes

See your financial infe by turning privacy off.
Accounting J o gl ’

My Accountant

On the left side of any QuickBooks Online company you'll find the navigation bar. You will learn
more about this as you go through this module.

qab E]iﬁilckhaaks

I Dashboard
Banking
Sales
Expenses
Projects
Woarkers
Reports
Taxes
Accounting

My Accountant
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Because the Home page automatically opens when you open QuickBooks Online, it directs the small
business owner to review key metrics about their business. This is a good thing. Too often, small
business owners and staff enter transactions but don't really look at their results until tax time. And
that could be too late.

CUSTOMER CENTER

Click the Sales tab in the navigation bar, then the Customers sub-tab (either in the horizontal list of
tabs or in the pop-up list of tabs) to open the Customer Center.

Products and Services

Dashboard Overview All Sales Invoigg,

Banking

oo |

$750 §1.526 $3,136
3 UNBILLED ACTIVITY 10 OVERDUE 12 PAID LAST 30 DAYS

Sales

v

cxpenses

Projects

Workers

jucts and Services
Reports Products and Service: [

— a

Taxes
B CUSTOMER / PROJECT a / COMPANY PHONE OPEN BALANCE ACTION

Accounting 's Bi =
g B Ar,“y,e.ﬂ‘rd-éar,‘,ﬁ,ww i (650) 335-3311 £239.00 Recsive payment ¥

My Accountant
0 _BleW\Vr\dsun-’Sf\f:p = 5538 $85.00 Recsive payment v

Cool C: = I
[ CeelCan =2 (415) 555-9933 50.00 Create invoice v

® The colorful money bar at the top of this center is a visual representation of potential revenue in
the form of unbilled estimates and time and expenses, plus receivables (including overdue
invoices), as well as invoices paid in the last 30 days. You can drill down on any color block of the
money bar to get to the underlying list and, ultimately, to transactions to review, edit or delete.

® The New Customer button in the top right corner creates a new customer in the Customer
Center, as opposed to creating one on the fly in the Customer field of a transaction, which you
can always do

® You can also click the drop-down next to New Customer and choose to Import customers here

® The visible columns of the Customer Center can be set by selecting the grid gear icon (in the top
right corner of the customer list, above the Action column) to show the address, email and/or
attachments column, as well as how many rows of the Center to display on a page and whether
to include inactive customers. This setting is “sticky,” which means the next time you open the
Customer Center, QuickBooks Online will remember your preference.

® Click the customer name to view or edit the customer details (i.e., profile) for them, see a list of
transactions or create new transactions
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® Click the envelope icon next to a customer name in the Customer Center to launch your native
email client to send them an email

® Above the Customer list, you can easily find a customer or filter the list by typing part of the
name in the search box

® You can sort the customer list (or a transaction list for a customer, if you've clicked on the
customer name or a color block of the money bar) forward and backward by several parameters
simply by clicking the column header for that parameter, either once or twice, to specify sorting
forward or backward

® Once in the transaction list for a customer (or if you've clicked Open Invoices or Overdue
Invoices in the money bar), you can create invoices, receive payments, send a reminder or an
invoice link, print a packing slip, print a statement or copy a sales transaction for an individual
customer under the Actions column

® Clicking the Start invoice hyperlink next to an entry (any entry which can lead to invoices such as
an estimate, a delayed charge or a time activity) will open an invoice populated with that entry;
any additional entries available to be added to the invoice will be in the drawer to the right of the

Involice.
Customers s s =0
Unbillad Lazt 365 Dayz Unpsi Lazt 365 Daya Paic
$362
S s$87q $1,526 $3,136
4UNBILLED ACTIVITY 10 OVERDUE 12 PAID LAST 30 DAYS
~
B ire— a
[] | CUSTOMER/PROJECT a / COMPANY PHONE OPEN ESTIMATES ESTIMATE AMOUNT ACTION
[ Sconenscheinfamily Stors ] (650 557-8463 1 Open estimate 535207 Iﬁ-l“

® You can perform batch actions related to statements and email for more than one customer by
placing checkmarks in the boxes next to the appropriate customers in the Customer Center and
choosing from the Batch Actions drop-down menu
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VENDOR CENTER

Click the Expenses tab in the navigation bar then the Vendors sub-tab (either in the horizontal list of
tabs or in the pop-up list of tabs) to open the Vendor Center.

Dashboard Expenses
Banking
o ]7]
Seles
Unbilled Lasz 365 Days Unpeid Last 365 Days Paid
Expenses Expenses
& 588 53,892
Tojects Vendors 4 OVERDUE 21 PAID LAST 30 DAYS
Workers
A~
Reports
[ | Betch actions ~ Q,
Texes
[] | vewpor +/ comeany PHONE EMAIL ‘OPEN BALANCE ACTION
Accounting
s [] Bob's Burger Joint 50.00 Creats bill ¥
My Accountant
is [
| 1_300*8 by_BESSIS & (630} 555-7745 Books@Intuit.com $0.00 Craata bill v

The Vendor Center is like the Customer Center, except it's related to vendors, not customers.

® The colorful money bar at the top of this center relates to potential expenses (open purchase
orders), unpaid and overdue bills and what has been paid in the last 30 days

@ |If you click any of these color blocks, QuickBooks will display the underlying list of transactions
that pertain to that section; if you keep drilling down, you can ultimately drill down into individual
transactions to review, edit or deletie

® Although you can always create a new vendor on the fly in transactions by simply typing a new
vendor name in the Vendor field, the New Vendor button in the Vendor Center also allows you to
create a new vendor
If you click the drop-down next to New Vendor, you can import vendors here

® The Prepare 1099s button allows you to prepare 1099s

® The editing columns, individual transactions, batch transactions, emailing and viewing the
vendor in the Vendor Center work the same as in the Customer Center
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VARIOUS TRANSACTIONS TABS

There are four main ways to enter transactions in the Transactions tab of the left navigation bar:
Banking, Sales, Expenses and Accounting. (And for those who have enabled Projects, there is a fifth
way. You can enter transactions via the Projects tab.)

ab aifiilckhﬂaks

Dashboard

Banking

Sales

Warkers

Reporis

Taxes

Accounting

My Accountant

® Banking - This opens the Banking Center. If you have connected your bank and/or credit card
accounts to QuickBooks, you'll see those accounts listed across the top of the page, as well as a
list of transactions that need to be either matched or added to QuickBooks. You will learn about
that in Topic 4 of this training.
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® Sales - Click Sales in the left navigation bar, then All Sales to open the Sales Center where there
is a Sales money bar that shows potential revenue, unpaid/overdue invoices and what has been
paid in the last 30 days

® Asopposed to the Customer Center which shows a Customer list, the Sales Center shows a
list of transactions that can be filtered

® New transactions can be easily added from the top right corner of the screen by clicking New
transaction

® Next to the New transaction button there is an Import Transactions button which allows you
to import sales transactions from Square, if you have that set up

® The Action column shows suggested next steps, as well as other choices related to that
transaction in the drop-down menu

® Asinthe other centers, you can check multiple transactions and perform batch actions of
printing or sending

Dashboard

Benking

Sales

Expenses

Projects

Workers

Reports

Texes

Accounting

My Accountant

Overview All Sales Invoices Customers Products and Services

Sales Transactions
Invoice

Unisilled Lazz 365 Days Unpaid Laz: 365 Daya _
Payment

Feid

§362 $874 $1,526 136 Estimate

1 ESTIMATE 2 UNBILLED ACTIVITY 10 OVERDUE 12 PAID LAST 30 DAYS SO
Sales Receips

Credit Memo

Dalzyed Chargs

c

D DATE ¥ TYPE NO. CUSTOMER DUE DATE BALANCE TOTAL STATUS ACTION
D 0zM17/2019 Cf‘s'ge 1 Amy's Bird Sanctuary 0z/17/2019 $0.00 $124.00 | Open Create invoice
D Q2M17/2019 Estimate 1001 Sonnenzchein Family ... | 02/17/201¢ $0.00 $342.07 : Pending Create invoice v
B Q1/22/2019 nvoice 1033 Mark Cho 02/21/201¢ $31428 $314.28 : Open Racsive payment v
B o1/22/2019 nvoice 1037 Sonnenschein Family ... : 02/21/2019 $342.07 £342.07 : Open Recsive payment v
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® Expenses - Click Expenses in the left navigation bar, then Expenses to see a list of recent
expense transactions which, like other centers, can be easily filtered

® Click a transaction in the list to open the original transaction

® The types of transactions that can be entered from here are: bills, expenses, checks, purchase
orders or vendor credits

® You can also print checks from this screen

Dashboard Expenses Vendors
Banking .

Expense Transactions | printchecia [ |
Sales B8 “

y epenss
Expenses L=t 363 Dy
Chack
J Batch actions

Projects Purchazs order
DATE ~ TYPE NO. PAYEE CATEGORY TOTAL
vender Cradit
Workers
02416/2019 | Credit Card Expenae Automobile - $34.00
Reports
02/05/201% | Credit Card Credit Checking - $-900.00
Texes
02/03/201% | Credit Card Expense Squeaky Kleen Car Wash Automaobile - $10.99
Accounting

0142842019 | Credit Card Expense Hicks Hardware Job Expenses:job Materials: L w £42.40

My Accountant
27/2019 Credit Card Expensze Sq.JEEk“. Kleen Car Wash Automaobile - s19.99

01/27/2019 : Credit Card Expense Bob's Burger Joint Mzzls and Entertainmant - §18.97

o ooooooo

01/25/2019  Cash Expense Tania's Nursery Job Expensesob MaterizlsF W 5-23.50
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@® Chart of Accounts - Click Accounting in the left navigation bar, then Chart of Accounts (you
may also have to click See your Chart of Accounts), to see a list of your general ledger accounts

® You can double-click the account or select View register to open the register for any balance
sheet account (except Retained Earnings)

® Ifyou click the drop-down next to Add check in the top left corner of a bank account register
you've opened, you can add many types of transactions that affect a bank account:

Check

Deposit

Sales Receipt
Receive Payment
Bill Payment
Refund

Expense

Transfer
Journal Entry

® The types of transactions available from the drop-down will vary depending on the type of
balance sheet account being viewed in the register

¢ Back to Chart of Accounts FHBINEBALANCE
: ) Bank Balance $1 201.00
Bank Register | cresting | «3e2108 ’ 3
Go to: of 1 1-44 of 44
* All
DATE = REF NO. PAYEE MEMO PAYMENT DEFOSIT e BALANCE
TYPE ACCOUNT ]
Add :-eH{F’j CT T
Check
-
Deposit
Ch -
== -
$900.00 $1.201.00
CC-Cradit Mastercard
Tania's Nursery 523.50 $2,101.00
Cash Purch Job Expenses:Job MaterialzFlants and So
7 £75.00 £2,124350
Expenzs nal Fes:
01/22/2019 75 Hicks Hardware $22875 $2.199.50
Checl Sp
ot/22/2019 384513 5242825
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® Back in the Chart of Accounts, if you click the drop-down next to View register you can:

e Editthe account
® Make the account inactive
® Runareport(an Account QuickReport)

Craig's Design and Landscaping Services
ACCOUNT QUICKREPORT
Since November 19, 2018
DATE TRAMNSACTION TYPE MUM NAME MEMO/DESCRIPTION ACCOUNT CLR AMOUNT BALANCE
~ Cheacking
Beginning Balance
Check 4 Chin's Gaz and Oil Checking
Szles Tax Fayment Q1 Payment Checking
Szles Tax Fayment Q1 Payment Chacking
Expense g Tania's Mursery Checking
Check 12 Books by Bessie Checking
Check 5 Chin's Gaz and Oil Checking
Expenze 15 Tania's Mursery Chacking
Sales Receipt 1008 Kate Whelan Chacking
Fayment S&64 Freeman Sporting Goods:55 ... Checking
Payment Amy's Bird Sanctuary Amy claims the pest contral d...  Checking
Bill Fayment (Chack) 7 Hicks Hardwars Checking
01/04/201% Expense 8 Hicks Hardwars Checking
0111372019 Cash Expense Bob's Burger Joint Checking
01/13/200¢9 Check Tony Rondonuwu Checking
01/13/2019 Caszh Expanze Squeaky ¥lean Car Wash Chacking

® You can select Run report to view an Account QuickReport for any Profit and Loss account

To summarize, the Navigation bar, in general, and the various Transactions tabs specifically,
(Banking, Sales, Expenses and Accounting, and Projects, if this feature is enabled) are places to go to
enter transactions.

However, there is one other place to launch all transactions and we will cover it next.
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® Projects - If the Projects feature in QuickBooks Online Plus has been enabled, you can launch
transactions related to a project from the Projects area of the left navigation bar. (You will not see
the Projects tab in the left navigation bar unless this feature is enabled by clicking the gear icon
- Account and Settings > Advanced - Projects.)

® Click Projects in the left navigation bar. If there are no pre-existing projects, click Add your
first project.

Dashboard

Banking

Seles ‘

Expenses

Workers

See all the pieces fit together

Get a better picture of your project when you tag transactions to that
project and run related reports.

Add your first project

Reports

Texes

Accounting

My Accountant

® If there are pre-existing projects and you wish to add one, click New project in the top right
corner

Dashboard Projects
Banking In prograss - &l customers A
Seles

:Down?traw?rli{\_andscaping Options v

Expenses
Workers
Reports
Texes
Accounting

My Accountant
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Topic 2: Navigate

® If you wish to add a transaction to a pre-existing project, click the project name in the list of
projects, then click Add to project. You can add any of the following transactions to the
chosen project: Invoice, Receive payment, Expense, Estimate, Time entry, Bill, and Purchase

order.

Dashboard @ Alprejes

Downtown LA Landscaping

E2pig Bill's Windsurf Shep | In progress
Add notes

Seles

Expenses

Frojects Project reports Transactions
——

Workers

Reports 1 Project profitability

. Hew much you're makin
Texes
Accounting Nonbillsble time

My Accountant

- Unbilled time and expenses

el

Inveice
Recsiva payment
Expense
Estimate

Time

Sill

Purchase order
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Quick CREATE

The Quick Create icon is at the top right of the QuickBooks Online page. It's the + key that spins into
an X when you click it. This is your one-stop shop for creating new transactions.

There are two views of Quick Create. There's a condensed view that just shows the common
transactions of Invoice, Estimate, Expense and Check, and a Show More view that lists all
transactions in QuickBooks sorted by the different areas of the company: Customers, Vendors,
Employees and Other. The choice of view is sticky; QuickBooks Online remembers which view you
prefer and offers it to you the next time you click the Quick Create button.

Create
Invoice
Estimate

Expense

Check

¥ Show more

Create

Customers Vendors Employees Other
Invoice Expense Payroll # Bank Deposit
Recaive Payment Check Single Time Activity Transfer
Estimats Bill Weskly Timesheet Journal Entry

Credit Memo
Sales Receipt
Refund Recsipt
Delayed Credit

Delaysd Charge

Pay Bills

Purchase Order
Vendor Cradit
Credit Card Credit

Print Checks

b Show less

Statement

Inventory Cty

Adjustment

Course 2 - Navigate QuickBooks Online

23



QuickBooks Online 2019 Client Training Guide Conclusion

Course Conclusion

You have just covered Course 2 - Navigate QuickBooks Online. This course has been developed to
help you train your clients on how to use QuickBooks Online successfully.

By completing this module, your client should understand:

® Best practices in QuickBooks Online

® How to navigate around QuickBooks Online
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Lesson 1 — Get Started Lesson Objectives

Lesson Objectives

Gain an overview of the course and the topics to be covered
Understand how QuickBooks Desktop (aka QuickBooks) works and how to get around in it
Learn common business terms used by QuickBooks

Practice using the QuickBooks Help tools

See how to exit QuickBooks
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Forms

You record most of your daily business transactions in QuickBooks Desktop on a QuickBooks form,
which looks just like a paper form. Here's an example of the form you use when you want to record a
bill from one of your vendors.

Enter Bills
Main Reports oA
¢*» B B XQoeweeewr @ § B O B B B
Find Mew  Save Delete ¢Mamulize Print Aftach Select  Enfer Clear Recalculate Pay
- - File PO Time Splits Bill
@ Bil 0 Credit | Bill Received
Vendor
SUMMARY &
VENDOR  Cal Gas & Electric - DATE 12/15/2023 @
Mol S Fhone 415-555-0202
ADDRESS ggl gas g‘olé\;ctric S Open balance 12268
Mld.dl:ﬁxeldCASMBZ AMOUNTFILIE, S5 68 POs to be received 0
BILL DUE 12/30/2024 [
TERMS  |Net 15 - DISCOUNT DATE
MEMO Acct#560-82645-99C
RECENT TRANSACTION &
Expenses $122.68 ltems $0.00 i
121523 Bill 122.68
ACCOUNT _ AMOUNT MEMO CUSTOMER.JCE E# CLASS . 11125123 Check a753
65100 - Utilities: 65110 -... 122.68 Overhead Qverhead 10125123 Check 56.87
09/05/23 Bill Pmt-Check 122.68
08/25/23 Bill - Paid 122.68
v NOTES ¢
Save & Close | Save & New | Revert
NOTES
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Lists

The list is another basic QuickBooks feature. You fill out most QuickBooks forms by selecting entries
from a list.

Note: In the Enter Bills window above, the information in the Vendor, Terms, Account and
Customer/Job fields are pulled from lists.

QuickBooks uses lists to store information about customers, vendors, employees, items or services
you sell, and so on. Lists save time and help you enter information consistently and correctly.

When you're filling out an invoice form and you select a customer name from the Customer/Job list,
QuickBooks not only fills in the name, but also the address, payment terms and customer's sales tax,
based on the information previously entered in the customer’s record in the Customer Center.

Here's an example of the Customers & Jobs list in the Customer Center. You can customize columns
in the list by right- clicking a column header and choosing Customize Columns.

M New Customer&Job v f| NewIransactions v (=) Print Excel ¥ Word ¥ Collections Center & Income Tracker
Customers & Jobs
Active Customers. - <
el
- Abercrombie, Kristy
< Family Room
< Kitchen 0.00
+Remodel Bathroom 6,967.13
+ Allard, Robert 300.00
+Remodel 0.00
= Anthony's Pizza Parlor 0.00
+ Babcock's Music Shop 0.00
+Remodel 0.00
+ Baker, Chris 0.00
+Family Room 0.00
»Garage Repair 0.00
+ Balak, Mike 0.00
+Utility Shed 0.00
+ Barley, Renee 0.00
+Repairs 0.00
+ Bauman, Mark 3,925.00
+Home Remodel 3,925.00
NOTES
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Registers

Registers

In addition to forms and lists, you'll also work with registers in QuickBooks. Just as you use your
paper checkbook register to see a record of all the transactions in your checking account — checks
you've written, other withdrawals you've made, as well as deposits — a QuickBooks register is a
record of all the activity in that one account. (Some people use registers for entering transactions,
although the preferred method is to use forms.) AlImost every QuickBooks account on the balance
sheet (all assets, liabilities and equity accounts) has its own register. (The exception is Retained
Earnings.) See the next section All the Accounting You Need to Know for more information.

Accounts Receivable is the record of money owed to that business; that is, the outstanding invoices

for which a business has not yet received payment from customers.

Here's an example of the register for an Accounts Receivable account.

11000 - Accounts Receivable

& Goto.. | &) Print... | [5 Edit Transaction [E8) QuickReport
DATE BER CUSTOMER ITE an RATE A AMT PAID
12M5/2023 Abercrombie, Kristy Remodel Bathroom 7,633.28
PMT
12M5/2023 Brenda Bowden_c 10,000.00
PMT
12M5/2023 68 Vasquez, Anabel:-Basement Remodel 862.00
1NV 12/30/2023
121152023 69 Ted Customer 45.000.00
1NV 121152023
12M15/2023 |73 Bauman, MarkHome Remadel 3,925.00
1NV 12/30/2023
121152023 T4 Bristol, Sonya:Repairs 3,925.00
1NV 01M14i2024
12115/2023 75 Bristol, Sonya:Utility Shed 3,925.00
1NV 01M14i2024
12M15/2023 |78 Burch, Jason:Room Addition 3,925.00
1NV 01M14i2024
1-Line Show open balance ENDING BALANCE 1 25,491 .63
Somtby  Date, Type, Number/Ref = | Record | Restore
NOTES
QuickBooks 2019 Student Guide 8



Lesson 1 — Get Started Get Around in QuickBooks

Get Around in QuickBooks

QuickBooks provides access to information to help you get started.

]

o Step-by-Step: Get Started

1. Select F1 on your keyboard or, in the Help menu, select QuickBooks Desktop Help. Scroll
down the window that appears.

Have a Ques

Ask your question here Q

Get started with QuickBooks Desktop

After you create a company file, you can start using QuickBooks right away. However, we recommend that you continue setting
up your business to make sure your financial statements are accurate.

Although you set up your basic company information when you created your company file, you still need to set up additional,
company-specific information. You can enter this information as you work, or you can enter this information now.

« Add your customers

+ Add your vendors

+ Set up QuickBooks Desktop Payroll

+ Add your employees

+ Set up the items you buy and sell

+ Set up your other accounts (bank accounts, etc.)

+ Make sure QuickBooks is up to date by entering all transactions that occurred before your start date
« Set up your sales tax information (if you charge sales tax)
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2. Click the link Download the QuickBooks User Guide and Quick Start Guide.

Have a Qu

Ask your question here Q

Feel free to just dive in and start using QuickBooks. If you're not sure where to start, take a moment to learn about the basics:

+ Choose the right sales form and bill your customers
+ Receive payments from your customers

+ Pay your bills

+ Customize your sales forms

+ Set up passwords and additional users

* Back up your QuickBooks data

To help you get started, you can:

+ Get help for common tasks
QuickBooks has a full-featured Help system to get you the information you need. To get help from anywhere within
QuickBooks, just press F1. You can also enter a search term at the top of the Help window.
You can also Download the QuickBooks User Guide and Quick Start Guide,
+ Visit the QuickBooks support site to search in-depth support articles or get{llp from a QuickBooks support representative.
* Visit the Intuit Community to connect with other QuickBooks users and small business owners.
* Find a local QuickBooks expert.
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3.

Click the link(s) to download the guide(s).

Have a Question?

Access QuickBooks user manuals and installation guides

Access manuals, guides, and demos for selected editions of QuickBooks products.

User Manuals for QuickBooks Desktop for Windows
= QuickBooks 2018
+ QuickBooks 201%J
» QuickBooks 2016

User Manual for QuickBooks Desktop for Mac

* QuickBooks for Mac 2016 official eBook

By looking under User Manuals for QuickBooks Desktop for Windows, you can open, or
download and save as PDF various resources from QuickBooks Desktop for Windows, version
years 2016 through 2018. (It also includes the QuickBooks for Mac 2016 official eBook.) All these
version-years offer the two-page QuickBooks Quick Start Guide and the 22-page QuickBooks
User Guide, which includes a visual guide. QuickBooks 2016 also offers QuickBooks 2016: The
Missing Manual - The Official Intuit Guide to QuickBooks, also available at https://http-
download.intuit.com/http.intuit/CMO/quickbooks/2016/docs/QuickBooks 2016 The Missing
Manual.pdf , which will help guide you through many tasks, including the following.

Manage your open windows - QuickBooks can be set to display one window at a time or
several windows (organized side-by-side or cascaded)

Use the menu bar - You can find all commands on the menu bar

FEile Edit Wiew Lists Favorites Company Customers Vendors Employees Banking Reports Window Help
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® Use the top icon bar - The top icon bar allows you to manage your business more quickly and
provides quick access to the centers

v - = - B . = = s S » =
» ® B & 2 T M B E & G MG -5
Home My Company Income Tracker Bill Tracker Calendar | Snapshols Customers Vendors Employees | Docs Reports OrderChecks Userlicenses | Invoice fem  Check  Bil  Reg  Acent Rmr

@ Use the left side navigation - The left side navigation acts like the top icon bar, allowing you
access to quick and easy shortcuts. Use the top icon bar, the left side navigation or neither. You
cannot use both the top icon bar and the left side navigation at the same time.

Search Company or Help  ~ [RSPSEEES

My Shortcuts

B Employees

1l Bank Feeds
Docs
E Reports

o Order Checks
e Add Payroll

B Credit Cards

@ My Shoricuts
B view Balances
M Run Favorite Reports

) Open Windows

Do More With QuickBooks

g Turn on Payroll

& Accept Credit Cards

= Order Checks & Supplies

o QuickBooks Online Accountant
T Activate TSheets
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Get Around in QuickBooks

® QuickBooks Centers - For Customers, Vendors, Employees, Reports and Bank Feeds, these
Centers offer quick access to common tasks

® Make the Home page your starting point - The Home page provides a graphical
representation of the workflow, organized into logical groups. You can click any of these icons on

the Home page to launch a window or transaction represented by the icon.

pd
=
Purchase
Orders

By

Sales
Orders

Estimates

Payroll
Center

="

Recaive
Inventory
=]
Enter Bills
= a8
Create
Invoices

Statement
Charges

Enter
Time

Employees

VENDORS

®

Home

Enter Bills Manage
Against Sales
Inventory Tax
Pay Bills
CUSTOMERS
E Create Sales
Accept Receipts
Credit Cards
Receive
Payments
Finance Statements Refunds
Charges & Credits
EMPLOYEES

= S

Pay Pay
Liabilities

2 &

Process HR Essentials
Payroll and Insurance
Forms

COMPANY
= v
Chart of Inventory
Accounts Activities
ik
Items &
Senices
N
QuickBooks Calendar
Mobile
BANKING
g ©
Record Reconcile
Deposits

4

Write
Checks

]

Print
Checks

Check
Register

=

Enter Credit
Card Charges

You are using a sample
company file

Create a new company file

ACCOUNT BALANCES
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Lesson 1 — Get Started Get Around in QuickBooks

® Get an overview of your company - The Insights tab of the Home page gives you real-time
information about how your company is doing and provides a location where you can keep track
of the tasks you need to perform. You can also get more detailed information from the Company
Snapshot found in both the Reports and the Company drop-down menus.

Home - 0 3
Rock Castle Construction
Friday, December 15 2023
Profit & Loss | This Fiscal Year-to-date -
7 Snapshot
Company Payments Customer Search
A
= Add Content » | Restore Default How do | custg
5
164,006.43 8
NET INCOME < r__q Income and Expense Trend « X  Prev Year Income Comparison w X Customers Who Owe I
505,730.40 L $in 1000s This yearto-date  ~ Al w7 Yearly ] | pe——
INCOME . ceee
241.723.97 ] 120 $ in1000s Abercrombie, Kristy
EXPENSES 100 600 Ted Customer
a0 500 Bolinski, Rafal
Allard, Robert
400 '
Income &0 Bauman, Mark
300
40 Vasquez, Anabel
20 200 Bristol, Sonya
UNPAID PAI . 100 I Burch, Jason
G e e fr May dn s S Om N e o | Mackey's Nursery and .
2018 2019 2020 2021 2022 2023 Pretell Real Estate
125.491.63 0.00 0.0l N income NN Expense I Frior Year(s) W CurrentYear
OPEN INVOICES OVERDUE PAI
Account Balances * ¥ TopCustomers by Sales - X 535 YearF_xDense_CG
N - Al w7
o . A This year-to-date  +
- Feseo e T $in 1000s
@ TumonPayroll () Accept o  * Accounts Receivable 125,491.63 v
bl »
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Lesson 1 — Get Started All the Accounting You Need to Know

All the Accounting You Need to Know

ABOUT THE CHART OF ACCOUNTS

® Chart of Accounts
® The Chart of Accounts is a complete list of your business accounts and their balances

® An account is a tracking category for your business’s assets, liabilities, equity, income and
expenses

® When you keep books for a company, you want to track:
® Where the income comes from
® Where you put it
® What the expenses are for
® What you use to pay them

® You track this flow of money through the Chart of Accounts

Look for account name or number

MAME § : TYFE RIPTICN ALAN
. Checking account at Bank of America A

+ 10300 - Savings ¢ Bank Savings 17,8910.19 '

+ 10100 - Checking 4 Bank Cash 83,154.95

+ 10400 - Petty Cash Bank Petty Cash T00.00

+ 11000 - Accounts Receivable Accounts Receivable  |Accounts Receivable 125,491.63

+ 12800 - Employee Advances Other Current Asset Employee Advances T70.00

+ 12100 - Inventory Asset Other Current Asset Inventory Asset 3372528

+ 13100 - Pre-paid Insurance Other Current Asset Pre-paid Insurance 4,050.00

+ 13400 - Retainage Receivable Other CurrentAsset Retainage Receivable 3,703.02

+ 12000 - Undeposited Funds Other Current Asset Undeposited Funds 3242098

+ 17000 - Accumulated Depreciation Fixed Asset Accumulated Depreciation -110,344 .60

+ 15200 - Buildings and Improvements Fixed Asset Buildings and Improvements 325,000.00

+ 15300 - Construction Equipment Fixed Asset Construction Equipment 15,300.00

+ 15000 - Furniture and Equipment Fixed Asset Furniture and Equipment 34,326.00

+ 16900 - Land Fixed Asset Land 90,000.00

+ 15100 - Vehicles Fixed Asset Vehicles 78,936.91

+ 18700 - Security Deposits Other Asset Security Deposits 1,720.00

+ 20000 - Accounts Payable Accounts Payable Moneys you owe to vendors and suppliers 48,136.92

+ 20600 - CalQil Credit Card Credit Card 38262

+ 20500 - QuickBooks Credit Card # Credit Card QuickBooks Credit Card 9420 "

Account ¥ | Activities v | Reports v | Attach Include inactive
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Lesson 1 — Get Started All the Accounting You Need to Know

ABOUT ASSETS, LIABILITIES AND EQUITY

® Assets
® Include both what you have or own and what others owe you

® The money people owe you from outstanding invoices is called your accounts receivable or
A/R for short. QuickBooks uses an accounts receivable account to track the money owed to
you by customers from invoices. You may have additional notes receivable if the business has
issued loans that are due for repayment. These additional notes receivable would not be
classified as A/R as they're not related to sales and so they'd be classified either as an Other
Current asset (if the money is owed within a year) or an Other asset (if it's owed for a longer
period than a year).

® The rest of your company'’s assets may include checking accounts, savings accounts, petty
cash, fixed assets (such as equipment or trucks), inventory and undeposited funds (money
you've received from customers but haven't yet deposited in the bank)

® Liabilities
® What your company owes to others
® The money you owe for unpaid bills is your accounts payable or A/P for short. QuickBooks

uses an accounts payable account to track the money you owe to vendors or suppliers for
bills

® Aliability can be a formal loan, an unpaid bill, or sales and payroll taxes you owe to the
government. When setting up your company file in QuickBooks, note that even though
unpaid bills are liabilities, they will be set up as accounts payable type accounts in
QuickBooks.

® Equity
® Equity is the difference between what you have (your assets) and what you owe (your
liabilities): Equity = Assets - Liabilities
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Lesson 1 — Get Started All the Accounting You Need to Know

CASH VERSUS ACCRUAL BOOKKEEPING

® Cash basis

® Income is recorded when money (from sales) is received; expenses are recorded when
money (from bills) is paid. In other words, income and expenses are recognized based on the
date money changes hands.

® Accrual basis

® Income is recorded at the time of the sale; expenses are recorded when you receive the bill.
In other words, income and expenses are recognized based on the date of the paperwork.

&

TIP: You can change or set the default reporting basis (accrual or cash) for summary reports
in the preferences of the company, based on the bookkeeping method you have chosen for
tax purposes. You can change the reporting basis of individual reports (except transaction

detail reports) by customizing the reports.

MEASURE BUSINESS PROFITABILITY

® The Balance Sheet - A snapshot of your company on one date. It shows:

® What your business has, including what others owe your business (assets and accounts
receivable)

® What your business owes to others, including to vendors/suppliers (liabilities and accounts
payable)

® The net worth of your business (equity)

® The Profit & Loss Statement - Also known as the Income Statement, it covers activity over a
particular date range (with a start date and an end date). It shows:

® Income
® Expenses
® Net profit or loss (income less expenses)

® The Statement of Cash Flows - This also covers activity over a particular date range (with a start
date and an end date). It shows:

® Receipts
® Payments
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Lesson 1 — Get Started All the Accounting You Need to Know

GENERAL JOURNAL TRANSACTIONS

® Traditional accounting method

Known as double-entry accounting

Total amount in the Debit column equals the total amount in the Credit column

Each amount is assigned to an account in the Chart of Accounts

To view the journal entry for a transaction, open the transaction and press Ctrl+y or, from the
Reports tab in the transaction window, click Transaction Journal

® |[f necessary, click Customize Report and choose to display the Credit and Debit columns
(rather than the Amount column)

Create

Main Formatiing Send/Ship Reporis oA

g @ 0]

Quick Transaction Transaction View Open Sales By Average Days To
Report History Joumnal Duoises gmarDetoll Do

CUSTOMER-JOB (Sl & =EY]

= Transaction Journal

Customize Report

Comment on Report ~ Share Template | Memorize Print v E-mail ¥ Excel ¥ | Hide Header Refresh

Dates  All *  From B To B SortBy Default -
| nV0|ce Sed Show Filters
3:08 PM Rock Castle Construction
T2z Transaction Journal
All Transactions
Trans # Type Date Num Name Memo Item Item Description Account Class Sales .. Debit Credit
3 1058 Invoice 121152023 1088 Cook, Brian:Kitchen 11000 - Accounts... Remode! 1,636.69 4

ITEM Cook, Brian:Kitchen Gas Rangetop  Appliance 40140 - Materials 1. Remode! 247.50 24750
Appliance Cook, Brian:Kitchen Double oven Appliance 40140 - Materials | Remode! 350.00 350.00
Appliance Cook, Brian:Kitchen Dishwasher Appliance 40140 - Materials 1. Remode! 450.00 450.00
Appliance Cook, Brian:Kitchen Greenhouse. Window. Window 40140 - Materials | Remode! 475.00 475.00

Window Cock, Brian:Kitchen Removal labor  Remova... Removal labor 40130 - Labor Inco. Remode| 45.50 0.00

Subtotal Cook, Brian:Kitchen Framing labor Framing. Framing labor 40130 - Labor Inco Remode! 66.00 0.00

Cook, Brian:Kitchen ion la Installati ion labor 40130 - Labor Inco. Remodel 38.50 0.00

Cook, Brian:Kitchen Install tile or ... Subs:Til.. Install tile or cou 40150 - Subcontra...  Remodel 1,320.00 0.00

Cook, Brian:Kitchen Painting Subs:Pa.. Painting 40150 - Subcontra...  Remodel 825.00 0.00

“Your customer can't pa

Turn on Cock, Brian:Kitchen Plumbing Subs:Plu... Plumbing 40150 - Subcontra...  Remodel 1,100.00 0.00

CUSTOMER MESSAGE Cook, Brian:Kitchen Install drywall Subs:Dr. Install drywall 40150 - Subcontra Remode! 1,000.00 0.00
State Board of Egu...  CAsales tax. San Dom. CA sales tax, Sa 25500 - Sales Tax... Remode! 7.5% 114.19

163568 163669
TOTAL 163669  1,636.69

&

NOTES
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Lesson 1 — Get Started Get Help while Using QuickBooks

Get Help while Using QuickBooks

QuickBooks provides extensive help in various formats. When you have questions,
QuickBooks provides:

® Onscreen QuickBooks Desktop Help to provide conceptual information and step-by-step
instructions, which includes links to The QuickBooks Quick Start Guide and the QuickBooks User
Guide as described in the section Get Around in QuickBooks.

® New Features section highlights new and improved features in the current version year
of QuickBooks

® The Year-End Guide

Support and Ask Intuit links for answers to specific questions

The onscreen Help provides several different types of information:

Conceptual explanations of how to apply QuickBooks to your particular business situation
Step-by-step instructions
A search engine that provides a list of topics related to the word or phrase you enter

Information relevant to the task you are currently performing

Access to community forums where you can exchange information with QuickBooks experts
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Lesson 1 — Get Started Get Help while Using QuickBooks

@
o Step-by-Step: Find a Topic in Onscreen Help

1. Press F1 or from the Help menu choose QuickBooks Desktop Help. This brings up the Have a
Question? window.

2. Inthe Have a Question? window, use the search box to type in a full question or one or more
keywords. QuickBooks displays a list of help articles and community forum answers.

invoice

Create invoices with payment link
Create invoices that your customers can pay online with E-invoicing. Note: This feature is supported in QuickBooks
Desktop...

sl 2

Accountant tools: Write off invoices
Overview Note: The following information applies only to QuickBooks Accountant and QuickBooks Enterprise Solutions.
Use this...

Create an invoice in QuickBooks Desktop
You use invoice to record sales transactions from customers who make no or partial payment during the time of the sale....

T_ a Need Support?
/ Contact Us

NOTES

QuickBooks 2019 Student Guide 20



Lesson 1 — Get Started Exit QuickBooks

Exit QuickBooks

Unlike most other Windows programs, QuickBooks doesn’t require you to save your data before
exiting. It does an automatic save while you're working (after every transaction is created, changed
or deleted) and every time you leave the program.

® To exit QuickBooks, from the File menu, choose Exit

To prevent or minimize data loss, you should make regular backup copies of your QuickBooks
company data. In the event of data loss, you can restore your data from the backup copy.

® To make a backup copy, from the File menu, choose Back Up Company. A copy is a
compressed complete copy of your data file used to restore your working file in case it is

compromised. It is a best practice to store your backups on a different drive from your working
file.

NOTES
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Lesson 1 — Get Started Move between Company Files

Move between Company Files

If you work with several companies, you'll work with multiple QuickBooks company files. You can
switch from one company file to another at any time, but you can have only one company file open
at a time. (Two exceptions are QuickBooks Accountant Desktop and QuickBooks Desktop Enterprise
Solutions, which allow you to open two company files at one time.)

QuickBooks provides an easy way to find and open a company file you've worked with before.

@
o Step-by-Step: Open a Previously Opened File

1. From the File menu choose Open Previous Company.

2. From the submenu select the company file you want to open.

@
o Step-by-Step: Change the Number of Company Files Displayed

in the Submenu

1. Make sure you're logged into a QuickBooks company file as the Admin user.
2. From the File menu choose Open Previous Company.

3. Choose Set number of previous companies.

4. Enter the number of company files you want QuickBooks to display (up to 20).

5. Click OK.

Alternately:
1. From the File menu choose Close Company/Logoff.
The No Company Open screen will appear.

2. Click Edit List to hide companies you no longer wish to see in this list or in the Open Previous
Company list.

3. Click a checkmark in the Hide column next to each company you no longer wish to appear in the
list.

4. Click OK.
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Lesson 1 — Get Started Get Started — Review Questions

Get Started - Review Questions

1. List the three main ways you enter data in QuickBooks.

2. Listthree ways to access features in QuickBooks.

3. What bookkeeping methods can you use to create reports in QuickBooks?

4. Which of the following would you not include in the Chart of Accounts?
a. Checking account
b. Vendor record
c. Depreciation expense
d. Accounts payable
5. Which of the following is an asset?
a. Accounts payable
b. Accounts receivable
c. Company delivery van
d. Bothaandb

e. Bothbandc
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Lesson 1 — Get Started Get Started — Review Questions

6. Checking, savings and petty cash should be set up as which of the following account types in
QuickBooks?

a. Expense
b. Other current asset
c. Bank
d. Equity
7. Which of the following best describes a balance sheet?
a. Asummary of a company’s finances over the past year
b. A financial snapshot of a company at a specific point in time
c. Asummary of a company'’s revenue and expenses for a fiscal year

d. None of the above
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Lesson 1 — Get Started Answers to Review Questions

Answers to Review Questions

1. List the three main ways you enter data in QuickBooks.
Forms, lists, register
2. List three ways to access features in QuickBooks.
Menu bar, Icon bar (top or left), Centers, Home page
3. What bookkeeping methods can you use to create reports in QuickBooks?

Accrual basis and cash basis are the two bookkeeping methods. You can change or set the default
reporting basis for summary reports in the preferences of the company. You can change the
reporting basis of individual reports (except transaction detail reports) by customizing the reports.

4. Which of the following would you not include in the Chart of Accounts?
a. Checking account
b. ¥ Vendor record
c. Depreciation expense
d. Accounts payable
5. Which of the following is an asset?
a. Accounts payable
b. Accounts receivable
c. Company delivery van
d. Bothaandb

e. v Bothbandc

QuickBooks 2019 Student Guide 25



Lesson 1 — Get Started Answers to Review Questions

6. Checking, savings and petty cash should be set up as which of the following account types in
QuickBooks?

a. Expense
b. Other current asset
c. v Bank
d. Equity
7. Which of the following best describes a balance sheet?
a. A summary of a company’s finances over the past year
b. v A financial snapshot of a company at a specific point in time
c. Asummary of a company's revenue and expenses for a fiscal year

d. None of the above
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Copyright

Copyright 2019 Intuit, Inc. Intuit, Inc.
All rights reserved. 5601 Headquarters Drive
Plano, TX 75024

Trademarks

©2019 Intuit, Inc. All rights reserved. Intuit, the Intuit logo, Intuit ProLine, Lacerte,
ProAdvisor, ProSeries and QuickBooks, among others, are trademarks or registered
trademarks of Intuit, Inc. in the United States and other countries. Other parties’ marks
are the property of their respective owners.

Notice to Readers

The publications distributed by Intuit, Inc. are intended to assist accounting
professionals in their practices by providing current and accurate information.
However, no assurance is given that the information is comprehensive in its coverage
or that it is suitable in dealing with a client’s particular situation. Accordingly, the
information provided should not be relied upon as a substitute for independent
research. Intuit, Inc. does not render any accounting, legal or other professional
advice, nor does it have any responsibility for updating or revising any information
presented herein. Intuit, Inc. cannot warrant that the material contained herein will
continue to be accurate nor that it is completely free of errors when published.
Readers should verify statements before relying on them.
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QuickBooks Online 2019 Client Training

Lesson Objectives

Edit the company Chart of Accounts
Add a new customer to the Customers & Jobs list
Add a new vendor to the Vendor list

Learn about custom fields and practice adding custom fields

See how to manage lists in QuickBooks

Lesson Objectives
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Use QuickBooks Desktop Lists

QuickBooks Desktop lists organize a wide variety of information including data on customers,
vendors, inventory items and more. Lists save time by helping you enter information consistently and
correctly, such as:

® Names, addresses and other information about customers
® Contact information for vendors

® Descriptions and prices for products and services

NOTES
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Edit the Chart of Accounts

The Chart of Accounts is your most important list because it shows how much your business has,
how much it owes, how much money is coming in and how much is being spent. It is the backbone
of any accounting system.

@
o  Step-by-Step: Display the Chart of Accounts

1. From the Lists menu, choose Chart of Accounts or press CTRL+a.

Chart of Ac
Look for account name or number
| search | Reset
MAME ¢ ! TYPE DESCRIPTION BALANCE TOTAL ATTACH
. Checking account at Bank of America
+ 10300 - Savings % Bank Savings 17,910.19
+ 10100 - Checking 4 Bank Cash 83,154.95
+ 10400 - Petty Cash Bank Petty Cash 700.00
+ 11000 - Accounts Receivable Accounts Receivable  Accounts Receivable 125,491.63
+ 12800 - Employee Advances Other Current Asset Employee Advances 770.00
+ 12100 - Inventory Asset Other CurrentAsset Inventory Asset 33725.28
+ 13100 - Pre-paid Insurance Other CurrentAsset Pre-paid Insurance 4,050.00
+ 13400 - Retainage Receivable Other CurrentAsset Retainage Receivable 3,703.02
+ 12000 - Undeposited Funds Other CurrentAsset Undeposited Funds 32,420,958
+ 17000 - Accumulated Depreciation FixedAsset Accumulated Depreciation -110,344.60
+ 15200 - Buildings and Improvements FixedAsset Buildings and Improvements 325,000.00
+ 15300 - Construction Equipment FixedAsset Construction Equipment 15,300.00
+ 15000 - Furniture and Equipment Fixed Asset Furniture and Equipment 34 326.00
+ 16800 - Land FixedAsset Land 90,000.00
+ 15100 - Viehicles FixedAsset Wehicles 78,936.91
+ 18700 - Security Deposits Other Asset Security Deposits 1,720.00
+ 20000 - Accounts Payable Accounts Payable Moneys you owe to vendors and suppliers 4813682
+ 20600 - CalQil Credit Card Credit Card 38262
+ 20500 - QuickBooks Credit Card ¢ | Credit Card QuickBooks Credit Card 94.20
Account ¥ Activities ¥ || Reports ¥ | Attach Include inactive

2. Scroll through the list.

The Chart of Accounts’ default display is by account type: balance sheet accounts first, followed by
income and expense accounts. You can click on the column headings to sort by name or balance
instead of by type.

NOTES
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Edit an Account

@
o Step-by-Step: Edit an Account

Edit an Account

1. Inthe Chart of Accounts, find the account you want to edit, then click on it (once — not a double-

click) to highlight the row.

2. Right-click on the row then click Edit Account or click the Account menu button then select Edit

Account.

3. Edit the information accordingly.

[TTT|  Account Type Bank

General Bank Feed Settings

Edit Account

- Number

AccountName  Checking
Subaccount of

OPTIONAL

Description Cash

BankAcct Mo. 0661001235
Routing Mumber 112200049

Tay-Line Mapping B/S-Assets: Cash

Accountis inactive

Change Opening Balance...

How do | change the account number?
How do | change the routing number?

- How do | choose the right tax line?

the account register.

Remind me to order checks when | reach check number

Order checks | can print from QuickBooks Learn more

| Save & Close |

You can change the opening balance in

10100

Cancel

4. Click Save & Close.

=  IMPORTANT: Some information, like Account Type, is not easily changed. If you set up an account in
error and want to modify it but QuickBooks won't let you make the change, you can delete the account
and start over, assuming no transactions have been posted to it.

NOTES
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Add a Subaccount

A subaccount is a way to break an account down into subcategories for reporting purposes.
Subaccounts appear on reports as indented lines under the main or parent account. This hierarchy
enables you to expand reports to show all subaccounts under a parent, or to collapse all
subaccounts into a parent account for a one-line view.

@
o Step-by-Step: Add a Subaccount

1. Inthe Chart of Accounts, click the Account menu button then choose New.

2. Select the appropriate account type (this must be the same account type as the parent account).
3. Click Continue.

4. Assign an appropriate account name and number if applicable.

5. Select the Subaccount of checkbox then select the parent account from the drop-down list.

Edit Account

[TT]| AccountType  Expense - Number | 60110

AccountName | el
+ Subaccountof 60100 - Automobile -

OPTIONAL

Description | Fuel Expense

Mote

Tax-Line Mappind  <Unassigned= » | How do |l choose the right tax line?

Account is inactive | Save & Close | Cancel

6. Click Save & Close.
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QuickBooks displays the new subaccount in the Chart of Accounts list.

+ 60100 - Automobile Expense Automobile

I S S N
=+ 60120 - Insurance Expense Business Truck Policies
+B60130 - Repairs and Maintenance Expense

7. Close the Chart of Accounts by clicking the X in the top right of the Chart of Accounts window
(not the x in the top right of the QuickBooks window as this will close the program!) or hit the
Esc key.

NOTES
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Customer, Vendor and Employee Centers

The Customer, Vendor and Employee Centers consolidate and organize important information. The
centers contain names, addresses and other information about the items on these lists. They also
hold more specific information, Contacts, To Do’s, Notes, Sent Email, custom fields and other details
you may want to track for each customer, vendor or employee.

(b New Customer & Job * E New Transactions ¥ 5 Print ¥ Excel * Word ¥ [| Collections Center Q Income Tracker

Customer Information 812 4o

A e - 4 Company Name Main Phone 415-555-6579 9115/2003: Send Kristy

Jol FullName  Mrs. Kristy Abercrombie Main Emal kristy@samplename.cm  SSmate for den remodel.

e Customer Type Residential 9/20/2003: Called Kristy to ...

l A°°°“_”:::s- rgq:“;; REPORTS FOR THIS CUSTOMER
+Family Room -1,616.25 BilTo KristyAbercrombie QuickReport
+Kitchen 0.00 5647 Cypress Hill Rd Open Balance
+Patio 0.00 Bayshore G4 94326 Show Estimates
+Remodel Bathroom 6,967.13 Customer Snapshot

« Allard, Robert 300.00
+Remods| 0.00 ’ Transactions Contacts ToDo's Motes Sent Email

+ Anthony's Pizza Parlor 0.00 | swow AlTans. - | Ausesr Al v | oa= [ThisFiscal Year ¥ | 1/01/2023 - 12/31/2023

+ Babcock's Music Shop 0.00 TYPE NUM DATE ¥ NT
+Remodel 0.00 Payment 1211512023 10100 - Checking 763328 A

-+ Baker, Chrig 0.00 General Journal FAMZ2011 12/15/2023 11000 - Accounts R.. 7,633.28
+Family Room 0.00 Credit Memo 71 1211512023 11000 - Accounts R.. -1,616.25
+Garage Repair 0.00 Estimate 513 1211212023 90200 - Estimates 767613

« Balak, Mike 0.00 Invoice 1081 1211012023 11000 - Accounts R.. 4,522.00
+ Utility Shed 0.00 Check 476 12/01/2023 10100 - Checking 0.00

+ Barley, Renee 0.00 Credit Memo 4002 12/01/2023 11000 - Accounts R.. 15 o
+Repairs 0.00

« Bauman, Mark 3,925.00 - Manage Transactions v Run Reports -
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Custom Contact

Fields

Custom Contact Fields

Each name listed on the Customer, Vendor and Employee Centers includes eight fields for contact
information. All eight of these contact fields for phone numbers, email addresses and URLs can be
customized per the drop-down list of available contact descriptions (mobile phones, social media

information, etc.).

custonzEr nave Abercrombie, Kristy
CURRENT BALANCE 0,00 How do | adjust the current balance?
Address Info Emeanes
Payment Settings FULL NaME  MIs. Kristy 111 Abercrombie
Sales Tax Seftings AR
Main Phone ~  415-555-6579 Main Email -
Addsonalio Work Phone = CC Email bt
Mobile - Website >
Fa . -
ADDRESS DETAILS
i Home Phone
Kristy Abercrombie
5647 Cypress Hill Rd Alt. Phone
Bayshore CA94326 Cop|
Alt. Mobile
Alt. Fax
Alt. Email 1
"I Customer is inactive Alt. Email 2
Linkedin
Facebook
Twitter

kristy@samplename.com

ipTo1

rcrombie
ress Hill Rd
CA 94326

|shipping address

Cancel

S +

Help

Lesson 3 — Work with Lists
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Work with the Customer Center and the
Customers & Jobs List

The Customer Center's Customers & Jobs list stores names, addresses and other information about
your customers. It also holds information about the jobs or projects you may want to track for each
customer.

The Customer Center is the dashboard that can launch sales forms (sales orders, estimates, invoices,
sales receipts, statement charges, receive payments and credit memos/refunds) and display
accounts receivable.

ADD CUSTOMERS

@
o Step-by-Step: Add a Customer

1. There are multiple ways to do almost anything in QuickBooks. To access the Customer Center,
you have four options:

® Click Customers from the left-hand or top icon bar (depending on your View settings)
® Choose Customer Center from the Customers drop-down in the menu bar

® From the Home page, click the blue Customers tab in the Customers section

® Press CTRL+j

2. Click the New Customer & Job menu button then choose New Customer.

3. Inthe Customer Name field, enter the name of the customer as you'd like it to appear on your
Customers & Jobs list.

4. Press Tab past the Opening Balance field to leave this field blank.

The Opening Balance field tells you how much each customer owes you on your start date, so
when you enter the rest of your transactions from the day after your start date to today, all
balances since your start date will be accurate.

It is recommended to enter individual outstanding invoices one by one whenever possible rather
than enter the outstanding balance owed in the Opening Balance field.

5. Complete the customer contact information appropriately.

Lesson 3 — Work with Lists 14
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You can have and use more than one Ship To address per customer or job. Add them with the

Ship To drop-down or by clicking the + sign in the bottom right corner.

MNew Cus

CUSTOMER NAME

OFEMING BALANCE asoF | 12M5/2023 B How do | determine the opening balance?

Address Info

COMPAMY MAME
Payment Settings FULL NaME | Mr/Ms L. | First M.I. ||Last
: JOB TITLE

Sales Tax Settings

Main Phone « Main Email =
Additional Info .

Work Phone = CC Email -
Job Info Mobile - Website -

Fax - Other 1 -

ADDRESS DETAILS

INVOICE/BILL TO SHIF TO -
& =

Copy ==

Customer is inactive;
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6. Click OK to add this customer. The Customer Center appears with the Customers & Jobs list
along the left side. (New names appear in the correct alphabetical order in the list. Customer
names can be moved around in this list, so they are no longer alphabetical. Right-click the list
then choose Re-sort List to return the names to alphabetical order.)

Customer Center: Esther Friedberg Karp

Edit Customer
Esther Friedberg Karp)
Active Customers - How do | adjust the current balance?
’e) dress Info comPany NaME | EFK CompuBooks Inc.

@ NAME = BALAN Payment Settings FULL NAME  Ms. Esther M1 Friedberg Karp
« Esther Friedberg Karp 0.00 JOB TITLE

) ) Sales Tax Settings

Fisher, Jennifer 0.00 -

* ' Main Phone = (416) 410-0750 Main Email =  esther@e-compubooks.com

+Garage Roof 0.00 Additional Info :

+Home Remodel 0.00 Work Phone = CC Email -
» Fomin, Slava 0.00 Job Info Mobile - Website -

+Utility Shed 0.00 Fax = Other 1 -
+ Freeman, Kirby 0.00

ADDRESS DETAILS
+Remodel Bathroom 0.00
- INVOICEBILL TO SHIF TO -
+Repairs 0.00
EFK CompuBoaks Inc

© Hendro Riyadi 4.223.00 10618 Toronto Ave. d i

+Remadel Kitchen 4,223.00 Northridge, CA913268 Copy >>

Esther Friedberg K:

+ Jacobsen, Doug 432000 LT B T

«+Kitchen 4,320.00

+Poolhouse 0.00
+ Jimenez, Cristina 0.00

+Utility Shed 0.00 o

Customer is inactive @ Cancel Help
+ Johnson, Gardon 0.00
Utility Shed 0.00
+Utility She: =

= IMPORTANT: The Customers & Jobs list is the same as the Customer/Job list. It is called Customers &
Jobs on the Customer Center and Customer:Job on forms. It is sometimes also referred to as simply the
Customer list.

PROVIDE ADDITIONAL CUSTOMER INFORMATION

There are additional tabs for Payment Settings, Sales Tax Settings, Additional Info and Job Info
where you can provide other important information.

NOTES
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Sales Tax Settings

There are multiple levels of taxability in QuickBooks. Taxability can be assigned by the item, the
customer and each individual sale for:

@ Item default taxability - This determines whether the item is displayed as taxable or nontaxable
each time it is used on a sales form. This is a default setting that can be overridden on the
individual form when the item is used.

® Customer default taxability

® Tax Code - Here you can set a customer to be taxable or nontaxable. If the customer is set up
as nontaxable, this overrides the item setup when taxable items are used on a sales form. This
can be changed on a sales form.

® Tax Item - This is the line tax item to which the customer’s sales will default on the Sales Tax
Report. If the customer’s tax code is Tax, the rate from the Tax Item drop-down will be
assigned. If the customer’s tax code is Non, the rate will not be applied but the sale will still
be grouped with that rate in the Sales Tax Report. This can also be changed on a sales form.

Edit Customer

cusToMER NaMmE | Pretell Real Estate

CURRENT BALANGE 5,026.50 How do | adjust the current balance?

Address Info Ty cone | Tax — n

Payment Settings
= g Tex TEM | San Domingo -

Sales Tax Settings

Additional Info
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The Payment Settings tab is where you enter customer account numbers and credit limits. You can
also record information about each customer’s payment terms, preferred delivery method of
invoices and preferred payment method. For customers who pay by credit card, you can enter credit
card numbers and expiration dates.

Edit Customer

cusTomeRr Mame | Pretell Real Estate

CURRENT BALANCE 5,026.50 How do | adjust the current balance?

Address Info “

ACCOUNT NO. CREDIT LIMIT
Payment Settings
ray g FAYMENT TERMS | Net 30 - FRICELEVEL  Pretell Real Estate Rates = a
Sales Tax Settings FREFERRED .
bELIVERY METHOD | A -
Additional Info PREFERRED
PAYMENT METHOD -
CREDIT CARD INFORMATION ONLINE PAYMENTS
CREDIT CARD MO, Let this customer pay you by
o CreditCard  visa [ B =
EXF. DATE
B Bank Transfer (ACH) [Bank
MAME OM CARD
ADDRESS
ZIF | FOSTAL CODE

Can | save the Card Security Code?

Customer is inactive @ Cancel Help

NOTES
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Transactions from the Customers
& Jobs List

Right-clicking on any customer or job in the Customers & Jobs list will bring up a menu which
includes access points for launching various customer-related transactions and features, such as:

Create Invoices

Create Credit Memos / Refunds
Create Estimates

Create Statements

Enter Sales Receipts

Enter Statement Charges
Create Sales Orders

Receive Payments

Make Deposits
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Work with the Employee Center

@
o Step-by-Step: Add a New Employee

1. Just like the Customer Center, there are multiple ways to access the Employee Center in
QuickBooks:

® Click Employees from the left-hand or top icon bar (depending on your View settings)
® Choose Employee Center from the Employees drop-down in the menu bar
® From the Home page, click the blue Employees tab in the Employees section

2. Click New Employee at the top of the Employee Center.

Employee Center: Dan T. Miller

%2 NewEmployee.. [} Manage Employee Information * ) Print ¥ (3} EnterTime ~ Excel = Word =

Employees Transactiong E m |O ee Informatlon @ &
p y & NOTE
Active Employees = >
Ful Name Dan T. Miller Main Phone  555-2601 Mo note available
HAME ATTACH Address  Dan Miller

. 195 Spruce Ave, #202 REPORTS FOR THIS EMPLOYEE
Il I Bayshore, CA 94326
Elizabeth M. Mason QuickReport

Payroll Summary

Gregg O. Schneider Map | Directions
Paid Time Off Report
Employee Pay Adjustments
History
Payroll Transaction Detail
Waorkers' Comp Payment
Senice - Details
Transactions ToDo's Notes Sent Email
sHow  All Transactions ¥ et |This Calendar Year * | 01/01/2023 - 12/31/2023
TRANSACTION TYPE DATE » ACCOUNT AMOUNT
Paycheck 121152023 10100 - Checking 1,299.60 =
Paycheck 121152023 10100 - Checking 1,350.15 '
Paycheck 12/0112023 10100 - Checking 1,325.15
Paycheck 171712023 10100 - Checking 1,324.61

v

3. Complete all employee information.
4. Click OK.

5. Close the Employee Center by clicking on the x in the top right corner of the Center (not the top
right corner of QuickBooks, which will close the program!) or by hitting the Esc key.

= IMPORTANT: Payroll requires additional setup to be ready for processing inside of QuickBooks.
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Work with the Vendor Center

The Vendor Center’s Vendor list is where you record information about the companies or people
from whom you buy goods or services.

ADD VENDORS

To pay your bills with QuickBooks, you need to add your vendors (sometimes referred to as
suppliers). Nearly everyone you pay, other than employees, is a vendor. Your vendor list supplies the
names available on purchase forms like purchase orders, bills, checks, vendor credits, sales tax
payments, payroll tax payments and bills.

@
o Step-by-Step: Add a Vendor

1. Just like the Customer Center and Employee Center, there are multiple ways to access the
Vendor Center in QuickBooks.

® Click on Vendors from the left side or top icon bar (depending on your View settings)
® Choose Vendor Center from the Vendors drop-down in the menu bar
® From the Home page, click the Vendors tab in the Vendors section

2. Click the New Vendor button then choose New Vendor.

3. Inthe Vendor Name field, enter the name of the vendor as you'd like it to appear on your Vendor
list.

4. The Opening Balance field is treated the same as the Customer Center entries. You can enter a
balance owed to the vendor as of the start date of the file, but it is best practice to enter
individual open bills whenever possible.

5. Enter the remaining vendor information appropriately.

Lesson 3 — Work with Lists 21



QuickBooks Online 2019 Client Training Work with the Vendor Center

6. Click OK to add this vendor.

The new vendor appears on the Vendor list. (New vendors appear automatically in their correct
alphabetical order in the Vendor list.)

Vendor Center: Mew Vendor

E New Vendor.. ¥ E New Transactions ¥ E'] Print * Excel ¥ f.'_—é' Word ¥ ﬂ Bill Tracker
Vendors V d | f m t 0 ¢
en Or n Or a Ion ’ NOTE
Active Vendors = > )
Company Name  New Vendor No note available
je Full Name
REPORTS FOR THIS VEMDOR]
. Biled From  New Vendaor
NAME BALANCE TOT. ATTACH QuickReport
Hopkins Construction ... 700.00 = Open Balance
Insurance Co 0.00
John Ross 0.00 Map | Directions
Kershaw Computer Se... 0.00 Order 1098 Forms
Keswick Insulation 500.00
Order Checks
Larson Flooring 2,700.00
Lew Plumbing 3,130.00
Madrid, Winnie 0.00 Transactions Contacts ToDo's Motes Sent Email
Mason, Elizabeth 0.00
! sHow Al Trans... = FILTER BY | All - cate  This Fisc.. = 01/01/2023 - 12/31/2023
McClain Appliances 0.00
Mendoza Mechanical 0.00 ' e o Sl fecoont AueeT
Middlefield Drywall 1,200.00
Miller, Dan 0.00 There are no transactions of type "All Transactions”, filtered by 7AllI", in date range "This Fiscal Year™.
Nowionsor | 0w
Pacific Paint Supplies 0.00
Patton Hardware Suppl... 4,479.20 - Manage Transactions v Run Reports -

7. Close the Vendor Center by clicking on the x in the top right corner of the Center (not the top
right corner of QuickBooks, which will close the program!) or by hitting the Esc key.

= IMPORTANT: Notice there are additional tabs in the vendor setup window. Feel free to utilize these
features as they apply to your business. Pay special attention to the Tax Settings tab if you would like to
run 1099 reports from QuickBooks.

Lesson 3 — Work with Lists 22



QuickBooks Online 2019 Client Training Transactions from the Vendor List

Transactions from the Vendor List

Right-clicking on any vendor in the Vendor list will bring up a menu which includes access points for
launching various vendor-related transactions and features, such as:

Write Checks
Enter Bills
Pay Bills

Enter Credit Card Charges

Create Purchase Orders
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Add Custom Fields

QuickBooks lets you add even more information to names on lists by having custom fields in the
Customers & Jobs, Vendor, Employee and Item lists. Custom fields allow you to track additional
information specific to your business.

(@}

o Step-by-Step: Add Custom Fields

1. Open the Customer Center (or the Vendor Center or the Employee Center).
2. Click on a customer (or vendor or employee, depending on the center you've opened).

3. Click the Edit (pencil) button (alternately, right-click on the customer name and choose the Edit
option for this type of list name).

4. Click the Additional Info tab.

5. Inthe bottom right corner of this window, click Define Fields. This opens the Set Up Custom
Fields for Names window, which corresponds to your Customer, Vendor and Employee lists.

Edit Customer

cusToneR Nave Abercrombie, Kristy

CURRENT BALANCE 5 350.88
Address Info
CUSTOMER Use for:
Payment Settings Label Cust Vend Empl @
: [Conireci7 » Pl
Sales Tax Settings Discount Available >
B-Day v v Help

Additional Info Date of last raise

Spouse's Name v

Customeris inactive @ Cancel Help
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6. Use the Label column to name your custom field.

7. Place a checkmark in the column for each name list to which you would like the custom field to
apply. QuickBooks Pro and Premier allow up to seven custom fields for each of the Customer,
Vendor and Employee lists, but with no more than an aggregate limit of 15 custom fields on all
lists together.

8. Click OK.
9. If you see an informational message, click OK.
10. Click OK to close the Edit Customer (or Edit Vendor or Edit Employee) window.

11. Close the Customer (or Vendor or Employee) Center.

NOTES
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@
o Step-by-Step: Add Custom Fields for Items

1. From the Lists menu, choose Item List.

Look for in Allfields - @ Reset Search within results
NAME DESCRIPTION TYPE ACCOUNT TOTAL QUANTIT. PRICE ATTACH
» Deposit on Account Depasit on Customer Account Senice 20690 - Customer Deposits 0.00
» Returns Bad Debt Returns Senice Returns and Allowances 0.00
 Blueprintchanges | |seviee | truction Income:40110 - Design Income
» Blueprints Blugprints Senice 40100 - Censtruction Income:40110 - Design Income 0.00
» Concrete Slab Foundation slab - prep and pouring Service 40100 - Construction Income:40130 - Labor Income 0.00
> Floor Plans Floor plans Senvice 40100 - Construction Income:40110 - Design Income 0.00
> Framing Framing labor Service 40100 - Construction Income:40130 - Labor Income 55.00
> Ir Ir ion labar Senvice 40100 - Construction Income:40130 - Laber Income 35.00
» Labor Senice 40100 - Construction Income:40130 - Laber Income 0.00
» Removal Removal labor Senice 40100 - Construction Income:40130 - Labor Income 3500
> Repairs Repair work Senvice 40100 - Construction Income:40130 - Laber Income 35.00
» Subs Subcontracted senvices Service 40100 - Construction Income:40150 - Subcontracted Labor Income 0.00
+Carpet Install carpeting Senice 40100 - Construction Income:40150 - Subcontracted Labor Income 0.00
+Drywall Install drywall Senice 40100 - Construction Income:40150 - Subcontracted Labor Income 0.00
<+ Duct Work Heating & Air Conditioning Duct Work  Service 40100 - Construction Income:40150 - Subcontracted Labor Income 0.00
+Electrical Electrical work Senvice 40100 - Construction Income:40150 - Subcontracted Labor Income 0.00
+Insulating Install insulation Senice 40100 - Censtruction Income:40150 - Subcontracted Labor Income 0.00
ltem = | Activities v | Reports + | Excel v | Afttach Include inactive

2. Inthe Item List, select the item you wish to edit.

3. Right-click on the item and choose Edit Item or click the ltem menu button then choose Edit
Item.

4. Click Custom Fields.
5. Click Define Fields.
6. Enter the custom field name you would like to use in the Label column.

7. Place a checkmark in the Use column for the field to show in the item setup. QuickBooks Pro and
Premier allow up to five custom fields for items.

Colar v A
Material o Cancel
Style Help
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8. Click OK to close the window.

9. If you see an additional Information window about activating custom fields for this list, click OK to
close this window as well.

10. In the Custom Fields for this (or any) item window, you can now enter information for your new
custom field.

Custom Fields for Lk Doorknobs

MATERIAL Chrome Cancel
STYLE Found Help
Define Fields

11. Click OK to close the Custom Fields window for that item, and then click OK to close the Edit
[tem window.

12. Close the Item List.

NOTES
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Manage Lists

Manage Lists

Sometimes you may want to re-order the way your accounts appear in the different sections of your
financial reports. You can re-order each section of your Chart of Accounts (within its account type) by
following the instructions below.

@

o Step-by-Step: Sort a List Manually

1. From the Lists menu, choose Chart of Accounts. Scroll to the account you would like to move.

2. Hover the mouse pointer over the diamond to the left of the account name.

3. Click and hold the left mouse button, and then drag the pointer upward until you see a dotted
line directly above the account name (or downward until you see a dotted line directly below the
account name). The mouse button can also be dragged to the right to make it a subaccount of
the account above it (assuming it is the same account type), or it can be dragged to the left to
move it out of being a subaccount.

+ 30100 - Capital Stock

+ 30000 - Opening Bal Equity

+ 32000 - Retained Earnings

+ 31400 - Shareholder Distributions

+ 4001 - Consulting Income

+ 40540 - Returned Check Charges

+ Returns and Allowances

+ 40100 - Construction Income
+40110 - Design Income
+40120 - Equipment Rental Inco
+40130 - Labor Income

—
+50199 - Less Discounts given

+40140 - Materials Income

+40510 - Mileage Income

+ 50100 - Cost of Goods Sold
+ 54000 - Job Expenses

me

- 40150 - Subcontracted Labor Income

+ 40500 - Reimbursement Income

+40520 - Permit Reimbursement Income

+40530 - Reimbursed Freight & Delivery

$

Chart of Accounts

TYPE DESCRIPTION BALANCE TOTAL
Equity Capital Stock 500.00
Equity Offset account for use during the setup of the company’s QuickBooks da... 4027375
Equity Retained Earnings

Equity Distributions paid to shareholders 0.00
Income

Income

Income

Income Construction Income

Income

Income

Income

Income

Income

Income

Income Account for reimbursable mile

Income

Income

Cost of Goods Sold QuickBooks Automatically Increases the balance in this account when y...
Cost of Goods Sold

ATTACH

Account ¥ | Activities v

Reports

*

Attach Include inactive
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4. Release the left mouse button to drop the account into the new position.

» 40100 - Construction Income Income Construction Income
+40110 - Design Income Income
+40120 - Equipment Rental Income Income
+40130 - Labor Income Income
+40199 - Less Discounts given Income
+40140 - Materials Income Income

5. Tore-sort the list (within each account type), click the Account menu button in the bottom left
corner of the Chart of Accounts screen and select Re-sort List.

6. Click OK.
7. Close the Chart of Accounts.
You can sort lists in QuickBooks by clicking on column headers in the lists like the Name and Balance

Total. The example below uses the Customer Center, but this also applies in the Vendor Center, ltem
list and Chart of Accounts.
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(@

o Step-by-Step: Sort a List in Descending Order

Manage Lists

1. Open the Customer Center (using any of the access methods described above) and Customers &

Jobs list.

2. Click the expand arrow to the right of the View drop-down list to expand the width of the
Customers & Jobs list.

(b New Customer & Job ¥

5 Print ¥

E New Transactions ¥

Excel ¥

Word ¥

| Collections Center

Q Income Tracker

Customers & Jobs

Active Customers

o ¢ full list only iFuII Name

e

IE a

+Family Room

- Abercrombie, Kri

Company Name

Residential
91-431
Met 30

Customer Type
Account No.
Terms

Bill To

Mrs. Kristy Abercrombie

Customer Information

Main Phone  415-555-6579

Kristy Abercrombie

# NOTE

9/15/2003: Send Kristy
estimate for den remodel

Main Email kristy@samplename.cm

9/20/2003: Called Kristyto ...
REPORTS FOR THIS CUSTOMER

QuickReport

Lesson 3 — Work with Lists

e Kitchen 5647 Cypress Hill Rd Open Balance
+Patio 0.00 Bayshore CA 94326 Show Exfimaies
+Remaodel Bathroom 6,967.13 Customer Snapshot
< Allard, Robert 300.00
<Remodel 0.00 Transactions Contacts To Do's Motes Sent Email
+ Anthony's Pizza Parlor 0.00 sHow  AllTrans.. = FiTER By All - osTE  This Fiscal Year = 01/01/2023 - 12/31/2023
+ Babcock's Music Shop 0.00 TYPE MUM DATE - ACCOUNT AMOUNT
+Remodel 0.00 Payment 1215/2023 10100 - Checking 763328 &
+ Baker, Chris 0.00 General Journal FAM2011 12115/2023 11000 - Accounts R... 7,633.28
»Family Room 0.00 Credit Memo 71 1201512023 11000 - Accounts R... -1,616.25
= Garage Repair 0.00 Estimate 813 121122023 90200 - Estimates 7676.13
+ Balak, Mike 0.00 Invoice 1091 12110/2023 11000 - Accounts R 4,522.00
»Utility Shed 0.00 Check 476 12/01/2023 10100 - Checking 0.00
< Barley, Renee 0.00 Credit Memo 4002 1210172023 11000 - Accounts R... 715
+Repairs 0.00
+ Bauman, Mark 3,925.00 o Manage Transactions ~ Run Reports v
30
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The full list view of the Customers & Jobs list displays.

Customer Center: Abercrombie Y

Excel v Word * Collections Center %8 Income Tracker
Active Customers - <
el
NAME BALANCE TOTAL NOTES ATTACH
- Abercrombie, Kristy
+Family Room -1,616.25
+Kitchen 0.00
«Patio 0.00
+Remodel Bathroom 6,967.13
+ Allard, Robert 300.00
+Remodel 0.00
= Anthony's Pizza Parlor 0.00
+ Babcock's Music Shop 0.00
«Remodel 0.00
+ Baker, Chris 0.00
+Family Room 0.00
+ Garage Repair 0.00
+ Balak, Mike 0.00
«Utility Shed 0.00
+ Barley, Renee 0.00
+Repairs 0.00
+ Bauman, Mark 3,825.00

3. Click the Balance Total column heading. This sorts the list in ascending order by balance total.
4. Click the column heading again. This sorts the list in descending order by balance total.

5. To return to the original order, click the large diamond that will now appear to the left of the
Name column heading. (Alternately, right-click anywhere in the list and choose Re-sort List, then
click OK.)
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6. Click the collapse arrow to the right of the window to collapse the Customers & Jobs list.

é] MNew Customer & Job + % hew Transactions * E Print Excel » Collections Center Q Income Tracker
Customers & Jobs
Active Customers - ‘@
ye) Show list Mt
NAME BALANCE TOT.. | NOTES A
+Family Room -1,616.25
«Kitchen 0.00
+Patio 0.00
+Remodel Bathroom 6,967.13
= Bristol, Sonya 7,850.00
+Repairs 3,925.00
«Utility Shed 3,925.00
=+ Melton, Johnny 8,618.64 =]
+Basement Remodel 0.00
+Dental office 861864
+ Cook, Brian 9,397.33 ]
<Kitchen 397933
+2nd story addition 5418.00
+ Campbell, Heather 13,900.00
+Remodel 13,900.00
+ Mackey's Mursery and Garden Supply 13,900.00 '
+Greenhouse Addition 13,900.00 i

7. Close the Customer Center.

NOTES
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In most lists, you can combine two names into one. This is called merging. For example, you may
find that you've been using two customer names (because of different spellings) when you really
need only one on your Customers & Jobs list. You can merge list names in the Chart of Accounts,
ltem, Customers & Jobs, Vendor, Employee and Other Names lists. This example uses the Vendor
list, but the concept is the same regardless of list type. (Accounts on the Chart of Accounts that you
wish to merge must have the same account type and should not have subaccounts.)

@
9. Step-by-Step: Merge Items on a List

1. Open the Vendor Center.

2. Double-click the entry you wish to merge (this entry will be merged into the other entry and any
informational fields associated with this list entry will be lost, so make sure you have all the
informational fields you need in the surviving entry).

= Edit Vendor - 3
VEMDCR MAME I-Iq:ltins Construction Rentals ]
CURRENT BALANCE T700.00 How do | adjust the current balance?

Address Info

cowrary nene  Hopkins Construction Rentals
Payment Settings FULL mame | Mr/Ms./.| | Freddy M1 Hopkins, Jr.
_ JOB TITLE

Tax Settings

Main Phone =«  415-555-2366 Main Email = fhopkins@samplename.com
Account Settings :

Work Phone = CC Email -
Additional Info Mabile - Website -

Fax *  415-555-2367 Other 1 -

ADDRES S DETAILS
BILLED FROM SHIFFED FROM
Hopkins Construction Rentals @ &

33 Old Bayshore Rd
Bayshore CA 94326 Copy >=

Vendor is inactive E Cancel Help

3. Inthe Vendor Name field, change the name to match the name of another vendor record with
which you wish to merge. This should be an exact match in terms of spelling, spacing and
punctuation.

4. Click OK.
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5. You will get a warning dialogue telling you there is another record with this name and asking if
you would like to merge. (Remember, you can never un-merge so be very sure this is what you
want to do. Also, the Audit Trail report will not report on renamed or merged names, so be sure
that this is what you want to do, and for good measure, make sure you have a backup of the file
before you do the merge.) Click Yes.

6. Close the Vendor Center.

= IMPORTANT: You cannot merge two names from different lists such as a Vendor and Customer record or
Other Names list record. All transactions containing the original list name will now appear as if they
were entered using the renamed, merged list name.

RENAME A LIST ITEM

You can rename any list name. When you make the change, QuickBooks automatically modifies all
existing transactions containing the list name. (This is very similar to the concept of merging, but
without renaming to be exactly the same as another name on the same list.) This example
demonstrates renaming in the Chart of Accounts.

@
o Step-by-Step: Rename a List Item in the Chart of Accounts

1. From the Lists menu, choose Chart of Accounts to display the Chart of Accounts for Rock Castle
Construction.

2. Inthe Chart of Accounts, select the account you would like to rename.

3. Right-click on the account and choose Edit Account or click the Account menu button and
choose Edit Account.

4. Make your changes in the Account Name field.
5. Click Save & Close.

6. Close the Chart of Accounts.

NOTES
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You can delete list items if you have not used them in any transactions, preferences or customized

report filters. If you try to delete a list item that has been used, QuickBooks displays a warning that
the item can't be deleted. If you don't want to use a list item but you can't delete it, you can make it
inactive. Here is an example from the Customer Center.

@
o Step-by-Step: Make a List Item Inactive

1. Navigate to the Customer Center.
2. Select the customer or job from the list that you wish to make inactive.
3. Right-click the name and choose Make Customer:Job Inactive.

4. To see inactive list items, choose All Customers from the View drop-down list.

Customers & Jobs Transactions

All Customers v >

jo)
B o#nauE - BALANCE TOT... ! ATTACH CRE
+Patio 0.00 —
+Remodel Bathroom 6,967.13 l
+Allard, Robert 300.00
+Remaodel 0.00
+Anthony's Pizza Parlor 0.00
+Babcock’s Music Shop 0.00
+Remodel 0.00
- emeoms | ow ||

b4 +Family Room 0.00
b4 +Garage Repair 0.00
+Balak, Mike 0.00
+Utility Shed 0.00
+Barley, Renee 0.00
+Repairs 0.00
+Bauman, Mark 3,925.00
+Home Remaodel 3,925.00
+Bolinski, Rafal 26.80

+2nd story addition 26.80 v

5. Close the Customer Center.

NOTES
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Print a List

You can print a QuickBooks list for reference, or you may print a list to a file to use in your word
processor or spreadsheet program. QuickBooks prints the Customers & Jobs list as it appears on the
screen. For example, if the Customers & Jobs list is expanded and sorted by balance total,
QuickBooks prints the expanded list sorted by balance total. If the list is collapsed, QuickBooks
prints just the customer name, the balance total and active status.

@
o Step-by-Step: Print the Customers & Jobs List

1. Inthe Customer Center, click the Print menu button then choose Customer & Job List.
2. Click OK to bypass the List Reports message.

3. Confirm your choice of printer and click Print.

A, New Customer & Job ¥ J=| New Transactions ¥ (&) Print ¥ Excel v Word * Collections Center %8 Income Tracker
] Customer & Job List X ] . 0 e =
Customers & Jobs Transactions Customer & Job nformation 0 me r I nfo rm atlo n * NoTe
Customer & Job Transaction List
All Customers hd . v
Company Name Wain Phone 415-555-6579 9/15/2003: Send Kristy
L Full hame  Mrs. Kristy Abercrombie Wain Email  kristy@samplename.com estimate for den remadel
Customer Type Residential 9/20/2003: Called Kristy to
# e inamE ~ BALANCE TOT.. | ATTACH E i 91431
- Abercrombie, Kiisly 535088 A Accounttie REPORTS FOR THIS CUSTOMER
' Terms  Met 30
+Family Room -1616.25 N CudickDeorcd

@
9.  Step-by-Step: Print Information on One Customer

1. Inthe Customers & Jobs list, select the customer whose details you want to print.
2. Click the Print menu button then choose Customer & Job Information.

3. Confirm your choice of printer and click Print.
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If you want to print information for selected customers only, you can generate and filter the
Customer Contact List report for those customers. You can also modify the report to include any
extra columns you want.

@
o Step-by-Step: Print Information for Selected Customers

1. From the Reports menu, choose List then choose Customer Contact List from the submenu.
2. Click Customize Report.

3. Click the Filters tab.

4. Select Customer in the Filter list.

5. Inthe Customer field, choose Multiple customers/jobs.

6. Place a checkmark next to those customers whose contact information you want to print.

7. Click OKto close the Select Customer:Job window.

8. Click OK to close the Modify Report window and display the customized report on the screen.
9. Print the report.

10. Close the Report window.

11. Close the Customer Center.

NOTES
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Add or Edit Multiple ltems at One Time

Add or Edit Multiple Items at One Time

If you have existing list information in Microsoft Excel® that you want to add to QuickBooks, or if you

want to make changes to multiple items, you can do so for items in the following lists: Customers,
Vendors, Service Items and Non-inventory Parts. (Multiple items may also be added to or edited in
the list of Inventory Parts, if the inventory preference is turned on.)

(@}

o  Step-by-Step: Edit or Add Multiple List Names at Once

1. Go to the Lists menu and choose Add/Edit Multiple List Entries.

2. Choose the list you would like to edit from the List drop-down.

3. Use the Customize Columns button in the top right corner to customize the information you
would like to see. (This means not only adding and taking away columns, but also changing their

order.)

Add/Edit Multiple List Entries

@ Select a list.

List

Customers

Currently Editing:

View

- Active Customers

9 Customize columns to display.

@ Paste from Excel or type to add to or modify your list.

l Customize Columns

Find

@x

LAST NAME

Search within results

Abercrombie, Kristy Mrs. Kristy Abercrombie 415- &
Family Room Mrs Kristy Abercrombie 415-
Kitchen Mrs. Kristy Abercrombie 415-
Patio Mrs. Kristy Abercrombie 415-
Remodel Bathroom Kristy Abercrombie Mrs. Kristy Abercrombie 415-
Allard, Robert Mrs. Amanda Robers 650-
Remaodel Mrs. Amanda Robers 650-
Anthony's Pizza Parlor Anthony's Pizza Parlor Mr. Anthony La Forte h55-
Babcock's Music Shop Babcock's Music Shop Ms. Kristie Babcock B650-
Remodel Babcock's Music Shop Ms. Bettie Wilson B650-
Balak, Mike Mr. Mike Balak 415-
Utility Shed Mr. Mike Balak 415-
Barley, Renee Ms. Renee Barley 415-
Repairs Ms. Renee Barley 415-

v
< »

| Save Changes | Close Help
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4. Use the Find field if needed.
5. Utilize copying tools by right-clicking in a cell on the grid.

6. To add any new list names, scroll to the bottom of the list and start entering or pasting
information into the first empty row. Alternately, you can change the View drop-down choice to
display unsaved list names (in the example above, that would be unsaved customers), and you
will be able to enter or paste information into an empty grid using the column headers as your
guide.

7. When your changes are complete, click Save Changes.

8. Click Close.

NOTES
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Work with the Lead Center

Work with the Lead Center

The Lead Center tracks data about your sales prospects (who are not yet customers) in one place
inside QuickBooks. The Lead Center has three panes:

® Use the Leads pane on the left to view and sort your leads

® Use the Lead Information pane on the right to review or edit information about a selected lead

@® Use the Tabs at the bottom of the window to access lists and notes for individual leads

To access the Lead Center, click Company on the menu bar and select Lead Center. QuickBooks
displays the Lead Center as shown:

Lead Center

Sk Newlead 43 Import Multiple Leads Excel ~
Actve Loads . Lead Information REPORTS FOR THIS LEAD
@ Lead Mame MB Raimondi Primary Contact Quick Report
Lead Status  Warm Title
NAME & STATUS Company Name Work Phone
Brad Smith Hot Main Phone Work Fax
Sasan Goodarzi Hot Website Mobile
l ME Raimondi m Main Email Main Email
Additional Email Additional Email
EFK Enterprizes Cold
To Do's Contacts Locations Notes
TYFE  All - STATUS Al - DATE Al -
DONE PRIORITY DUE DATE TYPE WITH DETAILS
To Do - Reports -
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@
o Step-by-Step: Add a New Lead

1. Choose Company > Lead Center.

2. Click the New Lead icon.

3. Enter the lead name in the Lead field.

4. Setthe lead status. Click the Status drop-down arrow and select Hot/Warm/Cold.

5. Use the Company and Contacts tabs to enter information about the prospect.

= Edit Lead b3
MAME  EFK Enterprises (Required)
STATUS Warm -
Company Contacts
~oMEANY MaMe EFK Enterprises Website ~ | www.e-compubooks.com
AN PHONE 416-410-0750 Main Email « esther@e-compubooks.com

LOCATION {Required)

Add Another Location

6. Enter additional information as desired.

7. Click OK.
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THINGS TO NOTE ABOUT THE LEAD CENTER

® Each lead must have a unique name. If you've already used the name, change it slightly by
adding a character or number.

® The Contacts tab provides the ability to enter details about contacts at the company. You can
have multiple contacts as needed.

@ You can enter one or more locations in the Locations field. If you have multiple locations, you can
click the Main Address drop-down arrow and select from the locations you've entered.

® You can import multiple leads to enter multiple prospects into the Lead Center at the same time
by using the Import Multiple Leads button at the top of the Lead Center then copying and
pasting from an Excel spreadsheet.

@
9. Step-by-Step: Convert a Lead to a Customer

You can convert a lead into a customer when needed. This will move the prospect from the Lead
Center to the Customers & Jobs List. Converting a lead to a customer cannot be undone.

Lead Center

it Newlead &3 Import Multiple Leads Excel =

e — . Lead Information l @]y REPORTS FOR THIS LEAD
@ Lead Name  MB Raimondi Primary Contact Convert this Lead to a Custor
Lead Stalus  Warm Title
NAME 4 StaTuS Company Name Work Phone
Brad Smith Hot Main Phone Work Fax
Sasan Goodarzi Hot Website Mobile
MB Raimondi Warm Main Email Main Email
Additional Email Additional Email
EFK Enterprises Warm

To Do's Contacts Locations Motes

To Do ~  Reports -

=  IMPORTANT: You cannot enter a transaction for a lead; it must first be converted to a customer.

NOTES
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Work with Lists — Review Questions

1. How many custom fields can you set up for items?

a. 4
b. 5
c. 7
d. 20

2. Which of the following forms and windows could potentially be populated with information from
the Vendor list?

a. Purchase Orders
b. Bills

c. Write Checks

d. All of the above

3. Which of the following activities cannot be accessed from the Customers & Jobs list in the
Customer Center?

a. Create statements

b. Assess finance charges
c. Enter credit card charges
d. Receive payments

4. On which tab of the Edit Customer window would you enter a customer’s payment terms (for
example, net 30 days)?

a. Address Info
b. Additional Info
c. Payment Settings

d. Job Info
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Work with Lists — Review Questions

5. A customer has three warehouses and you are installing an overhead door at each location. The
best way to track this in QuickBooks would be to:

a.

b.

C.

d.

Set up each location as a separate customer
Set up a separate job for each location under the customer
Enter all work as one order under the customer

Use a custom field to track each location

6. Products you sell would appear on which of the following lists?

a.

b.

C.

d.

Vendor list
Employee list
Chart of Accounts

[tem list

7. A subcontractor would appear on which of the following lists?

a.

b.

C.

d.

Vendor list
Employee list
Customers & Jobs list

[tem list

8. Name three of the lists on which you can merge names.

a.
b.
C.
9. True or false: You can delete list items that are used in transactions.
a.

b.

True

False
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Review Activities

2.

—_—

. Add the following customer using the data below:

Customer Name: Alla Rozenvasser
Opening Balance: $234.00
Company Name: Rozenvasser Advertising

Contact: Alla Rozenvasser

Bill to: 300 Main Street, Suite #3, Middlefield, CA 94432

Phone: 415-555-6767

Fax: 415-555-9090

Alt. Contact: Shannon Stubo
Type: Commercial

Credit Limit: $2500

Terms: Net 15
Tax Item: San Domingo

Add a new vendor using the data below:

Vendor: Martin Drywall

Contact: Sean D. Martin

Address: P.O. Box 76, Middlefield, CA 94432
Phone: 555-5432

Fax: 555-6565

Account: 082-4343

Type: Subcontractors

Terms: Net 30

Credit Limit: 1,000.00

Review Activities
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3. Inthe Customers & Jobs list select Ecker Designs. Answer the following questions:

® Whatis the job status for Ecker Designs’ office repairs?
® What is the number of the most recent invoice and how much was it?
® What happened on December 157
4. Inthe Vendor Center locate sales tax payment transactions. Answer the following questions:
® Who is the vendor?
® How many payments have been made?
® What is the total amount of payments that have been made?
5. Inthe Employee Center find Gregg Schneider’s information. Answer the following questions:

® What is the name of his spouse?
® When was Gregg hired?
® Whatis Gregg's overtime pay rate?
6. Inthe Vendor Center find C.U. Electric. Answer the following questions:

® What is the open balance for this vendor?
® How many bills are outstanding and what are the amounts?
® What are the payment terms for this vendor?
7. Open the Item list and answer the following questions:
® How many brass hinges are on hand?
® What is the price of a patio door?

® What is the finance charge percentage on overdue balances?
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Answers to Review Questions

1. How many custom fields can you set up for items?

a. 4
b. V5
c. 7
d. 20

2. Which of the following forms and windows could potentially be populated with information from
the Vendor list?

a. Purchase Orders
b. Bills

c. Write Checks

d. v All of the above

3. Which of the following activities cannot be accessed from the Customers & Jobs list in the
Customer Center?

a. Create statements

b. Assess finance charges

c. v Enter credit card charges
d. Receive payments

4. On which tab of the Edit Customer window would you enter a customer’s payment terms (for
example, net 30 days)?

e. Address Info
f.  Additional Info
g. v Payment Settings

h. Job Info
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5. A customer has three warehouses and you are installing an overhead door at each location. The
best way to track this in QuickBooks would be to:

a. Setup each location as a separate customer
b. ¥ Setup a separate job for each location under the customer
c. Enter all work as one order under the customer
d. Use a custom field to track each location
6. Products you sell would appear on which of the following lists?
a. Vendor list
b. Employee list
c. Chart of Accounts
d. v Item list
7. A subcontractor would appear on which of the following lists?
a. v Vendor list
b. Employee list
c. Customers & Jobs list
d. Item list
8. Name three of the lists on which you can merge names. (Any 3 of these will do.)
a. v Chart of Accounts
b. v Item
c. ¥ Customer & Jobs
d. v Vendor
e. v Employee
f. v Other Names
9. True or false: You can delete list items that are used in transactions.
a. True

b. v False
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Lesson Objectives

Learn how to work with registers for QuickBooks bank accounts
Demonstrate how to open a register
Learn the features common to all registers

Learn when and how to make entries directly in the register

Demonstrate how to reconcile a QuickBooks bank account
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Write a QuickBooks Check

(@

o  Step-by-Step: Write a Check

Write a QuickBooks Check

1. Inthe Banking area of the Home page, click Write Checks (or press CTRL+w).

2. Inthe Pay to the Order of field, choose the name of the vendor you wish to pay.

Write C
Main Reports oA
L ) .
¢+ B B X Bowerewy, Gl g B O B B & B Q
Find Mew Save Delete ¢Mem0lize Print Pay Online Aftach Select Enter Clear Recalculate Batch Reorder
M M File PO Time: Splits Transactions Reminder Order
Checks
BANK ACCOUNT “10100 - Checking - ] enoing sacsnce  83,154.95
NO. | 269
CATE 0212812023 H
F&Y TO THE ORDER OF | Dianne’s Auto Shop - 3 |231.00
Two hundredthirt]r—one and O0/QQ=*****+** s eassseraeserransarasrrrasrrrrrss DOLLARS
ADDRESS
Dianne's Auto Shop o CLEARED
Dianne Bradley
29834 Mustang Ave.
Millbrae, CA94030
WEMZ | Monthly Vechiicle Repairs and Maintenance
Expenses $231.00 ltems $0.00
ACCOUNT AMOUNT MEMO CUSTOMER:JOB BIL CLASS
50100 - Automobile:60130 - Repairs and Maintenance 231.00 Monthly Vechiicle Repairs and Maintenance Overhead [ |overhead |+
v
save & Close (LSRN Revert

If the Check for Bills window (indicating that there are unpaid bills outstanding for this vendor)
pops up, you may choose the option to Go to Pay Bills instead.

3. Complete the remaining information on the check.

4. Click Save & Close.

NOTES
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Use Bank Account Registers

@
o Step-by-Step: Open a Register (when no form is open)

1. From the Lists menu, choose Chart of Accounts.

Look for account name or number
MAME ¢ 0 TYFE DESCRIPTION BALANCE TOTAL ATTACH
+ 1001 - B of AChecking .m Checking account at Bank of America m-
+ 10300 - Savings ¢ Bank Savings 17.910.19
+ 10100 - Checking £ Bank Cash 8315495
+ 10400 - Petty Cash Bank Petty Cash 700.00
+ 11000 - Accounts Receivable Accounts Receivable  Accounts Receivable 12549163
+ 12800 - Employee Advances Other CurrentAsset Employee Advances 770.00
+ 12100 - Inventory Asset Other CurrentAsset Inventory Asset 3372528
+ 13100 - Pre-paid Insurance Other CurrentAsset Pre-paid Insurance 4,050.00
+ 13400 - Retainage Receivable Other CurrentAsset Retainage Receivable 3,703.02
+ 12000 - Undeposited Funds Other CurrentAsset Undeposited Funds 3242098
+ 17000 - Accumulated Depreciation Fixed Asset Accumulated Depreciation -110,344.60
+ 15200 - Buildings and Improvements FixedAsset Buildings and Improvements 325,000.00
+ 15300 - Construction Equipment FixedAsset Construction Equipment 15,300.00
+ 15000 - Furniture and Equipment FixedAsset Furniture and Equipment 34 326.00
+ 16900 - Land Fixed Asset Land 90,000.00
+ 15100 - Vehicles Fixed Asset ehicles 78,936.91
+ 18700 - Security Deposits OtherAsset Security Deposits 1,720.00
+ 20000 - Accounts Payable Accounts Payable Moneys you owe to vendors and suppliers 48,136.92
Account ¥  Activities ¥ || Reports ¥ | Attach Include inactive
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2. Inthe Chart of Accounts, double-click the balance sheet account whose register you wish to view
(this will work for all balance sheet accounts except for Retained Earnings).

10100 - Checking

& Goto.. | £ Print.. ‘ [52 Edit Transaction [8) QuickReport Download Transactions
DATE IBER PAYEE PA T o DEPOST BALANCE
12/15/2023 FAM2012 Abercrombie, Kristy:Remodel Bathroom 2500 8535495 1
GEMNJRN G60E00 - Bank Service Charges Bank sernvice charges for bounced checkd#
12/15/2023  FAM2013| Jacobsen, DougKitchen 2,000.00 83,354.95
GEMJRMN 11000 - Accounts Receivable [spli] bounced check
1211512023 FAM2013 Jacobsen, DougKitchen 25.00 §3,329.95
GENJRN 11000 - Accounts Receivable [splif] bounced check fee charged by bank
121152023 SEND 500.00 8382995
TRANSFF 10300 - Savings
12/15/2025 | 454 Sergeant Insurance 675.00 33,154.95
CHK  -split-
B |Number |Payee ~ |Payment Deposit l
Account * | Memo p
Splits EMDING BALANCE 83,1 54.95
1—Lme'
Sort by I Date, Type, Number/Ref = l | Record } Restore

3. Review features common to all registers:

The register displays every transaction that affects an account’s balance and lists them in
chronological order (unless another order is chosen in the Sort by drop-down box in the
lower left corner of the register window)

The columns in the register give specific information about the transaction

On every transaction line, QuickBooks displays the account’s running balance

The Ending Balance for a register is the account’s running balance for all dates after all
transactions have been entered, including checks, whether or not they have been printed

The register may be changed from a 2-line-per-transaction display, as in the example shown,
to a 1-line-per-transaction display by putting a checkmark next to 1-Line in the bottom left
corner of the register window. The 1-line display is easier on the eyes but provides less
detailed information.

A horizontal blue line separates all transactions entered for this register up to and including
today (today is recognized according to your calendar in Windows) from transactions that are
post-dated

4. Close the register window.

5. Close the Chart of Accounts.

NOTES

Lesson 4

— Work with Bank Accounts 8
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Enter a Handwritten Check

Sometimes you need to write a check by hand on the spot for items or services you did not plan to
purchase. QuickBooks lets you write the check then enter it later in the checking account register or
on the check form.

@
o Step-by-Step: Enter a Handwritten Check in the Checking Account Register

1. From the Banking drop-down menu choose Write Checks.
2. Ensure the proper account is selected in the Bank Account drop-down at the top of the check.

3. Click in the No. (check number) field in the blank transaction and enter the number from the
handwritten check. (If the No. field says To Print, uncheck the Print Later box on the toolbar at
the top of the check in the Main tab of the ribbon.)

4. Enter the information from the handwritten check and assign it to the corresponding expense
account.

5. Save & Close.

NOTES

Lesson 4 — Work with Bank Accounts 9
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Transfer Money Between Accounts

The Transfer Funds feature in QuickBooks allows you to move money from one balance sheet
account to another. These transactions may reflect funds transfers from one bank account to
another, movement of money from a bank to an asset account, or even payment against a credit
card or liability account. (This feature is especially useful in a multicurrency environment when
transferring funds between accounts of different currencies and the bank has assigned a specific
exchange rate to the transfer.)

@
o Step-by-Step: Transfer Money

1. From the Banking menu, choose Transfer Funds.

@ Previous ® Next E Save | n lournal | a Attach

Transfer Funds BES N S O S e\ Sl
12152023 ] -

TRANSFER FUNDS FROM | 10100 - Checking w | ACCOUNT BALANCE 83,154.85

TRANSFERFUNDSTO (40300 -Savings = ACCOUNT BALANCE 17,810.19

Qnline Funds Transfer TRANSFER AMOUNT [ 42,DEID[|-D

MEMO  Funds Transfer Ref #AB2783CA

Save & Close | Save & New | Clear

2. Inthe Transfer Funds From field, choose the account from which you are transferring the money.
3. Inthe Transfer Funds To field, choose the account to which the money is being transferred.
4. Enter the amount you wish to transfer in the Transfer Amount field.

5. If this were a multicurrency situation, you would also choose the currency of the Transfer Amount
and the exchange rate given to you by the bank. (The example here is not a multicurrency
situation and therefore you do not see those fields in this screen capture.)

Lesson 4 — Work with Bank Accounts 10
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6. Inthe Memo field, enter the alphanumeric confirmation code given to you by the financial
institution to reference this transfer transaction.

7. Click Save & Close.

NOTES

Lesson 4 — Work with Bank Accounts 11
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Reconcile Bank Accounts

Your bank sends you a statement for each of your accounts each month (or you can view it online
using your online banking credentials). The statement shows all the activity in your account since the
previous statement:

Opening balance

Ending balance

Amount of interest earned

Service charges

Checks and other withdrawals that have cleared the bank

Deposits made

Other transactions affecting the balance of the account

Lesson 4 — Work with Bank Accounts 12
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@
o Step-by-Step: Reconcile a Checking or Savings Account Statement

1. From the Banking drop-down, choose Reconcile.

2. Inthe Account drop-down, choose the appropriate bank account from the list.

Begin Reconciliation

Select an account to reconcile, and then enter the ending balance from your account statement.

Account (110100 - Checking |
Statement Date 11302023 @)
Beginning Balance 71,452,538 What if my beginning balance doesnt match my statement?
Ending Balance [ Tr'1,426.52]

Enter any service charge orinterest earned.

Service Charge Date Account Class
0.00 111302023 HE GOE00 - Bank Service Charges - -
Interest Earned Date Account Class
0.00 113002023 B - -

Locate Discrepancies Undo Last Reconciliation Cancel Help

3. Inthe Statement Date field, enter the closing date of the statement you wish to reconcile.
4. Inthe Ending Balance field, enter the ending balance on the statement you wish to reconcile.

5. Click Continue. Proceed to next exercise.

NOTES

Lesson 4 — Work with Bank Accounts 13
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Mark Cleared Transactions

(@

(o)

Step-by-Step: Mark Transactions as Cleared

Place a checkmark in the box next to Hide transactions after statement’s end date to show only
transactions dated up to and including the statement end date.

In the Checks and Payments section of the window on the left side, match the transactions with
the checks and payments on your statement. Place a checkmark next to each transaction in
QuickBooks that appears on your statement. This marks the transaction as cleared in your
QuickBooks register.

In the Deposits and Other Credits section of the window on the right side, place a checkmark
next to each transaction that matches your statement to mark the deposits as cleared in the
register.

You can open a transaction to view it and make changes, if necessary, by double-clicking on the
transaction in the reconciliation window.

When you are done with this process, the Difference in the bottom right corner should be zero.
When this difference is zero, and only when this difference is zero, click Reconcile Now.

For period: 11/30/2023
Checks and Payments
—
| DaTE - CHIK# PAYEE AMOUNT
Iy
S 1003112023 433 Sergeant Insurance 71256 1112812023 Keswick Insul . BILLPMT
Y 10312023 436 Bayshore Water 24.00 YN 11i2812023 467 Lew Plumbing [BILLPMT 0.00
< 1111412023 451 Larson Flooring 3,200.00 ¥ (1112812022 469 Sloan Roofing |BILLPMT 0.00
YN 11i2812023 470 Washuta & So...|BILLPMT 0.00
11/28/2023 464 Hopkins Constru... 300.00 < (1113012023 41077 Melton, Johnn... |PMT 4,135.50
11/28/2023 466 McClain Applianc... 600.00 © T
11/28/2023 468 Timberloft Lumber 6,790.00
11/30/2023 471 Bayshore Water 24.00
11/30i12023 472 Patton Hardware ... 656.23
11/30/2023 473 Wheeler's Tile Etc. 686.00
11/30/2023 474 Dianne's Auto Sh... 218.00 ¢
¥ Highlight Marked Mark All Unmark All Go To Matched Columns to Display...
Beginning Balance 71,452.58 Modify Senvice Charge 0.00
Items you have marked cleared — Interest Earned 0.00
5 Deposits and Other Credits 4,135.50 Ending Balance 7142652
4 Checks and Payments 4,161.56 ce 7142652
Difference 0.00]
| Reconcile Now | Leave
Lesson 4 — Work with Bank Accounts 14
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Mark Cleared Transactions

In the Select Reconciliation Report window, you can choose to display or print your reconciliation
reports. It is important to print both the Summary and Detail reports, and a best practice to save
them as PDFs for future reference.

NOTES

Select Reconciliation Report

Congratulations! Your account is balanced. All marked items
have been cleared in the account register.

Selectthe type of reconciliation report you'd like to see.

1 Summary

Toview this report at a later time, select the Report menu,
display Banking and then Previous Reconciliation.

| Display | Print... Close

Lesson 4 — Work with Bank Accounts
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View Cleared Checks in the Register

@
o Step-by-Step: View Cleared Checks in the Register

1. From the Banking menu, choose Use Register.

2. Choose the account register you wish to view from the list. (An alternate way to view the register is to
open the Chart of Accounts and double-click on the balance sheet account whose register you wish
to see.)

3. Scroll through the register to view the cleared items:

® Checkmark = cleared on a completed reconciliation
® Asterisk = cleared on a pending reconciliation
® No mark = not cleared

= WARNING: You are able to change the reconciliation status of a transaction from within the register. Do
not do it! Manually changing reconciliation status in the register has a negative impact on future
reconciliations.

10100 - Checking

& Goto.. | &) Print.. | [ Edit Transaction [5) QuickReport Download Transactions
DATE NUMBER PAYEE PAYMENT v DEPOST BALANCE
11/25/2023 463 Cal Gas & Electric a7 53 106,441.02
CHK 65100 - Utilities:65110 - Gas and Electric Acct #560-82645-99C
1112512023 42300.00 v 54,141.02
TRANSFI 10300 - Savings Funds Transfer
11/28/2023 464 Hopkins Construction Rentals 300.00 63,841.02
BILLPMT 20000 - Accounts Payable
11/28/2023 465 Keswick Insulation 000 v 63,841.02
BILLPMT 20000 - Accounts Payable WOID:
11/28/2023 466 McClain Appliances 600.00 63,241.02
BILLPMT 20000 - Accounts Payable 85-93117
11/28/2023 | 467 Lew Plumbing 0.00 v 63,241.02
BILLPMT 20000 - Accounts Payable VOID: 5-487
Splits ENDING BALANCE 83 3 1 54.95
1-Line
Sortby  Date, Type, Number/Ref IEC | Restore

4. If you open a check that has cleared via a reconciliation, you will see a green checkmark along
with the word Cleared stamped on the face of the check.

5. Close the account register.
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Locate Specific Transactions

You can use the QuickBooks Find command to search for specific checks you've written (and other

Locate Specific Transactions

transactions as well). For example, suppose you want to find all checks between $500 and $750 that

you've written during the current month.

@]
)

1. From the Edit menu, choose Find (or press CTRL+f) then select the Advanced tab.

Step-by-Step: Use the Find Feature

2. Choose the filter(s) you would like to use. You can choose multiple filters by setting one,

choosing another from the list, setting that one and so on. In the example below, the Amount

filter is set to include transactions with amounts between $500 and $750, and dates for this
month (which, being a sample company, QuickBooks sets from December 1, 2023, through

December 31, 2023, but we could have chosen the custom “from” and “to” dates). No filter was
used for Transaction Types, so all Transaction Types have been included. However, you could

have used a Transaction Type filter for one particular transaction type (e.g., Bill) or Multiple
Transaction Types (e.g., Check, Bill, Bill Payment, Sales Tax Payment, and Paycheck).

=

Simple Advanced
CHOOSE FILTER

FILTER Date

JZE This Month

Detail Level

Discount Available

Due Date

Entered/Modified

v

DATE TYFE
121512023 BILLPMT
12/15/2023 TRANSFR
12/15/2023 BILL
1211512023 BILLPMT
1211512023 BILLPMT
12115/2023 BUILD
12/15/2023 BILL
12/15/2023 PURCHORD
121212023 BILL

From  12/01/2023

To 12312023

501

502
51
9002
8059
6238

Find

Current Choices

FILTER SET TO
7 Amount 500.00 to 750.00
] Date This Maonth
™ Detail Level Summary only

Posting Status
Zero Reorder Qty

Wheeler's Tile Etc.

Keswick Insulation
Daigle Lighting
East Bayshore Tool & Supply

Thomas Kitchen & Bath
Patton Hardware Supplies
Washuta & Son Painting

Either
Hide

Help

ACCOUNT
10100 -
10300 -
20000 -
10100 -
10100 -
12100 -
20000 -
90100 -
20000 -

Checking

Savings

Accounts Payable
Checking
Checking
Inventory Asset
Accounts Payable
Purchase Orders

Accounts Payable

H-18756

Funds Transfer

Close

Mumber of
matches: 21

Lesson 4 — Work with Bank Accounts
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3. Click the blue Find button to search. To clear your filters and start fresh with a new Find, click the
Reset button.

4. From the results grid, double-click on the transaction you would like to view to open it.

You can also create a Find Report or export the results of the grid to Microsoft Excel® by
selecting the Report or Export buttons.

5. Close the Find window.

NOTES
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Use Bank Feeds

Bank feeds allow users to download bank and credit card transactions directly into their QuickBooks
file.

]

9. Step-by-Step: Use the Bank Feed Feature

1. From the menu bar, select Banking > Bank Feeds - Bank Feeds Center. If this is your first

time using the Bank Feeds Center, click on the Add Account button in the top left corner and
follow the prompts to set up your account information.

Bank Feeds

P AddAccount | E5) Rules

BANK ACCOUNTS Account Information LAST UPDATE Overayearago & *
ANYTIME Financial
Account ending in =*1244

_ ANYTIME Financial In QuickBooks

In QuickBooks ACCOUNT ENDING IN **1235 ENDING BALAMNCE Checkiny

Savings $17,910.19 = N = = 8
$5,035.66 $83,154.95

T transactions are waiting to be added to QuickBooks. Transaction List
CREDIT CARD

QuickBooks Credit Card $45.00
Account ending in =*4321 Over a year age Read messages from your bank
|n QuickBooks i oAesezges e cenen 1) Send items to your bank
QuickBooks Credit Card 94.20 i
uickBooks Credit Car bt E Payment Inquiry Responses (0) Online Checks (0 of 0) Bill Payments (0 of 0)
O Aens o) Transfers (0 of 0) Messages (0 of 0)
Payment Inquiries (0 of 0) Payment Cancellations (0 of 0)

Manage your account

Contact your bank

Send Items Create New -
Disable bank feeds

2. From the Bank Feeds window, click the Transaction List button to view and process transactions.
If this button says Download Transactions, this means all previously downloaded transactions

have already been posted to QuickBooks. Press the Download Transactions button to
download available transactions from the bank.

Use the grid to enter additional information about the downloaded transaction (payee, account
the expense or deposit should be mapped to, transaction number, etc.). This is how the
transaction will appear in your QuickBooks register.
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Use Bank Feeds

4. To process transactions individually, use the drop-down menu in the Select column.

48 Finish Later &5 Rules

7 Transactions
Checking

NEW TO QUICKBOOKS

Tell QuickBocks how to handle these bank transactions

staTus Al - TvPE  |Alltypes -

E ! DATE NO. DOWNLOADED AS

CHK  1113/03 ATM Withdrawal
CHK  11/13/03 239

CHK  11/14/03 242

CHK  1114/03 243

DEP 11/15/03 Deposit

CHK  11/30/03
PMT  11/05/03

Funds Transfer

FROM | 11/05/03

Bank Severvice Charge

ACCOUNT

| ™ [112003
PAYEE
ATM Withdrawal
Deposit

[] show Bank Memo

CLASS

Teschner, Anton:Sun Rooi 11000 - Accounts Receiva

PAYMENT
200.00
1,297.75
3,200.00
850.00

9.00

INYD.

Quick Add

Add More Details

Select Bills to Mark as Paid
2 Match to Existing Transaction

lgnore

5,000 00

Lesson 4 — Work with Bank Accounts
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5. To process multiple transactions at once, place a checkmark in the far left column and use the
Batch Actions drop-down in the bottom left corner of the window:.

Transactions List

4a Finish Later &5 Rules

CIRNSACHONS o e INYO...

Checking m

Tell QuickBooks how to handle these bank transactions

status Al - TvPE  Alltypes FROM |HIDS_«'03 Bl | o | 11/30/03 ‘ [] Show Bank Memo
STATUS TYPE | DATE NO. DOWNLOADED AS PAYEE ACCOUNT CLASS PAYMENT DEPOSIT AGTION
Rev CHK  11/13/03 ATM Withdrawal ATM Withdrawal 200.00 Select -
Rev CHK 1113103 239 1,297.75
Rev CHK 11/14i03 242 3,200.00
Rev CHK 1114i03 243 850.00
Rev DEP 1115/03 Deposit Deposit 2,080.11
Rev CHK 11/30/03 Bank Severvice Charge 9.00
11/05/03 Funds Transfer Teschner, Anton:Sun Rool 11000 - Accounts Receiva 5,000.00

Add/Approve
lgnore

Batch Actions ||

ik

6. Close the window when you are finished. After the transactions have been accepted, they will
appear in the appropriate register.

NOTES
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Work with Bank Accounts — Review Questions

1. What does the ending balance in a QuickBooks bank account register represent?
a. Only transactions that have been printed
b. All transactions entered in the register, including checks that haven't yet been printed

2. True or false: All income and expense accounts have a register associated with them in
QuickBooks.

a. True
b. False

3. is the process of making sure your checking account record matches
the bank’s records.

4. How can you determine whether or not a check has been cleared in QuickBooks?
a. A checkmark displays in the bank account register
b. The word Cleared is stamped on the check in QuickBooks
c. Both of the above
d. Neither of the above

5. True or false: If you are tracking bills with Accounts Payable and have already entered a bill, you
should pay the bill by writing a check from the Write Checks window.

a. True
b. False
6. Which of the following might affect a bank account reconciliation?
a. Interest
b. Depreciation
c. Service charges
d. Bothaandc

e. All of the above
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Review Activities

@ Use the checking account register to enter a handwritten check for $76.95. Use the next available
check number and make the check payable to Express Delivery Service for delivery of a new sign.
Assign the check to the Freight & Delivery expense account.

® Write a QuickBooks check to Bayshore Water for $143.87 to pay this month’s water bill. Assign
the check to the Utilities:Water expense account.

® Find all the checks in the sample file that were written for amounts between $3000 and $4,000.
How many checks are there?
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Answers to Review Questions

1. What does the ending balance in a QuickBooks bank account register represent?
a. Only transactions that have been printed
b. v All transactions entered in the register, including checks that haven't yet been printed

2. True or false: All income and expense accounts have a register associated with them in
QuickBooks.

a. True

b. v False. Only balance sheet accounts (excluding Retained Earnings) have registers associated
with them.

3. Reconciling is the process of making sure your checking account record matches the bank’s
records.

4. How can you determine whether or not a check has been cleared in QuickBooks?
a. A checkmark displays in the bank account register
b. The word Cleared is stamped on the check in QuickBooks
c. v Both of the above
d. Neither of the above

5. True or false: If you are tracking bills with Accounts Payable and have already entered a bill, you
should pay the bill by writing a check from the Write Checks window.

a. True

b. ¥ False. You should use the Pay Bills window to write the check.
6. Which of the following might affect a bank account reconciliation?

a. Interest

b. Depreciation

c. Service charges

d. v Bothaandc

e. All of the above
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Lesson Objectives

Learn how to record customer payments in QuickBooks
Learn how to handle customer discounts, partial payments, overpayments or down payments

Learn how to handle customer bounced checks

See how to record a deposit in QuickBooks and how QuickBooks treats the deposit behind the
scenes

Learn how to enter cash back from a deposit in QuickBooks
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Record Payment in Full for a Single Job

If you receive payment at the time of a sale and fill out a sales receipt, the customer payment is part
of that sales receipt transaction. When you invoice a customer and receive payment later, you must
enter the payment in the QuickBooks Receive Payments window as a transaction that is separate
from the sale.

@
o Step-by-Step: Record a Payment in Full

1. From the Customers menu, choose Receive Payments. (If the QuickBooks Payment Interview
window displays, close it.)

2. Inthe Received From field, select the Customer:Job from whom you are receiving the payment.
Press Tab.

3. Inthe Amount field, type the amount of the payment. Press Tab.
4. Inthe Date field, enter the date the payment was received. Press Tab.
5. Select the payment method from the payment icons. Press Tab.

6. Enter the reference number for the payment, if applicable.
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Record Payment in Full for a Single Job

7. Place a checkmark next to the invoices in the grid to which you are applying the payment. (If
Automatically apply payments has been chosen in Edit > Preferences > Payments >
Company Preferences, you can remove checkmarks and add your own if the automatic

application of payment doesn't suit your needs.)

Receive Payments

Main Reporis Payments oA
= o Process payment
«»> B X & = 0 = = -
Find Mew Delete Print  Email Atiach Look up Un-Apply Discounts And Record
M T File Customer/invoice Payment Credits Bounced Check Ad[‘
Customer Payment
ECEIVED FROM | Jacobsen, DougKitc... = . . -
u E =i Master ...
PAYMENT AMOUNT 2,000.00 I;:ET
CASH CHECK DEBIT e-CHECK
CATE 42M1402023 ] L
CHECK# | ggg CEFOSITTS  |42000 - Unde.. =
J | DATE NUMBER ORIG. AMT. AMT. DUE PAYMENT
1012312023 1069 3,207.75 795.00 0.00
11/25/2023 1082 4,725.00 3,5256.00 0.00
» 121512023 FAM2013 2,000.00 2,000.00 2,000.00
v
Totals 9,932.75 §,320.00 2,000.00
AMOUNTS FOR SELECTED INVOICES
AMOUNT DUE 2,000.00
APRLIED 2,000.00
DISCOUNT AND CREDITS
AFPLIED 0.00
save & Close Revert

8. Click Save & Close.

NOTES
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Enter a Partial Payment

@
o Step-by-Step: Enter a Partial Payment

1. From the Customers menu, choose Receive Payments. (If the QuickBooks Payment Interview
window displays, close it.)

2. Inthe Received From field, select the Customer:Job from whom you are receiving the payment.
Press Tab.

3. Inthe Amount field, type the amount of the payment. Press Tab.

4. Inthe Date field, enter the date the payment was received. Press Tab.
5. Select the payment method from the payment icons. Press Tab.

6. Enter the reference number for the payment, if applicable.

7. Place a checkmark next to the invoices in the grid to which you are applying the payment. (If
Automatically apply payments has been chosen in Edit > Preferences > Payments >
Company Preferences, you can remove checkmarks and add your own if the automatic
application of payment doesn't suit your needs.)
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right.

Enter a Partial Payment

8. Enter the amount of the payment to be applied to each invoice in the Payment column in the far

Receive Payments

Main  Reports  Paymenis B
«» B X 8= ¢ I
Find MNew Delete Prnt  Email Aftach Look up Un-Apply Discounis And

M T File Customerfinvoice Payment Credits Ad;
Customer Payment
RECEIVED FROKM  Bauman, MarkHom... = JR—
B EE | @~
—J —
FAYMENT AMOUNT 2,000.00 J—
CASH CHECK OEnm | SCHECK
DATE  1215/2023 v
CHECK# [333 CEFCSITTO  [42000 - Unde... +
J | DATE NUMBER ORIG. AMT AMT. DUE PAYMENT
» 12152023 73 3,925.00 3,925.00 2,000.00| %
v
Totals 3,925.00 3,925.00 2,000.00
UNDERPAYMENT AMOUNTS FOR SELECTED INVOICES
$1,925.00.
WHEN FINISHED: AMOUNT DUE 3.995.00
VE THIS AS AN UNDERRAYM e
T 2.000.00
1 WRITE OFF THE EXTRA /
CISCOUNT AND CREDITS
APFLIED 0.o0
VIEW CUSTOMER CONTACT INFORMATION
- Save & Close Clear

9.

underpayment option is selected.

10. Click Save & Close to record the partial payment.

NOTES

In the Underpayment section at the bottom, ensure the When finished: Leave this as an
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Apply One Payment to Multiple Jobs
of the Same Customer

@
o  Step-by-Step: Apply One Payment to Multiple Jobs of the Same Customer

1. From the Customers menu, choose Receive Payments. (If the QuickBooks Payment Interview
window displays, close it.)

2. Inthe Received From field, select the parent customer name for the jobs against which you are
receiving payment. This will enable QuickBooks to show all open invoices for the parent
customer and all its jobs. Press Tab.

3. Inthe Amount field, type the amount of the payment. Press Tab.
4. Inthe Date field, enter the date the payment was received. Press Tab.
5. Select the payment method from the payment icons. Press Tab.

6. Enter the reference number for the payment, if applicable.
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7. Place a checkmark next to the invoices in the grid to which you are applying the payment. (If
Automatically apply payments has been chosen in Edit > Preferences > Payments >
Company Preferences, you can remove checkmarks and add your own if the automatic
application of payment doesn't suit your needs.) You will be able to identify the invoice number

as well as the job to which it relates.

Apply One Payment to Multiple Jobs of the Same Customer

Main Reports Payments oA
5 @ E
Cuick Transaction Transaction Processed View Open Customer Sales By Item
Report History Journal  Payment Receipt  Invoices Balance Detail ltem Detail Price List
Customer Payment
RECEIVED FROM  Bristol, Sonya - : ’
BEES @ =~
! e
PAYMENT AMOUNT 7,850.00
CREDIT
CASH CHECK DEBIT e-CHECK
CATE 1 12115/2023 5] L
CHECK= 365 DEFOSITTS 112000 - Unde... w
DATE JoB {UMBER ORIG. AMT. AMT. DUE PAYME
» 121512023 Repairs T4 3,925.00 3,925.00 392500 ©
» [1215/2023 Utility Shed 75 3,925.00 3,925.00 3,925.00
12/15/2023 Repairs 78 1,400.00 1,400.00 0.00
v
Totals 9,250.00 9,250.00 7,850.00
AMOUNTS FOR SELECTED INVOICES
AMOUNT DUE 7.850.00
ARRLED 7.850.00
DISCOUNT AND CREDITS
AFFLIED 0.00
vero ] Save & Close Clear

8. Click Save & Close.

NOTES

Lesson 7 — Receive Payments & Make Deposits
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Enter Overpayments

If a customer sends you an overpayment, you simply enter the amount in the Receive Payments
window and QuickBooks keeps track of the additional payment. When the customer has future
invoices, you can apply the overpayment to those amounts — you can even apply the credit directly
to the invoice.

@)
o Step-by-Step: Enter the Payment

1. From the Customers menu, choose Receive Payments. (If the QuickBooks Payment Interview
window displays, close it.)

2. Inthe Received From field, select the Customer:Job from whom you are receiving the payment.
Press Tab.

3. Inthe Amount field, type in the amount of the payment. Press Tab.
4. Select the payment method from the payment icons. Press Tab.
5. Enter the reference number for the payment, if applicable.

6. Place a checkmark next to the invoices in the grid to which you are applying the payment. (If
Automatically apply payments has been chosen in Edit > Preferences > Payments >
Company Preferences, you can remove checkmarks and add your own if the automatic
application of payment doesn't suit your needs.) The total in the Payment column may not add
up to the total payment amount at the top of the Customer Payment window if you don't know
how to apply all the money.

7. Inthe Overpayment section at the bottom, you may choose Leave the credit to be used later to
leave the overpayment on the customer account or Refund the amount to customer to issue a
refund.
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8. Click Save & Close.

a. If you chose to refund the amount to your customer, the Issue a Refund window will appear.
Complete the form appropriately (including a memo, if desired).

b. Click OK.
e a Refund
Arefund is due to Lew Plumbing - C Issue this refund via Check -
Refund Amount % 2,730.00 Account 10100 - Checking -
Date 1215/2023 B RefiCheck No. To Print Ending Balance  82,742.33
Address Glen Lew Class b

Lew Plumbing
221 0ld Bayshore Rd
Bayshore CA 94326

Memao Refund of overpayment

« To be printed

NOTES
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Handle Down Payments & Prepayments

If a customer makes a payment before you've invoiced him for services (for example, he may be
making a down payment or paying a retainer fee), you can still record the payment in the Receive
Payments window. However, because you don't have any invoices against which to apply the
payment, QuickBooks records it as an unused payment (just like an overpayment for which you have
not issued a refund).

QuickBooks holds the unapplied amount in Accounts Receivable with the customer’s name (as a
negative amount). The next time you enter that customer in the Receive Payments window,
QuickBooks displays the credit amount in the Available Credits area. The customer’s balance also
reflects the credit amount.

@
o Step-by-Step: Enter the Down Payment

1. From the Customers menu, choose Receive Payments. (If the QuickBooks Payment Interview
window displays, close it.)

2. Inthe Received From field, select the Customer:Job from whom you are receiving the down
payment. Press Tab.

3. Inthe Amount field, type in the amount of the down payment. Press Tab.

Receive Payments

Main Reporis Payments oA
bl d a % g = @ &7 57 ] E] Process payment
Find New Delete Print  Email Attach Look up Un-App Discounts And Record
T T File Customer/invoice Credits Bounced Chec Ad;
Customer Payment

FCENEDFROM  EFKEnterpises v

e B BE = & | e
FOUNT 10,000.00 p—
CASH CHECK Depn | eCHECK
DATE [ 12M15/2023 -] b
cHECKE (3333 DEFOSITTC 12000 - Unde. =
J | DATE NUMBER ORIG. AMT. AMT. DUE PAYMENT
Totals 0.00 0.00 0.00
OVERPAYMENT AMOUNTS FOR SELECTED INVOICES
% 10,000.00.
WHE INISHED: AMOUNT DUE 0.00
0l REDIT TO BE USED F APPLIED

0.00
@ REFUND THE AMOUNT TO THE GUSTOMER
DISCOUNT AND CREDITS
APPLIED 0.00
VIEW CUSTOMER CONTACT INFORMATION

VEMT Down payment on future invoice save & Close | T Il Clear
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4. Select the payment method from the payment icons. Press Tab.
5. Enter the reference number for the payment, if applicable.

6. Ensure that no invoices are selected for applying the payment.
7. Ensure the Leave the credit to be used later option is selected.
8. Enter a memo indicating that it's a down payment, if desired.

9. Click Save & Close.

10. In the Payment Credit window that appears, click OK.

@
o Step-by-Step: Create an Invoice for a Customer Who Made

a Down Payment
1. From the Customers menu, choose Create Invoices.
2. Inthe Customer:Job field, select the customer for whom you are creating the invoice.
3. Add any billable time/costs, if applicable.

4. If you use custom invoice templates, select the appropriate template from the Template drop-
down.

5. Complete the invoice form appropriately.

6. Click Save in the Main tab of the ribbon at the top of the invoice to save your invoice but keep it
open.
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7. Click Apply Credits to apply the down payment amount toward this invoice.

Main Formatting Send/Ship Reports HoA
«» B B X CreateaCony 4@ & (@ [ Poniater B Elcreateasarn
Find MNew Save Delele @Memnnza Mark As Print  Email Email Later Attach Receive B Refund/Credit
- - Pending M M File Payments
CUSTOMER:JOB CLASS _ bi=0 =058 Rock Castle Invoice
Customer
| . DATE BILLTO SHIP TO e &
nvoice 12182023 W] |gpK Enterprises suMmaRY
INVOICE Preferred delivery method E-mail
78 Open balance -10,000.00
Active estimates 0
TERMS DUE DATE Bales Orders to be invoiced 0
~ 121152023 E
ITEM DESGRIPTION QUANTITY Uik RATE CLASS AMOUNT TAX
Removal ~ Removal labor 40 ~ | 3500« | - 140000 Non v |“
CUSTOMER PAYMENT 0
Your customer can not pay online
Edit customer preferences
v RECENT TRANSACTION g
1215/23 Payment 10,000.00
Your customer can't pay this invoice online T SanTomas v (775%) 0.00
Turn on TOTAL 1.400.00
CUSTOMER MES PEYMENTS APPLIED 0.00 NOTES &
- BALANCE DUE 1,400.00
MEMO CUSTOMER | Tax - Save & Close Clear
THC

8. Choose the credits you wish to apply to the invoice (if they're not chosen for you already) and
click Done. In this case, only part of a credit is being used and there is a remaining credit

balance.

INVOICE
Customer.Job  EFK Enterprises
Mumber 79 Amount Due 1,400.00
Date 12M15/2023 Discount Used 0.00
Qriginal Amt. 1,400.00 Credits Used 1.400.00
Balance Due 0.00
Credits
AVAILABLE CREDITS
J i DATE CRE... | CUSTOMER:JOB CREDITA...} AMT. TO ... ! CREDIT BA
w1 12M58/2023 3333 EFKEnterprises 10,000.00  1,400.00  8,600.00("
v
Totals 10,000.00  1,400.00 8,600.00
Of all the credits issued to this customer, only unused credits —
applicable to this specificinvoice are displayed above.
PREVIOUSLY APPLIED CREDITS
J i DATE CRE.. ! CUSTOMER:JCE CREDITA.. ! AMT. TO ... | CREDIT BALA...
A
v
Totals 0.00 0.00 0.00
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9. You will see the invoice is now changed to reflect the application of a credit and the balance due
is also affected.

Main Formatting Send/Ship Reports oA
¢« B B 2 Borwcoonm & = | Pueitar | B Tmescoss B [ create aaten
Find New Save Delete §BMemorize Mark As Print  Email Email Later | Aftach | & Apply Credits Receive B Refund/Credit
M M Pending - M File Payments
[SifzAas \\ =l
B W W
cusrone sos [EFRETED B - o Caste moice = | > EPkEnterprises i NG
| | W‘//,
’? Customer E‘\Y = \\U‘;
| |
| H DATE BILLTO SHIP TG s '{ &
NVOICE seericton 1211512023 B |ErkEnterprises | summary
Q PAID 121512023 INVOICE & 7 Preferred delivery method E-mail
|
79 | Openbalance -8,600.00
i\ Active estimates 0
TERMS DUE DATE | 8ales Orders to be invoiced 0
| |
v [125i2023 m| ||
ITEM ! DESCRIPTION i QUANTITY Eum § AMOUNT i TAX | |
Removal Removal labor 40 1,400.00 Non |‘ 7
EJ CUSTOMER PAYMENT ’
| |
,;\ Your customer can not pay online
;‘, Edit customer preferences
1
v v\(‘ RECENT TRANSACTION 5
|
"; 12/15i23 Invoice - Paid 1,400.00
Your customer can't pay this invoice onine ™ BanTomas v | (7.75%) 0.00 || 12115123 Payment 10,000.00
Turn on TOTAL 1,400.00 | |
| |
CUSTOMER MESSAGE PFAYMENTS APFLIED 1,400.00 ,;\ NOTES 4
SALANCE DUE 0.00 1
- i
1
MEMO CUSTOMER | Tax hd Save & Close Revert g
T8 CODE T

10. Click Save & Close.

NOTES
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Make Deposits

When you use the Enter Sales Receipts window (for a sale where you receive payment on the spot),
the Receive Payments window (for payments on invoices), or a payment item in the body of an
invoice, QuickBooks keeps track of the money you've received until you deposit it in the bank. When
you receive payments from customers, you can either deposit each payment directly into a
QuickBooks bank account or you can accumulate those payments in an account called Undeposited
Funds to be moved to a bank account at a later time. (This makes reconciling the bank accounts
much easier to do; you don't need to use a calculator to add up individual payments to match the
total deposit for the day when comparing the amounts in QuickBooks to the bank statement.
QuickBooks allows you to choose the method you prefer for depositing payments in the Company
Preferences for Payments.)

@
o Step-by-Step: Select Payments to Deposit

1. From the Banking menu, choose Make Deposits.

SELECT VIEW
Wiew payment method type All types = \Whatare payment method views?
Sort payments by Payment Method -
SELECT PAYMENTS TO DEPOSIT
o i DATE TIME TYPE NO FAYMENT METHOD  © NAME AMOUNT
121512023 RCPT 3009 Ted Customer 10,000.00
12192022 PMT 1234 Check Robson, Darci:Robson 1242098
1211512023 PNT Check Brenda Bowden_c 10,000.00
121512023 PNT 3333 Check EFK Enterprises 10,000.00
12118i2023 PMT 1234 Master Card Lew Plumbing - C 3,000.00
0 of 5 payments selected for deposit Payments Subtotal 0.00
Select All Select None
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2. Click to select the payments you want to bring to the bank in one batch (e.g., a deposit slip).

nents to Deposit
SELECT VIEW
View payment method type All types = | What are payment method views?
Sort payments by Payment Method -
SELECT PAYMENTS TO DEPOSIT
o i DATE TIME TYPE NO PAYMENT METHOD | NAME AMOUNT
121512023 RCPT 3009 Ted Customer 10,000.00
¥ 1211912022 PMT 1234 Check Robson, Darci:Robson ... 1242088
v 1211512022 PMT Check Brenda Bowden_c 10,000.00
¥ 1211502023 PMT 3333 Check EFK Enterprises 10,000.00
121512023 PMT 1234 Master Card Lew Flumbing - C 3,000.00
3 of 5 payments selected for deposit Payments Subtotal 32,420.98
Select All Select None
3. Click OK.

QuickBooks displays the Make Deposits window, which shows the payments you just selected.
4. Inthe Deposit To field, make sure the proper bank account is selected.

5. Ensure you enter the correct date and a memo, if desired.
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Make Deposits

6. Add any information, such as missing check numbers and extra memo information, for a

particular line, etc.

@ Previous ® Next E Save &= Print ~ &4 Payments @ History ﬂJournaI | ﬂ Attach

[PELLE I 10100 - Checking) - ] Date 12152023 @ Memo | Deposit
Click Payments to select customer payments that you have received. List any other amounts to deposit below.
Robson, Darci:Robson Clinic 12000 - Undeposited Funds 1234 Check
Brenda Bowden_c 12000 - Undeposited Funds Check
EFK Enterprises 12000 - Undeposited Funds  Down payment o... | 3333 Check
Deposit Subtotal
To get cash back from this deposit, enter the amount below. Indicate the account
where you want this money to go, such as your Petty Cash account.
Cash back goes to Cash back memao Cash back amount
Deposit Total
Save & Close | Save & New

12,420.98
10,000.00
10,000.00

32,420.98

32,420.98

Clear

If you have money to deposit that is not the result of a payment you received for a sale, you can
enter it in the detail area of the window in the next vacant row. For example, if you are also
depositing a premium refund from your insurance company or funds from a shareholder loan,

you would enter it here.

7. If any funds are deducted from the deposit because, for example, they're diverted to Petty Cash,
fill out the area in Cash back goes to, the Cash back memo and the Cash back amount.

8. You can print the deposit slip by selecting the Print icon at the top of the Make Deposits window
and take that to your bank to accompany the deposit. You also have the choice of printing a

summary.

9. Click Save & Close to record the deposit.

NOTES
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How QuickBooks Handles the Deposit

@
o  Step-by-Step: View the Undeposited Funds Account

1. From the Lists menu, choose Chart of Accounts.
2. Inthe Chart of Accounts, double-click the Undeposited Funds account.

When receiving payment on an Invoice or use a Sales Receipt and Undeposited Funds is chosen
as the account, the balance in Undeposited Funds is increased. When creating a Make Deposit
transaction and selecting payments from Undeposited Funds to deposit into a bank account, the
balance in Undeposited Funds is reduced. If there is nothing left in Undeposited Funds to
deposit into the bank, the balance in the account will be zero. (In the screen capture below it
shows a non-zero balance in Undeposited Funds. Therefore, choosing Make Deposits would show
payments left to deposit into the bank.)

12000 - Undeposited Funds

e Go to... | g Print... | 52 Edit Transaction E]QuickRepor‘t

a
m
:
in
m
m
i
I
T

DATE REF PAYEE DECREASE g NCREX

12115/2023 1234 Robson, Darci:Robson Clinic 12,420.98 ~ 3,000.00
DEP 10100 - Checking [splif]

12/15/2023 3009 Ted Customer 10,000.00 13,000.00
RCPT -split-

12/15/2023 3333 EFK Enterprises L4 10,000.00 23,000.00
PMT 11000 - Accounts Receivable Down payment on future invoice

12115/2023 3333 EFK Enterprises 10,000.00) 13,000.00
DEP 10100 - Checking [splif] Down payment on future invoice

12M15/2023 | 765467  Allard, RobertRemodel v 14,510.00 27 510.00
PMT 11000 - Accounts Receivable

12115/2023 765467 | Allard, RobertRemodel 14,510.00) + 13,000.00

DEP 10100 - Checking [splif]

I-Line ENDING BALANCE 13,00000

Sortby  Date, Type, Number/Ref =

NOTES
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How to Handle a Customer Bounced Check

@
o Step-by-Step: When a Customer Payment Check is Returned by the Bank

1. Open the Customer Center from the Customers drop-down menu (or press CTRL+j).

2. Highlight the Customer:Job from the list, then double-click on the payment transaction from the
transaction list to open it.

3. Select the Record Bounced Check icon.

ve Payments

Main Reporis Payments oA
E: o Process payment
«» B X @@ 0 & " @[ @)
Find MNew  Delete Print  Email Aftach Look up Un-Apply Discounts And Record
h M File Customer/invoice Payment Credits Bounced Check Ad;
Customer Payment e Rooand Romens ek
y Records a payment that the bank
returned for nonpayment and lets
RECEIVED FROU ECKE" Designs - l —— . you create a second invoice for the
u E | = MORE processing fees and bank charges.
PEYMENT AMOUNT 1,468.30
CREDIT
CASH CHECK DEEIT e-CHECK
DATE  12M5/2023 [} ]
CHECK # GEER DEPOSIT TO 10100 - Chec... =
.( DATE JOB MUMBER ORIG. AMT AMT. DUE PAYMENT
« 11130/20... Office Repairs 1086 1,468.30 1,468.30 1,468.30 ©
v
Totals 1,468.30 1,468.30 1,468.30
AMOUNTS FOR SELECTED INVOICES
AMOUNT DUE 1.468.30
AERLIED 1.468.30
DISCOUNT AND CREDITS
APFLIED 0.00
Save & Close Revert
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How to Handle a Customer Bounced Check

4. Enter any bank fees charged by your bank for the NSF transaction.
5.

If you charge your customer a fee for NSF checks, you can enter that as well.

Manage Bounced Check

What did the bank charge you for this bounced check?

BANK FEE  25.00 DatE | 12/15/2023 E

EXFENSE ACCOUNT  B0G00 - Bank Service Charges

CLASS

How much do you want to charge your customer?

CUSTOMER FEE | 45.00 Learn mare

Back “ Finish Help

Cancel

6. Click Next.

In the Bounced Check Summary, select Finish.

Bounced Check Summary

When you click Record Bounced Check, here's what will happen in QuickBooks:

1. Following invoices will be marked unpaid:

Invoice 1086 Ecker Designs Unpaid 1,468.30

2. These fees will be deducted from your bank account;
Checking Check GEEG 1,468.30
Checking Senice Fee 25.00

3. This invoice will be created for the fee you want to charge your customer:
Invoice Ecker Designs 45.00

Cancel

Lesson 7 — Receive Payments & Make Deposits
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8. Notice the Customer Payment screen indicates this check bounced.

Main Reporis Payments oA
E P Process payment
«» X &8 = @ % '
Find New Delete Print  Email Attach Look up Un-Apply Discounts And L
v - File Customer/invoice Payment Credits Bounced Check Ad

Customer Payment @ ooy

FEYMEMT AMOUNT 1,468.30
CREDIT
CASH CHECK DEBIT e-CHECK
DATE | 12M15/2023 [ | L
CHECK=  GBB6 DEFCEITTS 10100 - Chec.. =
J | DATE JOB MUMBER CORIG. AMT AMT. DUE FAYMENT
11430/20... Office Repairs 1086 1,468.30 1,468.30 000 &
« 121520 8908100 1,468.30 1,468.30 1,468.30
12M5120 .. 80 45.00 4500 0.00
v
Totals 2,881.60 151330 1,468.30
AMOLUNTS FOR SELECTED INVOICES
AMOUNT DUE 1.468.30
APFLIED 1.468.30
DISCOUNT AND CREDITS
AFFLIED 0.00

MEND Save & Close Revert

9. Save & Close.

To see the effect of the bounced check, open the bank register by double-clicking the bank account
from your Chart of Accounts (CTRL+a).

NOTES
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Receive Payments & Make Deposits — Review
Questions

1. A company has set up three different jobs for a single customer. The customer writes one check
to make a partial payment on open balances for all three jobs. In QuickBooks, that payment...

a. must be applied to the first invoice for the first job for the customer.

b. must be applied to the most recent invoice for the customer.

c. can be applied to any combination of invoices and jobs for the customer.

d. cannot be applied to any invoices or jobs for the customer until full payment is received.
2. QuickBooks supports which of the following types of payment scenarios?

a. Down payments for products or services

b. Overpayments from customers

o

Partial payments from customers
d. All of the above

3. True or false: You can enter a customer payment directly in the customer register.

a. True
b. False
4. The account acts like a cash drawer and is used to

hold funds until you deposit them into a bank account.
5. True or false: QuickBooks allows you to print deposit slips you can take to the bank.
a. True

b. False
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Review Activities

1. Create an invoice for Bryan Ruff's utility shed job. Add names to Rock Castle Construction’s Item
list as needed.

2. After you invoice Bryan, record a payment from him in the Receive Payments window.

3. Record Rock Castle Construction’s deposit of the payment.
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Answers to Review Questions

1. A company has set up three different jobs for a single customer. The customer writes one check
to make a partial payment on open balances for all three jobs. In QuickBooks, that payment...

a. must be applied to the first invoice for the first job for the customer.

b. must be applied to the most recent invoice for the customer.

c. v can be applied to any combination of invoices and jobs for the customer.

d. cannot be applied to any invoices or jobs for the customer until full payment is received.
2. QuickBooks supports which of the following types of payment scenarios?

a. Down payments for products or services

b. Overpayments from customers

o

Partial payments from customers
d. v All of the above

3. True or false: You can enter a customer payment directly in the customer register.
a. True
b. v False; you must enter payments in the Receive Payments window.

4. The Undeposited Funds account acts like a cash drawer and is used to hold funds until you
deposit them into a bank account.

5. True or false: QuickBooks allows you to print deposit slips that you can take to the bank.
a. v True

b. False
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Lesson Objectives

® Discuss the different ways you can handle bills in QuickBooks
® Learn how to enter a bill in QuickBooks

® Use the Pay Bills window to pay a bill in QuickBooks
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Use QuickBooks for Accounts Payable

Some business owners, especially if they own smaller, home-based businesses, pay their bills when
they receive them. Most business owners, however, find it more convenient to pay bills less often.
(They also like keeping the cash in the company for as long as possible.) If you don't plan on paying
your bills right away, QuickBooks can help you keep track of what you owe and when you owe it.

The money you owe for unpaid bills is called accounts payable. QuickBooks uses the Accounts
Payable account to track all the money you owe to suppliers/vendors. Like any QuickBooks balance
sheet account, the Accounts Payable account has a register where you can view all your bills at once.

@
o Step-by-Step: See the Accounts Payable Register

—_—

From the Lists menu, choose Chart of Accounts.

2. Double-click 20000 Accounts Payable in the list to open the register.

20000 - Accounts Payable

& Goto.. | ) Print.. ‘ [ Edit Transaction [ QuickReport
12512023 513 Timberloft Lumber 1,610.00 47,159.24
BILLPMT 10100 - Checking
1215/2023 514 Sloan Roofing 5,700.00 41,459.24
BILLPMT 10100 - Checking
12158/2023 Keswick Insulation Paid 670.00 4212924
BILL 54000 - Job Expenses:54500 - Subcontractors
121M5/2023 Sergeant Insurance 011412025 4,050.00 46,179.24
BILL 13100 - Pre-paid Insurance
1215/2023 Wu Contracting 1213012024 1,250.00 47,429.24
BILL -split-
1215/2023 12/03 Cal Gas & Electric 123012024 122 68 47,551.92
BILL 65100 - Utilities:65110 - Gas and Electric Acct #560-82645-99C
12M5/2023 | B059 Thomas Kitchen & Bath 0114/2025 585.00 48,136.92
BILL 54000 - Job Expenses:54300 - Job Materials
B L
Spits ENDING BALANCE 48,136.92
I-Line Show open balance
Sortby  Date, Type, Number/Ref = | Record ‘ Restore
Lesson 8 — Enter and Pay Bills 6
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The register keeps track of each bill you have entered, shows you the due date and keeps a
running balance of all the bills you owe. As a business owner, this helps you forecast your cash
flow, and the QuickBooks reminder system helps you pay your bills on time.

3. Press Esctwice to close the open windows.

Lesson 8 — Enter and Pay Bills



QuickBooks Desktop 2019 Client Training Enter Bills

Enter Bills

When you receive a bill from a vendor, you should enter it into QuickBooks as soon as you can. This
keeps your cash flow forecast reports up to date and doesn't give you the chance to set the bill aside
and forget it.

@
o Step-by-Step: Enter a Bill

1. From the Vendors menu, choose Enter Bills (or choose Enter Bills from the Home page).

Enter Bills
Main Reporis oA
X Po s
«* B E XQowweoer @ § B O B B @
Find New Save Delete §dMemorize Print Aftach Select  Enie Clear Recalculate Pay
5 5 File PO Time Spiits Bill
® Bill 7 Credit /| Bill Received
Name Transaction

VENDOR “ - DATE 12/15/2023 @ SUMMARY

REF. NO
ADDRESS

AMOUNT DUE 0,00

BILL DUE 12/25/2023 HE

-
RECENT TRANSACTIONS
Expenses $0.00 Items $0.00
ACCOUNT AMOUNT MEN usT BIL cLASS
A
v NOTES
save & Close | (IR TIUARY Clear

2. Inthe Vendor field, enter the vendor name.
3. Inthe Date field, enter the date of the bill.
4. |nthe Ref. No. field, enter the bill number.
5. Inthe Amount Due field, type 1500.

6. Enter the appropriate terms as well as any necessary memo information.
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7. Use the Expenses tab to enter expenses from the bill and post them directly to expense
accounts (you can use more than one line to refer to different types of expenses) and specify the
dollar amount of each expense. The amounts should add up to the total amount due on the bill.

Enter Bills

Main Reports
& [L]
«» B B X Boweon & @ o B B &
Find New Save Delete €BMemorize Print  AMach  Select Enter Clear Recalkulate  Pay
T T File PO Time Splits Bill
1 gil ) Credit | Bill Received
VENDOR  Davis Business Associates - DATE 1211512023 [
sponees | Davis Business Associates R HE
AMOUNT DUE |1 500.00
BILL DUE 1212512023 [
TERMS -
Expenses $1,500.00  ltems $0.00
ACCOUNT AMOUNT EMO CUSTOMER:JOB EILL
53300 - Printing and Reproduction 1,450.00
54000 - Job Expenses:54520 - Freight & Delivery - 50.00 |
Save & Close | Save & New

Vendor

SUMMARY

Phone
Email
Open balance

POs to be received

RECENT TRANSACTION
12/20021 Check

NOTES

Transaction

415-555-2874

kdavis@samplename.com

&

0.00
0

g

2,100.00

8. Click Save & Close to record the bill. (Note, if this were a vendor credit instead of a bill, you
could click on the radio button next to Credit in the top right corner instead of Bill. This would

issue a vendor credit, which, although all the numbers would appear positive as in the bill

example above, would function as a “negative” bill.)

=

NOTES

IMPORTANT: You can also enter bills and vendor credits directly in the Accounts Payable register, which
may allow for faster data entry. However, this does not provide as much room for memos or allow for
multiple expense accounts, job costing, or making the expenses billable to customers.
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Pay Bills

When you start QuickBooks or open a QuickBooks company file, a Reminders window appears to
tell you whether you have transactions to complete, such as bills to pay or money to deposit. (If you
don't see the Reminders window, turn it on by choosing Preferences from the Edit menu, and then
choosing Reminders.)

When QuickBooks tells you that there are bills due, you can display the Pay Bills window and select
the bills you want to pay.

@
o Step-by-Step: Pay a Bill
1. From the Vendors menu, choose Pay Bills (or click on Pay Bills from the Home page).
2. Ensure the Sort By order is by Vendor.

3. Check the boxes next to the bills you wish to pay.

SELECT BILLS TO BE PAID
(1 Due on or before
Show bills
@ Show all bills Filter By -
[SGIT BY vendor - ]
- VENDOR REF. NO DISC. DATE AMT. DUE CISC. USED CREDITS USED AMT. TO P&
= ACheung Limited 8908098 5,000.00 0.00 0.00 5,000.00 &
[~ 12/30/2024 C.U. Electric 500.00 0.00 0.00 500.00
1112025 | C.U. Electric 250.00 0.00 0.00 250.00|
[~ 12/30/2024  Cal Gas & Electric 12/03 122.68 0.00 0.00 0.00
[~ 01/22/2023  Cal Telephone 37498 623.00 0.00 0.00 0.00
[ 12/25/2024 Cal Telephone 91.94 0.00 0.00 0.00
v
Totals 4723572 0.00 0.00 5,750.00
Clear Selections
DISCOUNT & CREDIT INFORMATION FOR HIGHLIGHTED BILL
Vendor C.U. Electric Terms et 30 Mumber of Credits 0
Bill Ref. Mo. Sugg. Discount 0.00 Total Credits Available 0.00
Go to Bill Set Discount Set Credits
PAYMENT
Date Method & Tob inted Account
121152023 @ Check © Tobeprimed 10100 - Checking -
Assign check number Ending Balance 109,388,
[ Pay Selected Bils | [[eTEY
Lesson 8 — Enter and Pay Bills 10
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4. Ensure you have the proper payment method settings selected, as well as the bank account (or
credit card account, if you're paying by credit card) from which you want the bills to be paid.

5. Click Pay Selected Bills.

In the next window, you can choose to pay more bills, print checks for the selected bills, or click
Done to exit the module and print checks later (if you're paying by check).

= IMPORTANT: You can also click the Print Checks icon from the Home page to access your checks
marked Print Later.

NOTES
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How QuickBooks Records Your Bill Payment

When you pay $1,500 on a bill through the Pay Bills window, QuickBooks makes an entry in the
Accounts Payable register showing a decrease (debit) of $1,500 in total payables. It also creates a
check (credit) from your chosen bank account to pay the bill. This is a special type of check called a
Bill Payment Check. Similarly, if you are paying a bill using a credit card, it creates a payment (credit)
from your credit card account to pay the bill. This is a special type of credit card charge called a Bill
Payment Credit Card.

@
o Step-by-Step: See the Entry in the Accounts Payable Register

1. From the Company menu, choose Chart of Accounts.

2. Inthe Chart of Accounts, double-click the Accounts Payable account.

20000 - Accounts Payable
% Goto.. | &) Print.. | [ Edit Transaction [&) QuickReport

&
o
El
o
I
m
g
m
o
A
e
i
=]
w
i
f
X
3
"

12H5/2023 Keswick Insulation Paid 670.00 36,379.24
BILL 54000 - Job Expenses:54500 - Subcontractors

121512023 Sergeant Insurance 011142025 405000 40,429 24
BILL 13100 - Pre-paid Insurance

1211512023 WVu Contracting 12/30/2024 1,250.00 41,679.24
BILL -split-

1215/2023 12103 Cal Gas & Electric 1213012024 122.68 41,801.92
BILL 65100 - Utilities:65110 - Gas and Electric Acct #560-82645-99C

121512023 3434 Davis Business Associates 12/25i2023 1,500.00 4330102
BILL -split-

1211512023 8059 Thomas Kitchen & Bath 01142025 B85.00 43,886.92
BILL 54000 - Job Expenses:54300 - Job Materials

12M15/2023 Cal Telephone 714.94] 43,171.98
BILLPMT 20500 - QuickBooks Credit Card

L] - L

Splits ENDING BALANCE 43,171.98
1-Line Show open balance
Sortby  Date, Type, NumberRef = | Record | Restore

3. Close the Accounts Payable register.
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@
o Step-by-Step: See the Bill Payment Entry

1. Inthe Chart of Accounts, double-click 10100 Checking.

DATE PAYEE PAYMENT s DEPOSIT BALANCE
1211512018 508 East Bayshore Tool & Supply 1,476.23 65,070.43
BILLPMT 20000 - Accounts Payable
1215/2018 509 Hopkins Construction Rentals 450.00 64,620.43
BILLPMT 20000 - Accounts Payable
12M15/2018 510 Timberloft Lumber 896.00 63,724.43
BILLPMT 20000 - Accounts Payable 1890-76
12/15/2018 511 East Bayshore Tool & Supply GOG.52 £3,027.91
BILLPMT 20000 - Accounts Payable
1215/2018 512 Patton Hardware Supplies 400.00 62,627.91
BILLPMT 20000 - Accounts Payable RC 93
121512018 Timberloft Lumber 1,610.00 61,017.91
BILLPMT 20000 - Accounts Payable 1890-76
1215/2018 514 Sloan Roofing 5,700.00 55,317.91
BILLPMT 20000 - Accounts Payable
Splits ENDING BALANCE USD 546,43323
1-Line
Sortby  Date, Type, Number/Ref = | Record | Restore

2. Select the Bill Payment (BILLPMT) transaction you wish to view.

3. Double-click on the transaction or on the toolbar, click Edit Transaction.
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4. You can edit the transaction or click Save & Close.

How QuickBooks Records Your Bill Payment

Main Reporis

e» 5 @ X B
Find New Save Delete
BANK ACCOUNT

Print Later

Online Bank Pmt

FAY TOTHE ORDER OF | Timberloft Lumber

Aftach
File
ENDING BALAMCE 109,38331
no. |513
O 1352023 B
- 3 [1,610.00

Oneihousand sixmmdredien and GOF00E S 2=t F s anre e e s e nar e s e 1 DoLLARS

Timberloft Lumber
456 Old Bayshore Rd

ADDRESS  Bayehore CA 94326

MEMO

1890-76

BILLS PAID IN THIS TRANSACTION:

F.. | DATEDUE | VENDOR REF. MO BILLAMT. ! AMT.DUE i DISC. DA.. | AMT. PAID
1119/2024 Timberloft Lumber 13,780.00 8,000.00 10/30/2023 0.00|
12/20/2024 Timberloft Lumber 12849 1,960.00 19.60 11/30/2023 0.00
12/31/2024 Timberloft Lumber 80.50 80.50 12M11/2023 0.00

v 1231/2024 Timberloft Lumber 1,610.00  1,610.00 1211/2023 1,610.00

Discounts Revert

F
B B & = (
Clear Recalculate Batch Reorder
Splits Transactions Reminder Coh

s

v

=
Accounts Payable register.

NOTES

IMPORTANT: You can also open, view or edit this transaction by opening it in the same fashion from the

Lesson 8 — Enter and Pay Bills
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Enter and Pay Bills - Review Questions

1. You use the account to track money you owe to vendors.

2. List the two steps involved in using the accounts payable features in QuickBooks:

a.

b.

3. When you make a payment (from the checking account) in the Pay Bills window, you can see the
transactions in the and registers.

4. True or false: When tracking accounts payable in QuickBooks, the Enter Bills window is the only
place you can enter bills and vendor credits.

a. True
b. False

5. You paid a vendor $1,000 through the Pay Bills window (using the Checking account).
QuickBooks automatically creates a journal entry that:

a. Deletes the bill
b. Shows $1,000 as a credit in Accounts Payable and $1,000 as a debit in the Checking account
c. Shows $1,000 as a debit in Accounts Payable and $1,000 as a credit in the Checking account

d. Shows $1,000 as a debit in Accounts Payable and $1,000 as a credit in Accounts Receivable

Lesson 8 — Enter and Pay Bills 15
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Review Activities

1. Write a check to a vendor assigning the amount to more than one expense account.

2. Enter a bill in the Enter Bills window then view the bill transaction in the Accounts Payable
register.

3. Pay the bill using the Pay Bills window.

Lesson 8 — Enter and Pay Bills 16
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Answers to Review Questions

—_—

. You use the Accounts Payable account to track money you owe to vendors.

2. List the two steps involved in using the accounts payable features in QuickBooks:
a. v Enter bills

b. v Pay bills

3. When you make a payment (from the checking account) in the Pay Bills window, you can see the
transactions in the Checking and Accounts Payable registers.

4. True or false: When tracking accounts payable in QuickBooks, the Enter Bills window is the only
place you can enter bills and vendor credits.

a. True

b. v False; you can also enter bills and vendor credits directly in the Accounts Payable register,
which may allow for faster data entry.

5. You paid a vendor $1,000 through the Pay Bills window (using the Checking account).
QuickBooks automatically creates a journal entry that:

a. Deletes the bill.
b. Shows $1,000 as a credit in Accounts Payable and $1,000 as a debit in the Checking account.

c. v Shows $1,000 as a debit in Accounts Payable and $1,000 as a credit in the Checking
account.

d. Shows $1,000 as a debit in Accounts Payable and $1,000 as a credit in Accounts Receivable.

Lesson 8 — Enter and Pay Bills 17
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Training at a Glance

Use this as a guide to select specific workflows to be covered.

TOPICS STEP BY STEP WORKFLOWS
PRODUCT ® Benefits of using QuickBooks Online
OVERVIEW ® Know the features of your QuickBooks Online subscription

IMPORTING DATA ® Export QuickBooks Desktop data to QuickBooks Online
® Become familiar with importing lists into QuickBooks Online

SETTING UP YOUR ® Explore how to add users to QuickBooks Online
COMPANY ® Explore the Products and Services list

Print a transactions report for a selected account directly from the
Chart of Accounts

Print the Chart of Accounts
Connect a bank account to the bank feed
Become familiar with the Company tab in global Company Settings

Enter contact information, employer ID and tax form in global
Company Settings

Specify terminology for customers in global Company Settings
Become familiar with the Sales tab in global Company Settings

Become familiar with how to turn on inventory in global Company
Settings

Become familiar with the Expenses tab in global Company Settings
Explore how to turn on purchase orders in global Company Settings
Become familiar with the Advanced tab in global Company Settings
Explore how to close the books in global Company Settings

Explore how to show account numbers in global Company Settings

Explore how to enable auto-recall on forms in global Company
Settings

® Change settings for automatic signing out after a period of inactivity

Course 1 - Get Started 3
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QuICKBOOKS ONLINE TEST DRIVE

Exercises contained inside this handbook can be completed using a QuickBooks Online “test drive”
file. The test drive uses a sample company file called Craig’s Design & Landscaping Services. It can
be accessed through the following link:

Craig's Design & Landscaping

You don't have to create an account or sign in to access the test drive file; just complete the security
validation and click Continue.

This test drive is designed for you to explore and try out new things without worrying you will break
something or make a mistake. It is not designed to retain any changes you make. Once you close
this QuickBooks Online test drive company it is completely refreshed, so remember to allow
sufficient time to complete each task.

Course 1 - Get Started 4
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Topic 1: Product Overview

QuickBooks Online has many features and advantages that QuickBooks Desktop does not offer.
Once you make the change to QuickBooks Online, it is important to understand the features
available to you by being in the cloud and the feature availability based upon your subscription
level. Look at just some advantages that QuickBooks Online has:

Access data easily across multiple platforms, PC or Mac, browser or tablet

Mobile access included with QuickBooks Online subscriptions at no additional cost

No need to transfer data files since everyone logs in to the same account to access the same data
All the data is hosted, backed up and secured by Intuit's servers

Automatically create invoices and send them to clients, including delayed customer charges for
unbilled time and costs

Post to multiple accounts receivable and accounts payable lines in a single journal entry

Track inventory using the first in, first out (FIFO) method (the only QuickBooks Desktop edition
that offers FIFO inventory costing is QuickBooks Desktop Enterprise with Advanced Inventory)

Track logins, third-party activity and list changes in the Audit Log

Reports can be emailed to anyone at a scheduled frequency, even if they do not have access to
this QuickBooks Online company file

Further organize data with both class and location tracking; labels can be selected for locations
(such as property, store, territory, etc.)

Bank transactions are automatically downloaded nightly

Invite unlimited “reports only” and “time tracking only” users

Sync third-party apps to QuickBooks Online without opening the QuickBooks Online company,
since the apps sync to Intuit's always-accessible server; no downloading and managing third-
party sync engines

QuickBooks Online developers are always releasing new functionality to QuickBooks Online (no

need to install new versions of QuickBooks Online as you always get the latest and the greatest
with new features users are requesting)

Course 1 - Get Started 5
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Topic 1: Product Overview

KNOW THE FEATURES OF YOUR QUICKBOOKS ONLINE SUBSCRIPTION

QuickBooks Online is a great solution for many different types of businesses. Every company must
assess their needs to find a financial accounting solution appropriate for their business. Use the
QuickBooks Online subscription matrix to determine the features of your QuickBooks Online
subscription: http://quickbooks.intuit.com/online/compare. You can upgrade your QuickBooks

Online subscription at any time to accommodate changes in your business.

QuickBooks Online Simple Start

QuickBooks Online account
Automatic data backup
Bank-level security and encryption

One full-access user

Invite up to two accountant users, no
additional charge

® Unlimited invoices and estimates
® Charge sales tax to customers

® Snap photos of receipts so you're ready for
tax time

Print checks and record transactions
Download bank and credit card transactions
Import from QuickBooks Desktop

Import/export lists from Microsoft Excel®
(customers, vendors, Chart of Accounts)

Add payroll to pay W-2 employees and file
payroll taxes

Prepare and print 1099-Misc
Integrate with available applications

20+ built-in reports

Course 1 - Get Started
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QuickBooks Online Essentials

With QuickBooks Online Essentials you have access to all the Simple Start features as well as:

® Access for three users with permission ® Unlimited time tracking-only users
controls
® Compare sales profitability with industry
® Manage and pay bills, including schedule trends
payments for later
® Delayed charges and credits
® Automatic invoice creation on recurring
schedule ® Multicurrency

® Track billable hours by customer ® 40+ built-in reports

QuickBooks Online Plus

With QuickBooks Online Plus you have access to all the Simple Start and Essentials features
as well as:

® Access for five users with permission controls @ Track inventory using the FIFO method
(up to 25 paid users total)
® Prepare and print 1099-Misc
® Unlimited reports-only users
® Budgets
® Track billable hours by customer
® Two-sided items
® Purchase orders
® Estimates
® Class and location tracking
® 65+ built-in reports
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Topic 2: Import Data

IDENTIFY STEPS TO IMPORT DATA INTO QUICKBOOKS ONLINE

When you sign in to your company you can click the Help button (the question mark in the circle or
the word Help next to it) in the top right corner for access to in-product self-help resources such as
overviews and videos, as well as a Contact Us button with various options for ways to connect.

wvturt

@ quickbooks

+ q 3 . a
poshEos oo Craig's Design and Landscaping Services
Banking
Sales Start invoicing
People like you viewed these answers
Expemess See how much you're making
Set up alignment to print checks (or cheques)
Projects
Pay your employees How to print checks
Warkers
Start tracking time Set up payments Send your first Set up Payroll account preferences
Reports invoice
Align preprinted paychecks (or paycheques)
Taxes Connect with an accountant for QuickBaoks Online Payroll
Accounting
My Accountant Invoices Expenses Lest month ¥
$5,281.52 UNPAID  LAST 355 DAYS
‘ © $7!03_5 Benk oglancs §-3,021.93
$1.525.50 $3.756.02 LAST MONTH In QuickBooks $1,201.00 mon: -
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QuickBooks Online allows users to import data from QuickBooks Desktop within the first 60 days of
creating the QuickBooks Online account. When this data is imported, it replaces (i.e., overwrites) any
pre-existing data in the QuickBooks Online account.

Most QuickBooks Desktop data can be imported, but there are some limitations. Because
QuickBooks Online is being improved constantly, the import capabilities can change. Check the
latest limitations by visiting The Visual Guide to Export. At the time of this publication, these
guidelines are among those in effect:

® While the size of the QuickBooks Desktop company file does not matter when importing to
QuickBooks Online, the Desktop file must consist of no more than 350,000 targets

® If the Desktop file consists of more than 350,000 targets, consult The Visual Guide to Export for
alternatives regarding trimming the file or importing lists and/or balances only

® Form templates (such as invoices, credit memos, statements, etc.) from QuickBooks Desktop
cannot be brought into QuickBooks Online

® Memorized reports from QuickBooks Desktop cannot be brought into QuickBooks Online

@® Reconciliation reports from QuickBooks Desktop cannot be brought into QuickBooks Online

® Payroll data imports from QuickBooks Desktop to QuickBooks Online as checks, not paychecks;
any desired payroll service will have to be newly set up in QuickBooks Online via an interview

including calendar YTD fields for each employee

@ International versions of QuickBooks Desktop cannot be imported into QuickBooks Online’s U.S.
version

® You can import your QuickBooks Online data back to QuickBooks Desktop, with limitations,
using Internet Explorer (in The Visual Guide to Export, enter Export data file from QuickBooks
Online to Desktop in the search bar and follow those instructions)
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]

o Step by Step: Export QuickBooks Desktop Data to QuickBooks Online

These steps are for exporting a QuickBooks Desktop (Pro or Premier) company to QuickBooks
Online. These steps can be followed using a QuickBooks Desktop sample company to try out the
process. There are different steps for converting from QuickBooks Enterprise Solutions or
QuickBooks for Mac to QuickBooks Online; visit The Visual Guide to Export for instructions.

The QuickBooks Online file should be set up (by the client or by the accountant creating a
QuickBooks Online file on behalf of the client) ahead of time. If it is not set up ahead of time, you will
be prompted to do so when you find that there is no QuickBooks Online filename where the
converted Desktop file's records can reside.

1. Open the QuickBooks Desktop company data file as the Admin user.

2. The file cannot have more than 350,000 targets. To view the size of your file, press the F2 key. If
the file has more than 350,000 targets, you can still import lists.

3. Navigate to File > Utilities > Verify Data. Correct any errors in the QuickBooks data before
proceeding to the next step and, if necessary, perform step 3 and repeat Verify.

4. Navigate to File > Utilities > Rebuild data. A backup must be created before QuickBooks

Desktop runs the Rebuild action.

5. Navigate to Company > Export Company File to QuickBooks Online.

| Customers Vendors Employees Ban

Home Page

Company Snapshot
Calendar
Documents »

Lead Center

My Company

SetUp Users and Passwords 3
Customer Credit Card Protection...

Set Closing Date...

Bulk Enter Business Details...

Planning & Budgeting 3
To Do List

Reminders

Alerts Manager

Chart of Accounts Ctrl+A
Make General Journal Entries...
Manage Currency 3

Enter Vehicle Mileage...

Prepare Letters with Envelopes F

Export Company File to QuickBooks Online
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6. You will then see a window with a link to a guide about how to make the conversion from
QuickBooks Desktop to QuickBooks Online as smooth as possible, and a link to a quick tour of
the QuickBooks Online interface. Both are very useful, especially the guide, as there are
embedded links and it is constantly being updated. When you are ready, click Start your export.

Export to QuickBooks Online o x

Let's get you ready to move

Pack up your stuff \

IMake your move as smooth as possible '
Read our guide that helps you prepare

your files, create a backup, and more.

View our guide

Check the place out e ——

Your new home is different from the
old one. Take a quick tour before
settling into QuickBooks Online.

Take the tour
Start your export

=a
—

The wizard will provide the steps to sign in with your pre-existing Intuit user ID.

Export to QuickBooks Online [=]

Sign in to QuickBooks
Online Accountant

Email or user ID

Password

[LTTTTYTY ST

Remember me

& Signin

By clicking Sign In, you agree to our
License Agreement.
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7. When you click Sign in, you will see Your moving-day checklist which will guide you through
your next steps. At this point you can click any step to get more info, click Cancel export or

8.

Continue to proceed.

Export to Quicl

Your moving-day checklist

Now

Latel

Compare tools and features

Check out a comparison to see if QuickBooks Online
meets your needs. Compare

Clean up your books

Limit your export to about 1 year of company history, and

condense your files. Find out how

T

Keep using QuickBooks Desktop

Record everything in both places for at least 6-8 weeks in
case you dontlike QuickBooks Online.

Adjust your payroll records

Some items won't carry over, 5o you'll have to make a few

tweaks to your original setup. Find out how

Use projects for job costing

If you click Continue, you will be given the opportunity to overwrite any of the companies (60

days old or newer) associated with that ID. Click Continue.

Let’s import Engineering/Architecture

Firm

Choose the company in which to import your desktop
file. Your desktop data will replace—not merge with—
the data in the online company you choose

Adams, Guild and Gibson 07/14/15

EFK CompuBaooks Inc. 08/1915

N oo

Sample Engineering

Course 1 - Get Started
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If you don't see the company you want in the list, that's because it hasn't been created in
QuickBooks Online first. You should have created the "empty” QuickBooks Online company first

to ensure it appears on this list. Then you'll be able to select it and click Continue.

Let's import Engineering/Architecture
Firm
Choose the company in which to import your desktop

file. Your desktop data will replace—naot merge with—
the data in the online company you choose.

Create a new company in QuickBooks
Online Accountant in which to import
your file

Cancel

Course 1 - Get Started

13



QuickBooks Online 2019 Client Training

Topic 2: Import Data

10. You will be asked to confirm if you want QuickBooks to replace all the data in the existing
QuickBooks Online company file you chose (even if it's a brand new, empty one that you just

created). Enter the word AGREE in the field below and click Replace.

Do you want us to replace all of your
Sample Engineering QuickBooks
Online data with your QuickBooks
Desktop data?

If you want to proceed with overwriting the
data in this company, please type the word
AGREE below.

AGREE

Preparing Engineering/Architecture Firm...

This process may take up to 30 minutes.

Course 1 - Get Started

14



QuickBooks Online 2019 Client Training Topic 2: Import Data

Along the way, you will also see prompts to start tracking inventory in the QuickBooks Online
company as of a date you specify, if the QuickBooks Desktop company had been tracking
inventory.

WARNING: Be very careful with this step as it will overwrite all data in the QuickBooks Online company
you select, if it has been created already and is 60 days old or newer. You will see a summary of what
data will be overwritten and you will be prompted to confirm that you wish to “go ahead and replace
the data.” If you are only practicing this process, create a new QuickBooks Online company that can be
cancelled.

11. Once complete, wait for confirmation that the QuickBooks Desktop file has been successfully
imported.

We are on it!

We're transferring your data now. When it's done, we'll
send a confirmation email with a summary report to

I B o

OK, got it

An email will be sent within 24 hours notifying you that your QuickBooks Online company is ready.
Often the conversion is very quick and email confirmation is received almost immediately.

Verify the data was imported correctly. Create a Balance Sheet and Profit & Loss report in both
QuickBooks Online and Desktop. Customize the date range to All Dates. Set the accounting
method to Accrual. Compare the balances, looking for any inconsistencies. (Inconsistencies may be
addressed here, due to cash vs. accrual basis reporting, FIFO inventory vs. weighted average
inventory, and certain types of multicurrency transactions.)

You can re-import data into QuickBooks Online for 60 days from the creation date of the
QuickBooks Online company. It is important to note that re-importing data will overwrite any existing
data in the QuickBooks Online company.
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@)
o Step by Step: Import Lists into QuickBooks Online

1. Open the QuickBooks Online test drive account.

2. Navigate to the gear icon - Import Data (under the Tools section).

® Glickbooks = © Q & @Hr O

Deshbosrd Import Data

Bring your existing data into QuickBooks

Projects -
Bank Data Customers Vendors Chart of Accounts Products and Services
Workers
Reports
Taxes Need to import QuickBooks Desktop data? Find out how

Accounting

My Accountant

List data may be imported at any time into QuickBooks Online, such as customers, vendors,
accounts (i.e., general ledger accounts on the Chart of Accounts) or products and services. Each
option has a downloadable template to ensure data is properly formatted before import.

NoTe: When importing a Chart of Accounts, it does not replace the existing Chart of Accounts; it adds
any accounts in your spreadsheet that are not already in QuickBooks Online to the existing accounts.

In addition, bank and credit card statements can be manually uploaded and imported (in *.csv, *.qfx,
*.gqbo, or *.ofx format) into QuickBooks Online when a direct bank feed connection to online
banking cannot be established. To establish a bank feed connection, you can connect an online
bank or credit card account to the appropriate account on the Chart of Accounts by navigating to
the left navigation bar, selecting Banking - Add account in the top right corner. Future bank and
credit card statements can be uploaded manually either from the gear icon > Import Data gear
icon > Import Data > Bank Data access point or select Banking on the left navigation bar then
select File Upload (or, if the File Upload button is not displayed, select the drop-down next to
Update then File Upload).

Dashkoard Banking Rules

Banking

Bank and Credit Cards Checking -

Sales File upload
ey s Frrar Mastercard . I
Order Checks
Expenses $-3,621.93 $200.00 $304.96
BANK BALANCE Moments ago. BANK BALANCE Maments age BANK BALANCE Moments aga
Al $1,201.00 $800.00 1 $157.72 2
IN QUICKBOOKS N QUICKBOOKS IN QUICKBOOKS

Workers
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Topic 3: Set Up Your Company

RECOGNIZE STEPS TO SET UP AND MODIFY LISTS AND USERS

QuickBooks Online account lists and users can be managed from the gear icon in the top right.
Managing lists is an important component of QuickBooks Online. From the gear icon, all lists should
be reviewed to make sure they are appropriate for the company. This includes Chart of Accounts,
Recurring Transactions, Products and Services, Product Categories, Custom Form Styles, Payment
Methods, Terms, Attachments, and Classes and Locations.

@
o Step by Step: Add Users to QuickBooks Online

1. Open the QuickBooks Online company.

2. Navigate to the gear icon > Manage Users (under the Your Company section).

Manage users | Give Feodback
Usere Accounting firms @
Add user
NAME EMAIL USER TYPE STATUS BILLABLE o ACTION

Mo data available

3. Ensure the Users tab is selected (the total number of existing users displays in the name of the
tab).

4. Click Add user.
5. Choose a type of user.
6. Click Next.

7. Setthe user’s access rights.
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8. Click Next.

9. Select the user’s settings.

10. Click Next.

11. Enter the user's name and email address (the email address will be their user ID).

12. Click Save.

The invited user receives an email that contains a link to sign in to the QuickBooks Online company.

@
o Step by Step: Add Accountant Users to QuickBooks Online

1. Open the QuickBooks Online company.
2. Navigate to the gear icon > Manage Users (under the Your Company section).

3. Ensure the Accounting firms tab is selected (the total number of existing Accounting firm users
displays in the name of the tab).

4. Enter the accountant’s email address (your accountant/bookkeeper and members of their firm
who have been granted permission will have access to your company data).

5. Click Invite.

The accountant receives an email that contains a link to sign in to the client's company via
QuickBooks Online Accountant as an Accountant user.

@
o Step by Step: Products and Services List

1. Open the QuickBooks Online company.
2. Navigate to the gear icon > Products and Services (under the Lists section).

3. The Products and Services list appears. Notice that it lists the name, SKU, type, sales description,
sales price, cost, whether the item is taxable, the quantity on hand and the reorder point (if it's set
up as an inventory item). The items will be grouped by categories, if categories are used.
Additionally, a picture of the product or service can accompany the name of the item.
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4. To specify the columns which appear in the Products and Services list, click the grid gear icon at
the top right of the list and add or remove the checkmark next to each column you want to see or
not see. Click the grid gear icon again to have that list of columns disappear.

5. To edit an item, locate the item to be changed, then click Edit in the far right column for that
item. Make the necessary edits. Save and Close.

6. To add an item, click New in the top right corner of the Products and Services window.

a.

b.

Select a Type for this product/service (Inventory, Non-inventory, Service or Bundle).

The Product/Service information window appears; if you selected the wrong type of
product/service, select Change type and correct your selection.

Enter the item Name, and, if applicable, the SKU and Category for the product/service.
Upload a picture for this product/service if desired.

For Inventory items in new companies that have no history of transactions in QuickBooks
Online, specify the Initial quantity on hand (zero for new products) and the As of date for
that initial quantity. (Ensure the As of date is dated far enough back in time that it pre-dates
any live transactions you want to enter.) You can specify a Reorder point if desired. Also, for
any Inventory items, you would select the Inventory asset account.

Fill in the Sales information and Purchasing information for that product/service with the
corresponding default sales description, sales price/rate, income account, taxable status,
default purchase description, unit cost and expense account. Save and close or Save and
new.

7. To delete (deactivate) an item, locate the item, click the drop-down arrow next to Edit and click
Make inactive.

8. Click Yes to confirm. Notice that items are merely deactivated and not really deleted.

Transactions for deactivated items are never deleted.
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@
o Step by Step: Print a Transactions Report for a Selected Account

Directly from the Chart of Accounts
1. Open the QuickBooks Online company.
2. Click the gear icon > Chart of Accounts (under Your Company).
3. If prompted, click See your Chart of Accounts.

4. Selectan existing account that is a Balance Sheet type of account (i.e., the Type column has any
of these in it: Bank, Accounts Receivable, Other Current Assets, Fixed Assets, Other Assets,
Accounts Payable, Credit Card, Other Current Liabilities, Long Term Liabilities or Equity), and in
the drop-down next to View Register for that account, click Run report.

5. The Account QuickReport for that account will display.
6. Change the Report period in the top left corner, if necessary, and click Run Report.

@
o Step by Step: Print the Chart of Accounts

1. Open the QuickBooks Online company.

2. Click the gear icon = Chart of Accounts (under Your Company).

3. If prompted, click See your Chart of Accounts.

4. Click the Printer icon in the upper right-hand corner of the displayed Chart of Accounts.

5. The Chart of Accounts will display in print preview format. In the left column, select your printer
and print settings, if necessary, and select Print.
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@)
o Step by Step: Connect a Bank Account to the Bank Feed

1. Open the QuickBooks Online company.

2. From the left navigation bar, click Banking.

Dashboard Banking Rulss
Banking . .
Bank and Credit Cards Checking - (=] | Updata | = ‘
Sales
Checking z Savings Mastercard
E:
rpeness $-3,621.93 $200.00 $304.96
BANK BALANCE BANK BALANCE Momenta sga BANK BALANCE Momenta sge
Projects
o $1,201.00 $800.00 $157.72
IN QUICKBOOKS 2 5 IN QUICKBOOKS 1 IN QUICKBOOKS 7
Worksrs
~
Reparts
ForReview |  Reviewed |  Excluded Tekeatour | GotoRegister
Taxes
Accounting . - A Al (25) Recognized (14)
My Accountant D DATE v DESCRIPTION PAYEE CATEGORY OR MATCH SPENT RECEIVED ACTION
& enrems Books By Bessie Books by Bessie Uncategorized Income: $55.00 Add
D 02152019 ARental Uncategorized Income $200.00 Add
D 02/15/2019 ARemal Uncategorized Expanze $1,200.00 Add

3. Click Add Account in the top right-hand corner.

4. Follow the wizard to connect an account to the bank feed.
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RECOGNIZE STEPS TO MANAGE YOUR COMPANY ACCOUNT AND SETTINGS

Your company Account and Settings control much of the functionality in the QuickBooks Online
account. They are the foundation for a successful and efficient QuickBooks Online experience.

The Account and Settings screen organizes the account’s global preferences into these sections:

® Company
® Billing & Subscription
® Sales
® Expenses
® Payments
® Advanced
Account and Settings @ Help
Company
Company nams
Billing & Subscription -
e Compzny name Besutiful Landscapes
Legzl name JcG
Expenses EIN 12-3457789
Payment:
Company type Tax form Small business corporation, two or more owners (Form 11205)
AmvEne=s Industry Accounting, Tax Praparation, Bookkeeping, 2nd Payroll Sarvices
Contactinfo Company email
Customer-facing email
Company phone
Wabzite
Address
Company address
Customer-facing address
Legsl address 112 Main Street, Elgin. IL 60123
Communications with -
Marketing Preferences
Intuit =

NOTE: Two of these Account and Settings sections — Billing & Subscription and Payments — do not
appear in the test drive company file.
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0

10.

11.

]

Step by Step: Company Tab in Account and Settings

Open the QuickBooks Online company.
Navigate to the gear icon - Account and Settings.
On the Account and Settings page, click the Company section on the left.

Notice the settings can be updated by clicking Edit (the pencil icon) on the right.

® Company name

® Company type

® Contactinfo

® Address

® Communications with Intuit
@

Step by Step: Enter Company Name, EIN, Industry, Contact Information
and Tax Form in Account and Settings

Open the QuickBooks Online company.

Navigate to the gear icon > Account and Settings.

On the Account and Settings page, click the Company section on the left.

Find the Company name settings on the right and click Edit (the pencil icon) on the right to enter
or edit the company name information.

Enter the Company name, the Legal name, and the EIN.
Click Save.

Find the Company type settings on the right and click Edit (the pencil icon) to enter or edit the
company type information.

Choose a tax form from the list.

Choose a Company type from the drop-down; start entering an industry and finish by selecting
one from the list that appears.

Click Save.

Find the Contact info settings on the right and click Edit (the pencil icon) to enter or edit the
company contact information.
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12. Click Save.
13. Click Done.

@
o  Step by Step: Specify Terminology for Customers in Account and Settings

1. Open the QuickBooks Online company.
2. Navigate to the gear icon > Account and Settings.
3. Onthe Account and Settings page, click the Advanced section on the left.

4. Find the Other preferences settings on the right and click Edit (the pencil icon) to enter or edit
the Customer Label (Clients, Customers, Donors, Guests, Members, Patients, or Tenants).

5. Click Save.
6. Click Done.
@

o Step by Step: Sales Tab in Account and Settings

1. Open the QuickBooks Online company.
2. Navigate to the gear icon > Account and Settings.
3. Onthe Account and Settings page, click the Sales section on the left.

4. Notice on the right that the settings can be updated by clicking Edit (the pencil icon).

Customize look and feel of forms for customers
Sales form content

Products and services

Messages

Reminders

Online delivery

Statements
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@)
o Step by Step: Turn on Inventory in Account and Settings

1. Open the QuickBooks Online company.

2. Navigate to the gear icon > Account and Settings.

3. On the Account and Settings page, click the Sales section on the left.

4. Find the Products and services area and click Edit (the pencil icon).

5. Click the box next to Track quantity and price/rate (so these fields appear on sales forms).
6. Click the box next to Track quantity on hand (so inventory is tracked).
7. Click Save.

8. Click Done.

9. Click the gearicon in the upper right.

10. Click Products and Services.

11. Select New to create a new product or Edit to alter an existing product.

12.If it's an existing product, select Change Type and choose Inventory item. I it's a new product,
choose the type Inventory item.

13. Enter or edit the item Name and, if applicable, the SKU and Category for the product/service.
14. Upload a picture for this product/service if desired.

15. For Inventory items in new companies that have no history of transactions in QuickBooks Online,
specify the Initial quantity on hand (zero for new products) and the As of date for that initial
quantity (again, remember to back-date that As of date sufficiently to pre-date any live
transactions you will enter). You can also specify a Reorder point if desired. Also, for any
Inventory items, you would select the Inventory asset account.

16. Fill in the Sales information and Purchasing information for that product/service with the
corresponding default sales description, sales price/rate, income account, taxable status, default
purchase description, unit cost and expense account.

17. Click Save and close or Save and new.
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@)
o Step by Step: Expenses Tab in Account and Settings

1. Open the QuickBooks Online company.
2. Navigate to the gear icon > Account and Settings.
3. On the Account and Settings page, click the Expenses section on the left.

4. Notice the settings can be updated by clicking Edit (the pencil icon).

® Bills and expenses
® Purchase orders
® Messages

@
o Step by Step: Explore Purchase Orders in Account and Settings

1. Open the QuickBooks Online company.

2. Navigate to the gear icon > Account and Settings.

3. On the Account and Settings page, click the Expenses section on the left.
4. Find the Purchase Orders area and click Edit (the pencil icon).

5. Click the box next to Use Purchase Orders.

6. Fill out remaining fields as needed.

7. Click Save.

8. Click Done.
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]

o Step by Step: Advanced Tab in Account and Settings

1. Open the QuickBooks Online company.
2. Navigate to the gear icon > Account and Settings.
3. On the Account and Settings page, click the Advanced section on the left.

4. Notice the settings can be updated by clicking Edit (the pencil icon) on the right.

® Accounting - to change the fiscal year or close the books
® Company type - sole proprietorship, etc. (also accessible on the Company page)

® Chart of Accounts - to turn account numbers on or off, specify a discount account and specify
a billable expense markup income account if required

® Categories - tracking classes, locations or both
® Automation
® Projects

® Time tracking
® Currency

® Other preferences

o Step by Step: Closing the Books in Account and Settings

1. Open the QuickBooks Online company.

2. Navigate to the gear icon > Account and Settings.

3. On the Account and Settings page, click the Advanced section on the left.

4. Find the Accounting setting on the right. Click Edit (the pencil icon) on the right.
5. Check the box to Close the books.

6. Enter a Closing Date.

7. Select one of these from the drop-down menu: Allow changes after viewing a warning or
Allow changes after viewing a warning and entering a password.

8. Enter a password and confirm the password (if the password option was selected).
9. Click Save.

10. Click Done.
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@)
o  Step by Step: Show Account Numbers in Account and Settings

1. Open the QuickBooks Online company.

2. Navigate to the gear icon > Account and Settings.

3. On the Account and Settings page, click the Advanced section on the left.

4. Find the Chart of Accounts setting on the right. Click Edit (pencil icon) on the right.
5. Check the box next to Enable account numbers.

6. Click the box next to Show account numbers.

7. Click Save.

8. Click Done.

9. Click the gearicon > Chart of Accounts (under Your Company).

10. If you are prompted, click See your Chart of Accounts.

11. Select the Checking account. Select the drop-down arrow next to View Register for that account
and select Edit.

12. Edit the Checking account. In the Number field, enter account number 10700. Save and Close.
13. View the account number now showing in the Chart of Accounts list.
14. Navigate to Reports > Balance Sheet.

15. View the account number for the Checking account appearing on the Balance Sheet.
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@)
o Step by Step: Enable Auto-recall on Forms in Account and Settings

1. Open the QuickBooks Online company.

2. Navigate to the gear icon > Account and Settings.

3. On the Account and Settings page, click the Advanced section on the left.

4. Find the Automation setting on the right. Click Edit (the pencil icon) on the right.

5. Check the box to Pre-fill forms with previously entered content.

6. Click Save.
7. Click Done.
@

o  Step by Step: Enter/Edit Many Account Numbers at Once in
Chart of Accounts
1. Now that Account Numbers have been enabled, open the Chart of Accounts.
2. Click Edit (the pencil icon) in the top right corner.

3. The Chart of Accounts becomes a grid you can edit, and you can add/edit account numbers in
the Number column for many account numbers at once.

4. When you are finished adding or editing your account numbers, click Save. (Tip: you can use this
same method to edit the names of many accounts at once on the Chart of Accounts.)
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@
o Step by Step: Change Settings for Automatic Sign Out

after a Period of Inactivity
1. Open the QuickBooks Online company.
2. Navigate to the gear icon > Account and Settings.
3. On the Account and Settings page, click the Advanced section on the left.
4. Find the Other preferences setting on the right. Click Edit (the pencil icon) on the right.
5. Select 1, 2 or 3 hours from the drop-down list next to Sign me out if inactive for.
6. Click Save.

7. Click Done.
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QuickBooks Online 2019 Client Training Guide Conclusion

Guide Conclusion

You have just covered Course 1 - Get Started. This course has been developed to help you train your
clients how to use QuickBooks Online successfully.

By completing this module, your client should understand:

@® The benefits of QuickBooks Online
® How to import data

® The parameters of setting up their company
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STATE OF WISCONSIN WORK PERMIT REQUEST FORM

The following items MUST BE PROVIDED IN PERSON before a work/street trades permit can be issued to the minor or parent/guardian:

1. REQUIRED: A duly attested birth certificate (preferred form of age documentation), or a verified baptismal certificate, or a
driver’s license, or photo ID card issued by the Department of Transportation, or a school record for proof of the minor’s age.

2. REQUIRED: The minor’s Social Security card for proof of Social Security number. If the minor’s Social Security card is lost, then
the Social Security number MUST be verified by contacting a Social Security representative. To do that, the minor and/or the
minor’s parent, guardian, or court-ordered foster parent must go to the Lancaster Office of Social Security and request a
replacement card. The Social Security Representative will provide you with a print out verifying the minor’s social security number.

3. REQUIRED: Completion on this form of the employer information below; or a letter from the employer containing the employer’s
name, address, telephone number, and signature, along with a statement of the intent to employ the minor, the job title, the job
duties, the days of work, and the approximate number of hours of work per week.

4. REQUIRED: The signature below of the minor’s parent, guardian, or court-ordered foster parent; or a letter from the minor’s
parent, guardian, or court-ordered foster parent giving consent for the minor to accept the employment being offered by the
employer.

5. REQUIRED: Payment from the employer of $10.00 for the work permit fee. If the permit fee is paid by the minor rather than the
employer, then the employer shall reimburse the minor for the permit fee no later than the first pay check issued to the minor.

EMPLOYER MUST COMPLETE THIS SECTION — WORK PERMIT REQUIRED INFORMATION

Employer Name Today’s Date

Employer Mailing Address/City/State/Zip

Employer Telephone Number Employer Fax Number
Printed Name of Minor Being Hired Date Minor Will Begin Employment
Title of the Job Minor Will Be Performing Approximate Number of Hours Per Week Minor Will Be Working

Days of the Week Minor Will Be Working
Monday [ ] Tuesday [ ] Wednesday [ | Thursday [ | Friday [] Saturday [ ] Sunday []

Provide a Brief Description of Job Duties:

Printed Name of Employer Representative Signature of Employer Representative

PARENT OR GUARDIAN MUST COMPLETE THIS SECTION — REQUIRED INFORMATION

Name and Address of School that the Minor is Attending

Do Parents Own this Business? Yes [ | No [_] Is the Minor a H.S. Graduate? Yes ] No[] Is the Work Being Performed as Restitution?
Yes |:| No |:|
Printed name of Parent, Guardian, or Court-Ordered Foster Parent Signature of Parent, Guardian, or Court-Ordered Foster Parent

| give my permission for the minor whose name is listed above to accept the
work that is described above.




PAYROLL

Employers must keep the following records for at least 3 years for each employee, other
than exempt employees paid on other than an hourly basis.

s wN e
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Name and address.
Date of Birth.
Date of entering and leaving employment.
Time of beginning and ending of work each day.
Time of beginning and ending of meal period:
a. When the employee’s meal periods are required or when such meal periods
are to be deducted from work time.
b. This requirement shall not apply when work is of such a nature that
production or business activity ceases on a regularly scheduled basis.
Total number of hours worked per day and per week.
Rate of pay and wages paid each payroll period.
The amount of and reason for each deduction from the wages earned.
The employee’s production, if paid on other than time basis.

Requirement

Employees under 18 years of age must receive at least a 30-minute duty free meal period
when working a shift greater than 6 hours in duration. Section DWD 274.02(2) recommends
that employers provide similar breaks to adults but does not require such breaks for adults.
If an employer provides breaks of less than 30 consecutive minutes in duration, the break
time will be counted as work time.

Employers must pay all employees for “on duty” meal periods. An “on duty” meal period is
one where the worker is not provided at least 30 consecutive minutes free from work, or
where the worker is not free to leave the premises of the employer during a meal period.

Employers also are not allowed to require that meals be accepted as part of the worker's

wages.

State law does not require that brief rest periods, or coffee breaks, be provided to
employees. Such matters are to be determined between the employer and the employee
directly.

Rest periods or breaks of less than 30 consecutive minutes each shift are considered work
time and must be paid for. Employers may not deduct from a worker’s wages for any time
off less than 30 consecutive minutes.



The state overtime law applies to most Wisconsin employers, including state and local units
of government but not necessarily to each individual worker. Covered workers, regardless of
age, must be paid 1 1/2 times their regular rate of pay for all hours worked in excess of 40
hours a week.

The law applies to factories, mercantile (see definition of mercantile) or mechanical
establishments, restaurants, hotels, motels, resorts, beauty parlors, retail and wholesale
stores, laundries, express and transportation firms, telegraph offices and telephone
exchanges.

“Mercantile” means, “pertaining to merchants or trade,” and is viewed with regard to profit
or designed for profit; designed for mass appeal, emphasizing skill and subjects useful in
business. “Trade” means the business or work in which one engages regularly, an
occupation requiring manual or mechanical skill; the persons engaged in an occupation,
business, or industry, dealings between persons or groups, the business of buying and
selling or bartering commaodities or services, to do business with, to have dealings, to give
one thing in exchange for another.

Under the Wisconsin Employment of Minors regulation, 16 and 17-year-old minors may be
employed more than 8 hours a day or 40 hours a week when school is not in session. They
must receive one and one half times the regular rate of pay, for all hours worked in excess
of 10 hours per day or 40 hours per week and that, they do not work in excess of 50 hours
per week. The exception to this rule is that minors who are 14 to 17 years of age may be
employed more than 50 hours per week in agriculture during peak periods.

Arrest and Conviction Record

Overview

State law protects workers from workplace discrimination because of arrest or conviction
record under certain circumstances. However, it is not employment discrimination under the
law when an employee's arrest or conviction is substantially related to the employment.

The statute of limitations for filing a complaint is 300 days from the date the action was
taken or the individual was made aware the action was taken.

What is an arrest or conviction record?

An arrest record is information that a person has been questioned, apprehended, taken into
custody or detention, held for investigation, arrested, charged with, indicted or tried for any



felony, misdemeanor or other offense. A conviction record is information indicating that a
person has been convicted of any felony, misdemeanor or other offense, been judged
delinquent, has been less than honorably discharged, or has been placed on probation,
fined, imprisoned or paroled by any law enforcement or military authority.

What does it mean for an arrest or conviction to be
substantially related to the employment?

An arrest or conviction is "substantially related” to a job when there is some overlap
between the circumstances of the job and the circumstances of the offense. For example, a
theft related conviction is substantially related to a cashier position. A drunk driving offense
is substantially related to a position as a truck driver. However, a drunk driving offense is
probably not substantially related to a cashier position.

What actions are covered?

When an individual's arrest or conviction record motivates the adverse decision, it becomes
unlawful discrimination. Specifically, the law prohibits discrimination in recruitment and
hiring, job assignments, pay, leave or benefits, promotion, licensing or union membership,
training, layoff and firing, harassment, and other employment related actions.

Frequently Asked Questions

Can an employer discharge a current employee because of a pending criminal charge?
An employer may suspend an employee if the pending criminal charge is substantially
related to the circumstances of the particular job or licensed activity.

Can an employer refuse to hire a person because of a record of arrest that did not lead to
conviction?
No. An employer is not allowed to ask about arrests, other than pending charges.

What can an employer ask regarding arrest and conviction records?

An employer may ask whether an applicant has any pending charges or convictions, as long
as the employer makes it clear that these will only be given consideration if the offenses are
substantially related to the particular job. An employer cannot legally make a rule that no
persons with conviction records will be employed. Each job and record must be considered
individually.

Can an employer refuse to hire an applicant because of a lengthy record of convictions or
conviction for a crime the employer finds upsetting?

An employer may only refuse to hire a qualified applicant because of a conviction record for
an offense that is substantially related to the circumstances of a particular job. Whether the
crime is an upsetting one may have nothing to do with whether it is substantially related to
a particular job.
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What if an employer believes a pending charge or conviction is substantially related but the
employee or applicant believes it is not?

In this situation, the employee or applicant may file a complaint and the Equal Rights
Division will make a determination as to whether there is a substantial relationship.

Can an employer refuse to hire or discharge a person with a pending charge or conviction
because other workers or customers don't want the person with a conviction there?

No. The law makes no provision for this type of problem. The employer must show that the
conviction record is substantially related to the particular job. Co-worker or customer
preference is not a consideration.

Is it a violation of the law if the applicant's conviction record is only a part of the reason for
not being hired?

Yes. A conviction record that is not substantially related to that particular job should be
given no consideration in the hiring process.

How should an applicant answer questions on an application regarding conviction record?
It is best to answer all questions on an application as honestly and fully as possible and to
offer to explain the circumstances of the conviction to the employer.

Can an employer refuse to hire an applicant because they failed to disclose all requested
criminal background information on an application?

Yes, an employer who discovers that an applicant has provided false or misleading
information in response to a question on a job application may refuse to hire that applicant
without violating the law. In this case, the decision not to hire the applicant is because of
dishonesty rather than the applicant's conviction record.

Should an employer ask about the circumstances of a conviction during an interview?

Yes. An employer must obtain enough information to determine if the conviction record is
substantially related to the job. If the employer decides there is a substantial relationship,
employment may be refused but the employer must be prepared to defend the decision if
the applicant believes there is not a substantial relationship and files a complaint.

Employers are only allowed to deduct certain items from an employee's wages, such as
taxes, insurance premiums, etc. Employers are not permitted to charge employees
for breakages, cash shortages, fines or any other losses to the business, unless you have

authorized the deduction in writing.
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Work Permits

Child Labor

Law Change - Effective June 23, 2017

Work Permit Requirements

e A work permit is required before anyone under the age of 16 is allowed to work in
any job with the exception of agriculture or domestic service work.

e Employers must have a work permit on file for the minor being employed before
they may allow the minor to begin work.

Where can I get a Work Permit?

Work permits are issued at various locations throughout the state. You may apply for a work
permit at your school office or call (608) 266-6860 for information on where in your area
you may apply for a work permit.

NOTE: The permit will not be issued if the work is prohibited by law.

How to Obtain a Work Permit

To obtain a work permit, either the minor alone or the minor and a parent must visit the
permit officer, taking with them:

e the minor's birth certificate or other proof of age,
e the minor's social security card
o letter from the employer expressing intent to hire, on employer's regular letterhead,
describing:
o job duties,
o hours of work,
e awritten parents consent
a $10.00 permit fee

Proof of Minor's Age

We may accept a valid operator's license or an identification card issued by the Wisconsin
Department of Transportation as proof of a minor's age. This means that we may now
accept either a duly attested birth certificate, a verified baptismal certificate, or a driver's
license or photo ID card issued by the Wisconsin Department of Transportation.


https://dwd.wisconsin.gov/er/laborstandards/workpermit/default.htm#collapse1-1
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For the Employer - Permit Fee Requirement

The employer must reimburse the $10.00 permit fee to the minor by no later than the
date of the first paycheck.

Copies of the permit go to the employer and the minor, in addition to the school district
where the minor is enrolled.

Poster Posting Requirements

Every employer, employment agency, labor organization and licensing agency subject
to the act shall post in a conspicuous place upon its premises, a poster prepared and made
available by the department, relating to the provisions of the act and this chapter.

Whether an employer chooses to pay the overtime premium directly in wages or offers the
employee compensatory time, the employer is obligated to pay the person 1 ¥z times their
regular rate of pay for the overtime hours. If the employer pays the overtime premium by
allowing the employee to use compensatory time the employee is entitled to use 1.5 hours
of compensatory time for each overtime hour worked. Nongovernment employers must
also ensure the employee uses the compensatory time within 31 days of when the time is
earned.

An employer and an employee do not have the authority to reach an agreement to waive a
state law or regulation concerning overtime pay. Since federal law may also require an
employer to pay its employees overtime pay, it should be noted that a modification or
waiver of state overtime rules would not exempt the employer from any federal overtime
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NFIB Small Business Legal Center

« We are the voice for small business in the courts and
the legal resource for small business owners
nationwide.

 While the information provided in this presentation is
intended to be accurate, it should not be considered
legal advice. The Legal Center cannot be held
responsible for any errors or omissions.
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Four Truths about Employment Law

1. Juries care about fairness, not legality.
Juries favor employees.

3. Juries always give employees the benefit of
the doubt.

4. The government is not neutral.

N
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Millionaire Question

What percentage of jurors
would try to return a verdict
for an employee who is
unfairly treated yet no law
has been broken?

*« 10%
« 35%
« 51%
« 68%

A’ NFIB



At-Will Employment

Employment relationships generally fall into
two categories:

« Contractual - termination must be
handled per terms of contract

« “at-will” - employment may be
terminated by employee or employer at

any time and for any reason, except an
illegal one

A’ NFIB



Laws that Protect Employees

« Title VII of the Civil Rights Act of 1964 (Title VII):
Prohibits discrimination/harassment based on race,
color, religion, genetic information, and national
origin

« Americans with Disabilities Act (ADA): Prohibits
discrimination against qualified individuals with
disabilities

« Pregnancy Discrimination Act (PDA): Prohibits
discrimination against employees based on
pregnancy, childbirth, or related medical conditions

A’ NFIB



Laws that Protect Employees

« Occupational Safety and Health Act (OSH Act):
Makes it illegal to fire someone in retaliation for
reporting safety/health violations or participating in
an investigation

« Fair Labor Standards Act (FLSA): Prohibits retaliation
against employees who complain of FLSA violations
or participate in investigations

* Age Discrimination in Employment Act (ADEA):
Prohibits age discrimination against individuals 40
years of age or older

A’ NFIB



Termination of Employment

« Can be initiated by the employee (resignation) or the
employer (dismissal/termination)
« Employer initiated in cases of:
ounacceptable job performance,
omisconduct, or
oeconomic reasons (budget cutbacks, reorganization,
downsizing)

* Focusing today on employer-initiated terminations

A’ NFIB



Legal Reasons to Terminate An Employee

« Poor performance

« Policy violation

« Failure to meet eligibility requirements
« Failure to meet job qualifications

« Layoff or elimination of position

A’ NFIB



Discipline and Documentation Process

A discipline process:
o lays the groundwork for fair and legal
firings
o puts the employee on notice of the
problem and potential consequences
Documentation:
o records the problem and actions taken,
especially if termination is the last resort
o Should be complete and thorough

A’ NFIB



Progressive Discipline

Most employers follow progressive discipline.
For example, an employee may get:

1. A verbal warning for first offense

2. A written warning if the problem
continues

3. A final written warning

4. Termination as a last step

A’ NFIB



How to Document Discipline

For complete and effective documentation, be
sure to cover all the following elements:

 The facts, including details like the date,
time, and location of the problem

 The specific rule or standard violated

« Objectives for improvement - what you

expect the employee to do to correct the
problem

A’ NFIB



How to Document Discipline (cont.)

« Suggestions for meeting objectives: What
you agree to do to help the employee meet
the objectives.

 Consequences: The action you will take if the
employee fails to meet the stated objective

« Signatures and dates: You and the employee
should both sign

A’ NFIB



Termination Checklist

« Was the employee informed of required standards of
performance and conduct and the consequences of
not meeting those standards?

« Was a proper investigation conducted -- did the
employee have an adequate opportunity to tell his or
her side of the story?

« Was the employee given adequate counseling or
training and opportunity to correct the problem?

« Is the employee’s employment history as documented
consistent with discharge?

A’ NFIB



Termination Checklist

« Have performance standards, work rules and disciplinary
procedures been applied consistently?

« Do the facts make clear that the employee is not being
discharged because of his or her race, sex, religion, age, national
origin, disability or other improper reason?

 Is discharge the appropriate penalty?

« Was a proper termination interview conducted and complete
documentation prepared?
dIn person, professional, private & witnessed
dKeep short & avoid confrontation

A’ NFIB



Common Errors in Termination of Employment
Error #1- Terminating the employee on the spot

« Do not act out of anger, frustration or impulse

[t is not recommended to terminate an employee on the
spot.

« INSTEAD - Suspend the employee effective
immediately, pending a review of the situation

A’ NFIB



Common Errors in Termination of Employment
Error #2 - Lack of documentation to support the decision

Do not construct documentation after the fact

« INSTEAD - document all through the employment
relationship, in the normal course of business.

« REMEMBER - if it's not documented, it didn't happen!

A’ NFIB



Common Errors in Termination of Employment
Error #3 - Losing control of the termination meeting

 The emotions of the situation take over the meeting

« INSTEAD: Prepare the manager for the meeting. Know
what needs to be communicated to the employee and
keep the meeting on track

A’ NFIB



Unemployment Compensation

+ Financial Eligibility rules vary from state to state.

- Usually based on working at least so many weeks in a certain
time period.

* Find links to your state’s unemployment agency at the U.S.
Department of Labor Web site.

5 16 17
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http://www.workforcesecurity.doleta.gov/unemploy/agencies.asp

Unemployment Compensation

Generally eligible if:
« Laid off due to lack of work.

« Terminated for work related issue that do not rise to the level
of "“misconduct.”

Generally ineligible if:

* Voluntary quit.
« Terminated for work related misconduct.

A’ NFIB



Unemployment Compensation

« Generally ineligible if
employee voluntarily quit
without good cause.

« Burden of proof on
employee to prove good
cause.

A’ NFIB




Unemployment Compensation

* Not the same thing as
“poor performance.”

»Termination for poor
performance will not
usually disqualify.

»Must be a violation of a
uniformly enforced
company policy

A’ NFIB



Termination Scenario #1

An employee has begun to perform erratically
and is suspected of having a problem with

drugs. What can you say to him about it? The
performance problem becomes more serious,

possibly justifying termination. Should you
terminate outright?

A’ NFIB



Termination Scenario #2

Your company terminates an employee for being
unproductive and abrasive. A few days later you
receive a phone call from the owner of another
business in town who asks you for a candid
reference on the terminated employee. What
can you say? Suppose the employee’s attorney
calls, threatens litigation , and asks for a
reference as part of the settlement? Suppose
the employee assaulted a co-worker?

A’ NFIB



Remember. ..

* Nip problems in the bud — act quickly

* Be consistent

* Ensure fairness

* Be aware of laws, policies, procedures affecting decision

A’ NFIB



Questions?




THANK YOU!

Beth Milito
(202) 406-4443
elizabeth.milito@nfib.org
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Thank you!
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U.S. Department of Labor

Wage and Hour Division

BASIC INFORMATION

current as of June 2012

The U.S. Department of Labor’s Wage and Hour Division (WHD) is responsible for administering and enforcing laws that establish
minimally acceptable standards for wages and working conditions in this country, regardless of immigration status.

FAIRLABOR STANDARDS ACT

The Fair Labor Standards Act (FLSA) affects
most private and public employment. The
FLSA requires employers to pay covered
non-exempt employees at least the federal
minimum wage and overtime pay for all
hours worked over 40 in a work week.

Covered employees must be paid for all
hours worked in a workweek. In general,
compensable hours worked include all
time an employee is on duty or at a
prescribed place of work and any time
that an employee is suffered or permitted
to work. This would generally include

work performed at home, travel time,
waiting time, training, and probationary
periods.

« Federal Minimum Wage:
$7.25 per hour effective July 24, 2009

« Tipped employees may be paid $2.13
per hour; if an employee’s tips combined
with cash wage does not equal the ap-
plicable minimum wage, the employer
must make up the difference

« Overtime after 40 hours in a week = 1
5 times an employee’s regular rate of pay

CHILD LABOR

E¥ouih

Preparing the 21st Century Workforce

Note: Different rules apply to youth employed in agriculture. States also regulate the hours

The FLSA also regulates the employment
of youth.

Jobs Youth Can Do:

» 13 or younger: baby-sit, deliver news-
papers, or work as an actor or performer
« Ages 14-15: certain permitted in such
establishments as office work, grocery
store, retail store, restaurant, movie the-

ater, and amusement parks
« Age 16-17: Any job not declared hazardous

» Age 18: No restrictions

more information on federal or state rules, log on to www.youthrules.dol.gov.

Hours Youth Ages 14 and 15 Can Work:
« After 7 am and until 7 pm

(Hours are extended to 9 pm June 1-Labor Day)
« Up to 3 hours, including Fridays

on a school day
« Up to 18 hours

in a school week
«Up to 8 hours

on a non-school day
» Up to 40 hours

in a non-school week

that youth under age 18 may work. To find

FAMILY AND MEDICAL LEAVE ACT

The Family Medical and Leave Act (FMLA)
applies to employers who employ 50 or
more employees, public agencies, and el-
ementary and secondary schools. Eligible
employees are entitled to take unpaid,
job-protected leave with continuation of
group health insurance coverage for up to
12 workweeks in a 12-month period for:

« the birth and care of a newborn child;
« the placement and care of an child for

adoption or foster care;

« for the serious health condition of the
employee or the employee’s spouse,
child, or parent;

« for qualifying exigencies arising out of a
covered military member’s covered active
duty status.

And 26 workweeks of leave during a single
12-month period to care for a covered ser-
vicemember with a serious injury or illness.

MIGRANT AND SEASONAL
AGRICULTURAL WORKER
PROTECTION ACT

CONTACT US:

1-866-4US-WAGE

The Migrant and Seasonal Agricultural
Worker Protection Act (MSPA) requires
farm labor contractors, agricultural
employers, and agricultural associations
who "employ" workers to:

« Pay workers the wages owed when due
» Comply with federal and state safety and

MORE INFORMATION AVAILABLE AT:

YOUTHRULES!: WWW.YOUTHRULES.DOL.GOV
WHD WEBSITE: WWW.WAGEHOUR.DOL.GOV

health standards if they provide housing for
migrant workers

» Ensure that vehicles that they use to
transport workers are properly insured,
operated by licensed drivers and meet
federal and state safety standards

» Provide written disclosure of the terms
and conditions of employment

ELAWS: WWW.DOL.GOV/ELAWS
DOL WEBSITE: WWW.DOL.GOV




	Copyright
	Trademarks
	Notice to Readers
	About the Author
	Training at a Glance
	QuickBooks Online Test Drive

	Topic 1: Best Practices
	Identify Best Practices when Using QuickBooks Online
	Browser Tips
	Keyboard Shortcut Tips
	Calculations


	Topic 2: Navigate
	Company Home Page
	Customer Center
	Vendor Center
	Various Transactions Tabs
	Quick Create

	Course Conclusion
	Copyright
	Trademarks
	Notice to Readers
	About the Author
	Lesson Objectives
	Forms
	Lists
	Registers
	Get Around in QuickBooks
	All the Accounting You Need to Know
	About the Chart of Accounts
	About Assets, Liabilities and Equity
	Cash versus Accrual Bookkeeping
	Measure Business Profitability
	General Journal Transactions

	Get Help while Using QuickBooks
	Exit QuickBooks
	Move between Company Files
	Get Started — Review Questions
	Answers to Review Questions
	Copyright
	Trademarks
	Notice to Readers
	About the Author
	Lesson Objectives
	Use QuickBooks Desktop Lists
	Edit the Chart of Accounts
	Edit an Account
	Add a Subaccount
	Customer, Vendor and Employee Centers
	Custom Contact Fields
	Work with the Customer Center and the Customers & Jobs List
	Add Customers
	Provide Additional Customer Information

	Sales Tax Settings
	Transactions from the Customers & Jobs List
	Work with the Employee Center
	Work with the Vendor Center
	Add Vendors

	Transactions from the Vendor List
	Add Custom Fields
	Manage Lists
	Rename a List Item

	Print a List
	Add or Edit Multiple Items at One Time
	Work with the Lead Center
	Things to Note about the Lead Center

	Work with Lists — Review Questions
	Review Activities
	Answers to Review Questions
	Copyright
	Trademarks
	Notice to Readers
	About the Author
	Lesson Objectives
	Write a QuickBooks Check
	Use Bank Account Registers
	Enter a Handwritten Check
	Transfer Money Between Accounts
	Reconcile Bank Accounts
	Mark Cleared Transactions
	View Cleared Checks in the Register
	Locate Specific Transactions
	Use Bank Feeds
	Work with Bank Accounts — Review Questions
	Review Activities
	Answers to Review Questions
	Copyright
	Trademarks
	Notice to Readers
	About the Author
	Lesson Objectives
	Record Payment in Full for a Single Job
	Enter a Partial Payment
	Apply One Payment to Multiple Jobs of the Same Customer
	Enter Overpayments
	Handle Down Payments & Prepayments
	Make Deposits
	How QuickBooks Handles the Deposit
	How to Handle a Customer Bounced Check
	Receive Payments & Make Deposits — Review Questions
	Review Activities
	Answers to Review Questions
	Copyright
	Trademarks
	Notice to Readers
	About the Author
	Lesson Objectives
	Use QuickBooks for Accounts Payable
	Enter Bills
	Pay Bills
	How QuickBooks Records Your Bill Payment
	Enter and Pay Bills — Review Questions
	Review Activities
	Answers to Review Questions
	Copyright
	Trademarks
	Notice to Readers
	About the Author
	Training at a Glance
	QuickBooks Online Test Drive

	Topic 1: Product Overview
	Know the Features of Your QuickBooks Online Subscription
	QuickBooks Online Simple Start
	QuickBooks Online Essentials
	QuickBooks Online Plus


	Topic 2: Import Data
	Identify Steps to Import Data into QuickBooks Online

	Topic 3: Set Up Your Company
	Recognize Steps to Set up and Modify Lists and Users
	Recognize Steps to Manage your Company Account and Settings

	Guide Conclusion

